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Getting Started

Welcome to Gentran:Director® for Windows® Application Integration
subsystem, Sterling Commerce’s Electronic Data Interchange (EDI)
mapping software for the Windows operating system. Gentran:Director
provides you with the tools you need to translate your application files to
EDI standard formats for documents you send to your partners (outbound
mapping), and to translate EDI standard formats to your application format
for documents that you receive from your partners (inbound mapping).

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 1



What's in this Manual Getting Started

What's in this Manual

This manual contains a tutorial for the Gentran:Director Application
Integration subsystem, using the ANSI X12 standard. This tutorial includes
an inbound mapping example (purchase order) and an outbound mapping
example (invoice). The purpose of this tutorial is to break the mapping
process down into concise and understandable steps, using examples that
enable you to understand and master the tasks and processes required to
create your own maps.

To access reference information, refer to the Gentran:Director Application
Integration online Help or Application Integration User’s Guide. For
additional information on the various tasks described in this manual, refer to
the Gentran:Director User’s Guide.

This manual assumes that you are familiar with using a
PC and with Microsoft® Windows functions, EDI
concepts, EDI standard structure, your internal
application format, data mapping concepts, and with
the Gentran:Director product.

The Tutorial Guide is organized into chapters. A brief description of the
chapter contents follows.

B Chapter 1, Getting Started explains the content, organization, and
conventions in this guide, as well as the system requirements. This
chapter also describes a brief outline of how to build maps using
Gentran:Director Application Integration, how to customize global
display options, and gives you an introduction to mapping and
Gentran:Director for Windows.

B Chapter 2, Inbound Purchase Order uses a step-by-step approach to
explain the tasks and procedures necessary to create an export map for
an ANSI inbound (850) purchase order.

B Chapter 3, Outbound Invoice uses a step-by-step approach to explain
the tasks and procedures necessary to create a system import map and an
import map for an ANSI outbound (810) invoice.

B The Glossary contains definitions of mapping and Gentran:Director
Application Integration subsystem terms and concepts.
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Getting Started What’s in this Manual

Conventions in
this Manual The different typefaces used in this manual are as follows:

Creatinganewmap  This typeface is used for emphasis or to indicate a
chapter or section in this manual or other
Gentran:Director manuals.

NEW... This typeface indicates a button in the program.
Click the button with your mouse, or press TAB
until the button is highlighted, then press ENTER
to execute that command.

F1 This typeface indicates a key that you need to press
on your keyboard. A plus sign (+) between key
names indicates a combination of keys to be
pressed together (e.g., ALT + TAB).

The different icons used in this manual are as follows:

This icon indicates a note that gives you additional
information on the current subject.

This icon indicates a caution that alerts you to the
potential loss of information. Please read any text
preceded by this icon carefully.

This icon indicates helpful tips, suggestions, shortcuts,
and alternative actions.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 3
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Getting Started

Introducing Mapping

Inbound

Outbound

Translation
Objects

A map is a set of instructions you define in the Gentran:Director Application
Integration subsystem that indicates the corresponding relationship between
your application file and the EDI standards, and defines how the system
should translate data.

For inbound mapping, the system translates your trading partner’s EDI
standard formatted business document to your application file format. To
translate inbound data, you need to create an export map in Gentran:Director
Application Integration (because the system is exporting to your application
file).

For outbound mapping, the system translates your application file format to
EDI standard formats, so you can send documents to your partners. To
translate outbound data, you need to create an import map and a system
import map in the Gentran:Director Application Integration subsystem. You
need to create an import map because the system is importing from your
application file. The import map defines how to move data from your
application file (flat file definition), which may contain multiple documents,
to the EDI standard-formatted documents that your partners expect to
receive from you. You need to create a system import map to determine
which trading relationship (established in Partner Editor) corresponds to
each document in the application file, so the system knows which import
map to use to process the document.

The map you create is the source from which you compile a translation
object. A translation object is a set of rules that instruct the translator how to
convert a file from one format to another. Every function performed during
translation requires a translation object. Translation objects control all the
functions of Gentran:Director EDI translation. Translation objects can
belong to the following two categories: system translation objects or user
translation objects. System translation objects control the creation and
separation of interchanges, functional groups, and transaction sets. They are
also used to generate and reconcile functional acknowledgements. User
translation objects control data entry, importing, exporting, document
turnaround, and creating printed reports. All the required system translation
objects are automatically installed with the Gentran:Director system.
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Getting Started Introducing Mapping

Gentran:Director Application Integration enables you to generate import,
export, and document turnaround translation objects. The Gentran:Director
Forms Integration subsystem enables you to generate data entry and print
translation objects. Once you generate a translation object using the
Gentran:Director Application Integration subsystem (or the
Gentran:Director Forms Integration subsystem), you must register the
translation object with Gentran:Director (see the Gentran:Director User’s
Guide for more information). In addition, you must establish correct trading
relationships for all trading partners from which you receive or to which you
send data (see the Gentran:Director User’s Guide for more information).
During the process of establishing a trading relationship, you need to specify
the name of the appropriate translation object that the translator uses to
translate the data (see the Gentran:Director User’s Guide for more
information).

The diagram below illustrates the inbound and outbound translation process:

Export Translation Object

'

Application
Inbound L» pp_»

Gentran:Director

Outbound -&—— .-
EDI Application

i

Import Translation Object

When you create an import map, you must define to Gentran:Director your
application file format and the EDI standard format in which your partners
expect to receive the documents. When you create an export map, you need
to define to Gentran:Director the EDI standard format in which your partners
sends documents and your application file format (how the data needs to be
formatted for your application to process it).
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Getting Started

Application File
Format

If you are creating an import or export map, you must define your
application to the Gentran:Director Application Integration subsystem. In
Gentran:Director terminology, your application file is also referred to as a
fixed-format file or a positional file. Your application file must contain all the
information that you either need to extract from your partner’s document (if
the map is inbound) or need to send to your partner (if the map is outbound).

The map components that you use to define your application file are as
follows:

B A group is a looping structure that contains related records and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. If you create a group that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (a loop within
a loop). The application (positional) file is a group and therefore, it is
visually represented the same way as other groups and subgroups in the
Application Integration subsystem: 3

B A record contains a group of related fields. A record can occur once or
can repeat multiple times. A record is visually represented in the
Application Integration subsystem as: 0

B A field is the smallest piece of information defined in the application
file. A field is the application map component that is mapped (linked) to
a corresponding EDI element. A field is visually represented in the
Application Integration subsystems as: @

When a field has a mapping operation performed against it, a red
checkmark is displayed over the field icon.

Before you define your application file format, you should obtain a layout of
the necessary records, fields, and groups. Each map component is arranged
sequentially in the order that it is most logical for the system to process.
Therefore, each level of your application file must be created sequentially.
For example, your application file contains records and groups. The records
contain fields and the groups contain records and/or subgroups. This means
that you must create records and groups before you create the subordinate
fields.
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Introducing Mapping

EDI File Format

Map Components

The EDI file must contain all the information that you expect to receive from
your partner (if the map is inbound) or need to send to your partner (if the
map is outbound).

The Gentran:Director Application Integration subsystem generates an EDI
file for you, based on the standard (agency), version, transaction set, and
release (for the TRADACOMS standard only) you selected. The system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. If you
are creating an import or export map, you typically need to customize the
system-generated EDI file by modifying the properties of the map
components, and using specialized Gentran:Director functions to manipulate
the EDI file structure.

If you want to use a specialized version of an EDI standard that is not
available in the Gentran:Director standards database, it may be appropriate
for you to define the EDI file yourself.

The specific EDI map components that you use depends on the type of map
you are creating. This includes the standard, version, and transaction set
(document) selected, and which groups, segments, composites, and elements
your company requires. We recommend that you determine which map
components you are using before generating or defining an EDI file.

The map components that Gentran:Director uses to define the EDI file
format are as follows:

Bl A group is a looping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a subgroup (this corresponds to a nested
looping structure — a loop within a loop). The EDI file is a group and is
visually represented the same way as other groups and subgroups in the
Application Integration subsystem: ()

Bl A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times. A segment is visually represented in the Application
Integration subsystem as: ‘.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 7
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Getting Started

Bl A composite is a data element that contains two or more component

data elements or subelements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards). A composite is visually represented in the Application
Integration subsystem as: &

An element is the smallest piece of information defined by the EDI
standards. An individual element can have different meanings
depending on the context. Elements are typically not considered to have
useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding
application field to move data to and from the EDI file. An element is
visually represented in the Application Integration subsystem as:

When an element has a mapping operation performed against it, a red
checkmark is displayed over the element icon.

Please see the Gentran:Director Application Integration User’s Guide for
more information on customizing the properties of the map components, and
using specialized Gentran:Director functions to manipulate the EDI file
structure.

8 April 2005
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Introducing the Application Integration Subsystem

Introducing the Application Integration Subsystem

The Gentran:Director Application Integration subsystem enables you to
translate your application files to EDI standard formats for documents you
send to your partners (outbound mapping), and to translate EDI standard
formats to your application format for documents that you receive from your
partners (inbound mapping).

Navigation

You can access the Gentran:Director Application Integration Window in one
of four different ways:

Click the menu option from the Main Menu Bar.
Click the appropriate button on the Main Toolbar.
Click the appropriate part of the map.

Click a map component with the right mouse button to access a shortcut
menu, which contains all the functions that are currently available for
that map component. The content of the shortcut menus varies,
depending on the type and level of the selected map component.

When you start Gentran:Director Application
Integration, the Main Menu Bar contains a subset of
menu items. A full set of menu items is displayed after
you create a new map or open (load) an existing map.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 9
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The Gentran:Director - Application Integration Window appears as follows::

Control Menu
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Main Menu Bar

April 2005

Main Toolbar

Status Bar

The Control Menu contains the following commands: Restore, Move,
Size, Minimize, Maximize, and Close.

The Title Bar contains the name of the application. You can use this to
move the position of the EDI Director window on your desktop.

The Minimize button reduces the window to an icon.

The Maximize button enlarges the window to its maximum size.
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Getting Started Introducing the Application Integration Subsystem

B The Main Menu Bar contains the following drop-down menus
(detailed descriptions of each of the commands on these menus are
found in the online Help). Unavailable items are dimmed.

Eile

- Cib Boroe |
Open Cirl+0 Lopy Split DB e
EI Easte [t - =
ose .
Save Chil+5 Create Sub 4 i Expand Branch
Save A Insen , Deactivate Expand Al
AVE S Delete Del ™ Unexpand Branch
Compile Eripaiiss inink Shiow &ctive Only
Erirt... Ctil+F i Equalize
_'fn T Sessioh Bules Generate TDF
Print Setup... Canstants Generate LIBE]
Print To File... Swrtax Tokens =
Code Lists Lot T
1 Pet_8h0.map - —
Dietailz
sl Find...

Dia

te Fomats. ..

Using Help

Arnange lcons

v 1 Pet_850.map About GEMTRAM: Server - Application Integration. .

B The Main Toolbar gives you access to some of the most common
operations in the Application Integration subsystem. Unavailable items
are dimmed. The Main Toolbar is a dockable toolbar, so you can affix it
to any edge of the client window. The Main Toolbar is illustrated below:

Gentran:Director Application Integration ANSI Tutorial Guide

New Cut Constants Split Unlink
‘ Sa‘ve Pa|ste Code Lists ‘ Deactivate
NEFEREEEEEEERERIREE
| |
Open Copy Syntax Activate GenLrate
. .~ Tokens ) TDF
Compile Session Promote Link
Rules

B The Status Bar displays status information about a selection, command,
or process, defines menu items as you highlight each item in the menu,
and indicates any current keyboard-initiated modes for typing (e.g.,
CAP for the “Caps Lock” key).

April 2005 11



Introducing the Application Integration Subsystem Getting Started

Keyboard

Techniques The procedures in this manual are designed to be executed with a mouse. If
you prefer to use the keyboard, press the ALT key and the underlined letter

@ of the desired menu option to open the menu. Once the menu is open, press
the underlined letter of the desired menu option to access that option.

If a key combination (e.g., CTRL + N for the NEW
command) is specified on the menu for that option, you
may press that key combination as well.

Instead of clicking a button to execute a command on a
dialog or browser, press TAB to highlight the desired
button, and press ENTER to execute that command.
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Customizing Global Display Options

The Gentran:Director Application Integration subsystem allows you to
customize the display of maps in several different ways. The global display
options that are established apply to all maps. This section explains how to
perform the following:

B Customizing global display options
B Displaying links (global option)
You can set or change global map display options at any time.

Customizing
Global Display Complete the following steps to customize global (for all maps) display
Options options:
1. Select Preferences... from the Options menu to display the Preferences
dialog (the Tree tab is displayed by default). The Preferences dialog is a

property sheet that enables you to set global defaults for
Gentran:Director.

Preferences

Tree ILinks | Standard Formatsl PositionalDefauIlsI Files | Eonfirmationsl

These settings customize the look. of the file format tree.

Colaurs... |
¥ Show record descriptions Font... |

¥ Show figld descriptions

kK I Cancel Help
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2.

April 2005

To turn on the default display of group, record (segment), and field
(element) descriptions, select the appropriate options.

You typically want all descriptions displayed for reference. But
depending on the size of your monitor, it may be easier to see the entire
map if the descriptions are not displayed.

You may want to experiment with shrinking the size of
the font for the map (see Customizing Global Fonts in
the Gentran:Director Application Integration User’s
Guide) before you turn off the display of descriptions.

Click OK to save changes and exit the Preferences dialog.

Gentran:Director Application Integration ANSI Tutorial Guide
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Customizing

Global Display Mapping Links are the visual lines that connect a field/element on the Input
of Links side of the map to a field/element on the Output side of the map.

Complete the following steps to customize the global display of mapping
links:

1. Select Preferences... from the Options menu to display the Preferences
dialog.

2. Click the Links tab to display the linking options. The Links tab enables
you to set the default display of mapping links.

Preferences

Tree  Links | Standard meatsl Positional Defaultsl Files I Confirmationsl

These zettings contral how links are shown between the input and output file formats.

@ Show no links
" Shiow links ta ar fram the cumently selected slement,

" Show links to o from all visible elements

The options in the Links section of the Preferences dialog enable you to
select:

B Show no links
Do not visually display mapping links.

Bl Show links to or from the currently selected element
Display only the mapping links for the currently selected field (this
option enables you to concentrate on the selected field and removes
the confusion of viewing many links at once).

W Show links to or from all visible elements
Display all the mapping links.

The option you select is the default for all maps.

3. Click OK to save changes and exit the Preferences dialog.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 15
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Building a Map with Application Integration

16

This section is an overview of the map-building process.

1.

April 2005

Prepare and Analyze

Obtain a layout of your application file and determine how it
corresponds with the EDI standard you are using. Determine how you
move data to or from each application field.

Set Global Defaults (first time only)

The first time you use the Gentran:Director Application Integration
subsystem, you should establish the default date format that the system
uses. Please see the Gentran:Director User’s Guide for more
information on setting the global date default.

Create, Save, and Name a New Map
Please see Creating the Export Map on page 30 for more information on
creating, saving, and naming a map.

Activate the Appropriate EDI Groups, Segments, and Elements
Please see Activating EDI Map Components on page 36 for more
information on activation.

Define your Application File Format
Please see Defining Your Application File Format on page 41 for more
information on defining your application file format.

Map the Appropriate Data for Each Application Field
Please see Mapping Your Data on page 65 for more information on
mapping your data.

Compile the Translation Object

Please see Compiling the Map on page 109 for more information on
compiling the translation object and translation object naming
conventions.

Print the Mapping Report

Validate and review the map, and make modifications as needed. Please
see Printing the Report on page 111 for more information on printing
the mapping report.

Register the Translation Object with Gentran:Director
Please see the Gentran:Director User’s Guide for more information on
registering translation objects.

Gentran:Director Application Integration ANSI Tutorial Guide
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Building a Map with Application Integration

Translation

Object
Type

10.

11.

Create the Appropriate Trading Relationship

Establish the appropriate trading relationship in Gentran:Director for
your trading partners. Please see the Gentran:Director User’s Guide for
more information on creating trading relationships. The trading
relationship that you will use in this tutorial (PETZONE) is provided on
the tutorial diskettes. You need to import the partner profile
(PETZONE.PAR) into Gentran:Director, before you begin this tutorial.
Please see the Gentran:Director User’s Guide for more information on
importing trading relationships.

Testing the Translation Object

Obtain test data from your partners and process the data. Verify
acknowledgement processing (if applicable). Verify communications
with your network.

For these tutorials, we have provided test data for the translation objects
you create. The following table describes how to locate that test data:

Test Data Default
Name Path Location

Inbound (export) PETTSTEL.INT C:\GENSRVNT\TUTORIAL\PETTEST.INT
Outbound PET_EINV.TXT C:\GENSRVNT\TUTORIAL\PET_810.TXT
(system import and

import)
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Inbound Purchase Order (850)

This tutorial defines the tasks necessary to create a map used to translate
ANSI X12 purchase orders (850) that you receive from your trading partner.

This chapter explains all the tasks and processes associated with creating a
map for an inbound purchase order, including the following:

Mapping analysis

Creating the new map

Activating groups, segments, and elements

Defining your application file format

Mapping your data

Finalizing the map

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 19
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Getting Started

Inbound
Mapping
Scenario

Mapping
Analysis

20

This tutorial exercise is meant to be completed in its entirety. We
recommend that you complete each task sequentially, without referring to
the completed map that is provided with the installation program (although
you may want to verify your completed map with the model).

The purpose of completing each task in this tutorial in sequential order as if
it were your own scenario, is to teach you not only how to perform the
individual mapping tasks, but also to teach you a logical approach and
methods that should be utilized when you create your own map.

In this tutorial exercise, your company is MWT Manufacturing Co., which
manufactures a wide variety of supplies for pet stores. Your company sells
pet supplies directly to large pet supply retail chains. You need to create a
map that enables your company to translate the purchase orders that you
receive from one of your trading partners, Pet Zone (a large pet supply
retailer). Once the purchase orders are translated into your application file
format, they can be processed through you Order Processing System, and
your company can ship the goods to Pet Zone.

You have an existing application file layout from your order entry
department, that defines the information your system needs to process the
order. And, from discussions with the Pet Zone, you know the data content
of the orders that your partner is sending you.

The first step in creating a map is the analysis of the mapping requirements.
This is the most important step in creating a successful map. If the analysis
you perform is complete, you have all the information you need to create the
map in an efficient and logical manner. If you omit this critical step and
proceed directly to creating the map, it is likely that creating the map is a
much longer and arduous task, and the map may be invalid due to oversights
and omissions.

Regardless of whether you are translating data inbound or outbound,
mapping analysis involves the following steps:

1. Analyzing your application file format
2. Analyzing your partners EDI file format
3. Correlating your application and the EDI file formats

After you complete these steps, you can begin creating the map.
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Analyzing Your
Application File
Format

The first step of mapping analysis is analyzing your application file format,
because this is probably the component that is the most familiar to you. In

Field Name

this tutorial, your application file format contains all the information that you
need to extract from the purchase order your partner sends you, so that your
system can correctly process the purchase order, and your company can fill
the order correctly.

You must define your application file format to Gentran:Director. If your
company has an existing application file format, as in this tutorial, you
should obtain the record layout from the appropriate person. If you did not
have an existing application file format, you would need to create one by
determining which fields are necessary to process the data correctly, and
then grouping the fields logically under records.

The application file layout for this tutorial is as follows:

Max
Length

Description

Header Record (POHEADER) 1 per document
CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
BILLTONAME Bill To Name String 0 35
BILLTOADD1 Bill To Address Line 1 String 0 35
BILLTOADD2 Bill To Address Line 2 String 0 35
BILLTOCITY Bill To City String 0 30
BILLTOSTATE Bill To State String 0 2
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Field Name

Description

Min
Length

Max
Length

BILLTOPOSTALCODE Bill To Postal Code String 0 9

DELDATE X Delivery Date Dt/Tm 6 6
(MMDDYY)

CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)

NUMLINEITEMS X Number of Line Items Number (NO) 1 6

PO Detail Group (PODetailGroup) up to 100,000 per document
Detail Record (PODETAIL) 1 per document

CUSTNUMDET X Customer Number String 1 8

PODATEDET X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

UuoM Unit of Measure String 0 7

UNITPR Unit Price Number (N2) 0 14

QTYORD X Quantity Ordered Number (NO) 1 9

Description Record (PODESC) up to 5 per document

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 80

Allowance/Charge Record (POALLCHG) up to 5 per document

CUSTNUMAC X Customer Number String 1 8

PODATEAC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMAC X Purchase Order Number String 1 22
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. o Max
Field Name Description Length

ACIND Allowance or Charge String 0 1
Indicator

ACMETHAND Allowance or Change String 0 2
Method of Handling Code

ACTOTAMT Allowance or Charge Total Number (N2) 0 9
Amount

Summary Record (POSUMMARY) 1 per document

CUSTNUMSUM X Customer Number String 1 8

PODATESUM X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMSUM X Purchase Order Number String 1 22

NUMLINEITEM SUM X Number of Line Items Number (NO) 1 6

The above table contains the minimum information necessary to define your
application file format to Gentran:Director (hame, mandatory status,
description, data type, and field length). Each record contains a group of
logically-related application fields. These fields contain the information
from the EDI file that your system needs to process the purchase order. The
group contains logically-related application records.

Each record contains a key (consisting of three fields) that ensures that the
same identifying information is located at the beginning of each record. Your
application contains a record key so that each record can be identified
individually. The record key for this purchase order consists of your
partner’s customer number, the purchase order date, and the purchase order
number. The records and the group are defined as follows:

B The POHEADER (header) record contains the purchase order type
code, shipping and billing information, delivery and cancel by date
information, and the number of line items in the purchase order. This
header record is mandatory and occurs once for each purchase order
translated.

B The PODetailGroup (detail information) contains all the line item
information for the order, including the item, unit of measure, price,
quantity ordered, description, and the allowance and charge
information. Each PODetailGroup can occur up to 100,000 times per
order translated. This equals a maximum order of 100,000 items. The
information within the PODetailGroup is further segregated by record.
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Analyzing the EDI
File

B The PODETAIL (detail) record contains line item code number, unit of
measure, price, and quantity ordered. The PODETAIL record occurs
once per PODetailGroup.

B The PODESC (description) record contains descriptive information
about the line item ordered. The PODESC record can occur up to five
times per PODetailGroup, so multiple descriptive terms can be used for
each item. For example, if the line item is a “dog collar,” the description
fields may be “red,” “large,” and “leather.”

B The POALLCHG (allowance and charge) record contains the allowance
or charge indicator, method of handling code, and total allowance or
charge amount. The POALLCHG record can occur up to five times per
PODetailGroup, so multiple allowances and/or charges can be used for
each item.

B The POSUMMARY (summary) record contains the total number of line
items in the purchase order. The POSUMMARY record occurs once for
each purchase order translated.

Now that you have thoroughly analyzed your application file format, the
next step is to determine the requirements of the purchase order that you
receive from your partners.

To analyze the EDI file, you must first determine what your trading partners
are sending you. You and your partners need to agree on which standard,
version, and transaction set you are using. In this tutorial, we are using the
ANSI X12 standard, version 003030, transaction set 850 (purchase order). It
is important to know the information that your partners are sending you
within the purchase order, and what data is contained in each element used.

It is very helpful to review the EDI standards that you are using before
analyzing the EDI file. Obtain an EDI standards manual for each standard
and version that you are using. Standards manuals are available from EDI
standard agencies.

After discussing with your partners what they are sending, determining
which segments and elements your company requires, and reviewing the
EDI standard, you can list the map components that you need to make
available for use (activate).
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For this tutorial, the map components that are required but not currently
active are the following:

Groups Segment Element
DTM DTMO02
N1 N1 N102
N3 N302
N4 N401
N402
N403
PO1 (already PO1 PO102
activated) PO103
PO104
PO107
PID PID PIDO5
ITA ITAO1
ITAO4
ITAO7

When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.

We recommend that you set up a Document Name for each map, to make the
identification of a document created by this map easier in Gentran:Director.
This allows you to differentiate between documents in the document
browsers in Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map.
Then, the Name field of the document browsers that contain this document
contain the data from the selected element or field. You can choose any
element or field as the Document Name, but we strongly recommend that
you select an element or field that occurs only once in the document and has
a data type of “String.” In this tutorial, the document name for the map is the
purchase order number.

After you complete the analysis of the EDI file and your application, the
final step in mapping analysis is correlating the two components.
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Reconciling Your
Application File
and the EDI File

Field Name

To reconcile your application file format with the EDI file, you must identify
each application file with its corresponding element in the EDI file and
select a method for mapping it. To map information to a field, you use
linking, standard rules, extended rules, or a combination of all three.

Linking (simple mapping) enables you to map a field or element from the
input side of the map to a field or element on the output side of the map. The
link between two map components (fields) is visually represented with a line
connecting the two fields.

Standard rules give you access to mapping operation functions that are
more complex than simple linking, but less involved than extended rules.

Extended rules enable you to use a Gentran:Director proprietary
programming language to perform virtually any mapping operation you
require.

Additionally, you may determine that you need to establish temporary
storage (work) areas for the map to handle items such as Ship To and Bill To
name and address information, which is extracted using extended rules from
a group in the EDI data.

We recommend that you determine which mapping operations are required
on a field-by-field basis for your application file.

The following mapping operations (by application field) are required for this
tutorial:

Mapping
Operations

Description

Header Record (POHEADER) 1 per document

CUSTNUMHDR Customer Number Extract Application ID from Partner
record

PODATEHDR Purchase Order Date Link to BEGO5

PONUMHDR Purchase Order Number Link to BEGO3

RECTYPHDR Record Type HDR

POTYPCODE Purchase Order Type Code Link to BEG02

SHIPTONAME Ship To Name Link to N101 using “ST” (ShipTo) Code

SHIPTOADD1 Ship To Address Line 1 Link to N301 using “ST” (ShipTo) Code

SHIPTOADD?2 Ship To Address Line 2 Link to N302 using “ST” (ShipTo) Code

SHIPTOCITY Ship To City Link to N401 using “ST” (ShipTo) Code
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Field Name Description O,\ngaptiiggs
SHIPTOSTATE Ship To State Link to N402 using “ST” (ShipTo) Code
SHIPTOPOSTALCODE Ship To Postal Code Link to N403 using “ST” (ShipTo) Code
BILLTONAME Bill To Name Link to N101 using “BT"(BillTo) Code
BILLTOADD1 Bill To Address Line 1 Link to N301 using “BT"(BillTo) Code
BILLTOADD2 Bill To Address Line 2 Link to N302 using “BT"(BillTo) Code
BILLTOCITY Bill To City Link to N401 using “BT"(BillTo) Code
BILLTOSTATE Bill To State Link to N402 using “BT"(BillTo) Code
BILLTOPOSTALCODE Bill To Postal Code Link to N403 using “BT"(BillTo) Code
DELDATE Delivery Date Link to DTMO02 using “001" Code
CANCELDATE Cancel By Date Link to DTMO2 using “002” Code
NUMLINEITEMS Number of Line Items Link to CTTO1

Detail Record (PODETAIL) up to 200,000 per document

CUSTNUMDET Customer Number Extract Application ID from Partner
record

PODATEDET Purchase Order Date Extended rule to map from BEG05

PONUMDET Purchase Order Number Extended rule to map from BEG03

RECTYPDET Record Type DET

CUSTPROCODE Customer Product Code Link to P0O107

UPCCODE UPC Code Extract Partner xref by partner item
from subtable “PRODCODE”

UOoM Unit of Measure Link to P0O103

UNITPR Unit Price Link to P0104

QTYORD Quantity Ordered Link to P0102

Description Record (PODESC) up to 5 per document

CUSTNUMDESC Customer Number Extract Application ID from Partner
record

PODATEDESC Purchase Order Date Extended rule to map from BEG05

PONUMDESC Purchase Order Number Extended rule to map from BEG03

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 27



Getting Started Inbound Purchase Order (850)

Field Name Description Mappl_ng
Operations
RECTYPDESC Record Type DES
DESC Description Link to PID0O5

Allowance/Charge Record (POALLCHG) up to 5 per document

CUSTNUMAC Customer Number Extract Application ID from Partner
record
PODATEAC Purchase Order Date Extended rule to map from BEG05
PONUMAC Purchase Order Number Extended rule to map from BEG03
RECTYPAC Record Type AC
ACIND Allowance or Charge Indicator | Link to ITAO1
ACMETHAND Allowance or Change Method Link to ITAO4
of Handling Code
ACTOTAMT Allowance or Charge Total Link to ITAO7
Amount

Summary Record (POSUMMARY) 1 per document

CUSTNUMSUM Customer Number Extract Application ID from Partner
record

PODATESUM Purchase Order Date Link to BEG05

PONUMSUM Purchase Order Number Link to BEG03

RECTYPSUM Record Type SUM

NUMLINEITEMSUM Number of Line Items Link to CTTO01

You must determine whether or not you need to use code tables to convert
data for the map. If you need to use tables, you must decide whether to create
a code table in Gentran:Director that can only be used with this map, or add
the table to either the partner relationship or the internal system partner in
Partner Editor. In this tutorial, you need to map information from a cross-
reference table to translate your partner’s code for a purchased item and your
code for the same item. A cross-reference table is used when you and your
partner each reference an item by a different name (or number). Please see
the Gentran:Director User’s Guide for more information on cross-reference
tables.
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You do not need to create this cross-reference table — it
is included with the PETZONE partner
(PETZONE.PAR) that is provided with the tutorial
data when you install Gentran:Director.

My Value Partner Value Description Reference Data
12345678901234 555666411 Large Dog Collar Red
23456789012345 555666817 Spring Breeze Cat Litter 10# Bag
34567890123456 555666908 Small Beef Basted Rawhide Bones Bag of 12
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

After you finish correlating your application file format and EDI file on
paper, you can begin creating the map.
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Creating the Export Map

30

The first task in creating a new map is to define the format that is used for
the input and output sides of the map. In this example, you are creating an
export map so Gentran:Director can translate a purchase order that your
partner sends to your application file. The input side of the map must reflect
the ANSI X12 850 purchase order that you receive. Instead of defining the
850 document to the system yourself, you want Gentran:Director to use the
standards database on your system to build the purchase order according to
the standard. The output side of the map must reflect your application file.

Complete the following steps to create the export map for the Inbound
Purchase Order:

1. Select New from the File menu to display the Create New Translation

Object dialog.
Funetian | mpart
W ata Sauree I j Caael |
— Input Format
Type Iﬂ [T sz Standard
SOency I j
WETSIGH I j
Trafisactian I j
HElEaze lﬁ
— Dutput Format
Type Iﬁ ™| e Standand:
AGEnc I j
TSI I j
rarsaction I j
Helease I—;,

2. From the Translation Object Function list, select “Export”.

Complete the Input Format section of the dialog. This is the format of
the data that is translated by the Gentran:Director system.

3. From the (Input Format) Type list, select “EDI” as the type of format for
the input data.
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4. Select the Use Standards check box, because you selected “EDI” in the
Type box and because you want the system to use the standards database
on your system to build the purchase order according to the standard.

5. To select a data source name from which Application Integration
accesses EDI standards, select one from the Data Source list. This DSN
is prompted the next time you create a map.

6. Select “[X] X12” as the EDI standard you are using for the input side of
the map from the Agency list.

7. Select “[003030] ANSI X12 VERSION 3 RELEASE 3” as the version
of the standard from the Version list. The versions that are available
depend on which standard you selected.

8. Select “[850] PURCHASE ORDER?” as the transaction set (document or
message) from the Transaction list. The transactions that are available
depend on which standard and version you selected.

Now you need to complete the Output Format section of the dialog.

9. From the Type list, select “Positional” as the type of format for the
output data. Gentran:Director uses the term “positional” to describe any
flat file that you create.

The Create New Translation Object dialog should now look like this:

Function I Export
Data Source IGENTH.-’-\N Standards j Careel |
— Input Farmat

Type IEDI VI ¥ Use Standard:

Agency |[><] w12 j

Yersion I[DDBIBU] ANSIX12 VERSION 3 HELEIj

Transaction | [350] PURCHASE ORDER =]

Release Iﬂ
r— Output Format

Tupe Im I} s Standards

SOEncy I j

Y ErSiET I j

Tratsaetong I j

Helease Iﬂ

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 31



Creating the Export Map Inbound Purchase Order (850)

10. Click OK to generate the new map (this may take a few seconds). The
new map is displayed in the following window.

#* GEMTRAN:Director - Application Integration - [EENTRAM1]

& File Edit Functions Wiew Option: Window Help ;lilil
Dl|u| &6 =] w==06E] sl 0]o] o] =
gSED - PURCHASE ORDER = OUTPUT -M- 1 =

BEG -1 BEGINMING SEGME

- -
| | 3 ] | »

Far Help, press F1 FLIR A

11. After you create a new map, it is important to define the details of the
map and save it. The Save function writes (saves) the map with current
focus to disk.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of information.
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Select Save from the File menu to display the Translation Object Details

dialog.

Tranzlation Object Details

— Surnmary
Author Description Transzlation Object Function Syztem
Esport - C
I I I et J Cancel |
—Werzion Contral
r ajor verzion ID rinor verzsion ID Compiled on I

— EDI Agsociations

Input Output
Agency Ig IX‘I 2 I_ I
Yersion [o03030 | Jamsix12VERSION ||| |
Transaction |SED |F'LIF|EZHASE ORDE | |
Releaze ID_ I_
F Group IF'D I I I
12. In the Author box, type your name. This box typically contains the name

13.

14.

15.

16.
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of the person who created the map.

In the Description box, type “PET X 3030 850 Export”. This box must
be unique because it is used by the system to identify the map. We
recommend that you use the following identifying characteristics: the
partner that this map is used for, the standard, the version, the type of
transaction this map uses, and the direction of the map (i.e., Import,
Export, etc.). For example, “PET X 3030 850 Export” is the description
of a map used with partner Pet Zone, for an ANSI X12 version 003030
Purchase Order (850), that is received Inbound (Export).

Verify that the type of map shown in the Translation Object Function list
is “Export”.

Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version number in the Major box
and accept the “0” as the release number in the Minor box.

%

The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides

Whenever any major changes are made to your map,
increase the version to the next real number (e.g., 2.0,
3.0). If you make a minor change to the map, increase
the version by a percentage point (e.g., 2.2).
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of the map are of EDI format. For the tutorial, DO NOT change the
information in these boxes.

%

The system allows you to change the information in the
Input and Output boxes, but modifying this
information does not alter the content of the map. An
example of when you may wish to alter these boxes is if
you want the map to reflect a standard version that is
not loaded on your system. You can change the version
on this dialog, and then physically alter the map to be
compliant with that version.

The Translation Object Details dialog should now look like this:

Tormwslalion Miges:t Dielails

rSummoy
bbby Diezciiption Trarslation Object Function S istem
Stedi PET 3030 850 Expoit Expot | C
o I ? I " |—I Cancel I
*erson Control

Major waigion I'I Hinar version IEI

Compiled on

Aoency

“erzmn

Flaleaen

F Group

EDI Azsocialione

F [z

Irput Output

[

|nusmn |.6.NSI H12 YERSIOM

Transachon IEED

N

|PURCHASE ORDE

|
I
—
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17. Click OK to save the translation object details and access the Save As
dialog.

Save As HE
Save in: IEMGDS j gl b

File name: ID:\GENSFNNT\Tutorial\F’et_eord.map

Sawve az type: IMaps [* map] j Cancel |

18. The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN Director\Maps.
If the current subfolder is not the correct one, select the appropriate
subfolder.

19. Type “PET_850.MAP” as the name of the map in the “File name” box.
You allocate a file name to a map when you save the map for the first
time or use the Save As function to save a copy of the map under a
different name. The name of the map must be 1-8 unique characters that
define the map in a meaningful way. For example, “PET_850.MAP” is
the name of a map for an inbound ANSI Purchase Order (850) for
partner Pet Zone.

The default file extension for maps is .MAP. Using this extension
distinguishes map files from other types of files, such as translation
objects. The naming conventions in Gentran:Director are as follows:

B The source map (map created in Gentran:Director) should be
named using the file extension .MAP (e.g., PET_850.MAP).

B The compiled translation object (translation object that is the result
of compiling the source map) should be named using the same file
name that was allocated to the source map BUT with the file
extension .TPL (e.g., PET_850.TPL).

We recommend that you use these nhaming conventions to distinguish
source maps and compiled translation objects from other types of files.
We also recommend that you use the same file name (different file
extension) for a source map and the translation object that was compiled
from it.
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Be very careful not to overlay the source map with the
compiled translation object. Use the . TPL file extension
to distinguish the translation object.

The Save As dialog should now look like this:
Save As EH I
Save jr: IaMaps j gl I: i

GEMTRAMI.map || Pet_tinv.map

Header_t.map Pet_tord. map

PET_810.map

PET_850.map

Pet_ginw. map
Pet_eard.map

File name:  [PET_B50MAP '
Save as lype: IMaps [*.map] j Cancel |

20. Click SAVE to save the map.

After you complete each section of this tutorial or when
any changes are applied to the map, you should save
the map by selecting Save from the File menu.

Now that you’ve finished creating and saving the new Export map, you need
to define the Input and Output sides of the map.

Activating EDI
Map The map components for an EDI File are the following:

Components & EDI File
] Segment
) Loop (Group)

& Composite Element
9 Element

The map components for a Positional File are the following:

Positional File
Record

Loop (Group)
Field

glmif -]
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The specific EDI map components that you use depends on the type of map
you are creating, the standard, version, and transaction set (document)
selected, and which segments and elements your company requires. We
recommend that you determine which segments and elements you are using
before starting this step.

When Gentran:Director generates the EDI sides of the map, the system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. By default, Gentran:Director displays active map components
with a black font, and inactive map components with a grey (dimmed) font.

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elements that are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

Complete the following steps to activate the required conditional groups,
segments, and elements:

1. Double-click the groups and segments in the table below to open them.
These are the groups, subgroups, segments, and elements that you need
to activate. Opening all the necessary segments and groups before you
start to activate allows you to scroll down the map and activate the
segments and elements sequentially.

Groups Segment Element
DTM DTMO02
N1 N1 N102
N3 N302
N4 N401
N402
N403
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Groups Segment Element

PO1 (already PO1 PO102

activated) PO103
PO104
PO107

PID PID PIDOS

ITA ITAOL
ITAO4
ITAO7

When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.

Click the Activate button on the Main Toolbar.

[

w

Click each inactive group that you need to use. This activates the
groups.

If you accidentally click a group that you did not mean
to activate, click the group with the right mouse button
to access the shortcut menu. Select Deactivate from the
shortcut menu.

4. Click each inactive segment that you need to use. This activates the
segments.

5. Click each inactive element that you need to use. This activates the
elements.

i | 6. Once you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn
activation mode off.
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Verifying EDI
Delimiters

EDI File Format Properties

If you are using an EDI standard that contains composite elements or
subelements, you must verify that Gentran:Director is specifying the correct
EDI delimiters. Delimiters are flags that you define to the system as
separating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the data is compressed (and the
leading zeroes and trailing blanks are removed). Since the fields vary in
length, the system needs a flag to determine where one element ends and
another begins. For example, an element delimiter marks the beginning of a
new element.

Although verifying EDI delimiters in Gentran:Director
is mandatory only if you are using a standard with
composite elements or subelements (which we are not
using in this tutorial), we recommend that perform this
task regardless of which standard you use.

Complete the following steps to verify EDI delimiters:

1. Click the 850 PURCHASE ORDER file icon with the right mouse
button to access the shortcut menu. Select Properties... from the shortcut
menu to display the EDI File Format Properties dialog.

Mame |50 Dese |PURCHASE ORDER K
[ Gtream segments

—EDI Syntax

Cancel

Fules...

Pl

[ Use syntawrecord [ Corfaing data

Tag Delimiter I Record Tag Tag elimiter Fas:

Elernent D elimiter I I Element Welmiten oz

o Tiag Fosition o
Segment Delimiter I ID— Seament Melmiter Fos

Sub Element D elimiter I: oo Lancih Sbelementbemter Eas
Release Character I ID Eelease Characten Fos

Decimal Separator I Decimal Sepanaton Fas

MR

2. Inthe EDI Syntax section, verify that the Specify defaults check box is
selected.

3. Verify the required delimiters for the ANSI X12 standard. If the
delimiters differ from the default in the table below, type either the
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character or the hexadecimal value in the correct box. The default
delimiters for ANSI X12 are the following (the tag delimiter, release
character, and decimal separator are not used for ANSI):

ANSI X12 ANSI X12
Default Default Hex
Character Value
Tag Delimiter
Element Delimiter * (asterisk) O0x2A
Segment Delimiter ~ (tilde) OX7E
Sub Element Delimiter : (colon) 0x3A

Release Character

Decimal Separator

4. Click OK to exit the EDI File Format Properties dialog.
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Defining Your Application File Format

Creating the
POHEADER
Record

If either side of your map is positional (fixed-format), you must define your
application file format to Gentran:Director. In this tutorial, the output side of
the map is positional. Your application file must contain all the information
that you need to extract from your partner’s document, so that your system
can accurately process the data.

Before you define your application file format, obtain a layout of the
necessary records, fields, and groups. The records contain related fields and
the groups contain related records. Each map component is arranged
sequentially in the order that it is most logical for the system to process.
Therefore, each level of your application file format must be created
sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. This means that you
must create records and groups before you create the subordinate fields and
records.

The first record in your application file is generally the header record. The
first record is subordinate to the icon in the application side (output) of the
map.

The POHEADER (header) record contains the purchase order type code,
shipping and billing information, delivery and cancel by date information,
and the number of line items in the purchase order. This header record is
mandatory and occurs once for each purchase order translated.

We recommend that you include a header record in
each application file. The header record is typically
mandatory and repeat only once (not a looping
structure).

Complete the following steps to create the first application record
(POHEADERY):

1. Click the Positional File icon to highlight it (Output for an inbound
map).

2. Select Create Sub from the Edit menu. Select Record from the submenu.
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The Positional Record Properties dialog is displayed.
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3. Inthe Name box, type “POHEADER?” as the record identification code.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

4. Inthe Desc box, type “PO Header Record” as the description of the
record. This box is used to provide a brief explanation of the record that
allows you to differentiate it from similar records.

5. Inthe Tag box, type “HDR” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

We recommend that you define the record tag on the
Positional Record Properties dialog, instead of defining
fields with the purpose of explicitly containing the
record tag.
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6. In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

7. Inthe Min Usage box, type “1” to make the header record mandatory.
This is the minimum amount of times the record must repeat.

If the Min Usage box contains a “0” (zero), the record
is conditional. If the Min Usage box contains a “1” or
greater, the record is mandatory.

If you want the record to repeat (loop), type the maximum amount of
times it can repeat in the Max Usage box. However, for the header
record, we recommend that you always accept the default of “1” so it
remains a record that only occurs once).

The Positional Record Properties dialog should now look like this:

I'ositional [lecord | "raparhics

rdertfcation

Mame|FOHEADER
Diezc |P|:| Headsr Fiecard
Tag [HOA Posiion |1 T Use ey Figd [ rey Fi
~Looping
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Min Uzage |1
(' Loy Sterl Ecit Fialds. .
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8. Click OK to create the POHEADER record.
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Creating the

PODetailGroup The PODetailGroup (detail information) contains all the line item
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information for the order, including the item, unit of measure, price, quantity
ordered, description, and the allowance and charge information. Each
PODetailGroup can occur up to 100,000 times per order translated. This
equals a maximum order of 100,000 items. The information within the
PODetailGroup is further segregated by related records that repeat in
sequence until either the data ends or it reaches the maximum number of
times that the loop is allowed to repeat.

Complete the following steps to create the PODetailGroup:

1. To create a group that is at the same level as the POHEADER record,
highlight the POHEADER record and select Insert from the Edit menu.
Select Group from the submenu.

The Group Properties dialog is displayed.

Liroup | 'rapcrtics

Mo |
e |
Fues. ..

Mirimum Uaags (0 [T Promote iaconds bo parant
MasimomUzage (1 =il

F
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2. Inthe Name box, type “PODetailGroup” to indicate that this group
contains all of the detail records. This is the segment loop identification
code.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.

3. Inthe Description box, type “PO Detail Group” as the loop description.
This box is used to provide a brief explanation of the loop.

Accept the default of “0” in the Minimum Usage box. This is the
minimum number of times the loop must be repeated. For a conditional
loop, the minimum usage should always be “0” (zero). For a mandatory
loop, the minimum usage should be “1” or greater.
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4. Inthe Maximum Usage box, type “100000”. This indicates that this
group of records can repeat up to 100,000 times. The Group Properties
dialog should now look like this:

Foonge Proojeliny

[ | PODetailGroup

[ e=iphion |F'EI Dielal Gmupg

Minimum Uaags (0 [T Promote reconds bo parart
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'l
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5. Click OK to create the PODetailGroup.

Creating the

PODETAIL, In this tutorial, the PODetailGroup contains three subordinate records:
PODESC. and PODETAIL, PODESC , and POALLCHG. After you create the first
’ subordinate record (PODETAIL), you can define the subsequent records at
POALLCHG the same level (PODESC and POALLCHG).

Records Complete the following steps to create the PODETAIL record:

1. Click the PODetailGroup to highlight it and select Create Sub from the
Edit menu. Select Record from the submenu.
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The Positional Record Properties dialog is displayed.
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In the Name box, type “PODETAIL” as the record identification code.

In the Desc box, type “PO Detail Record” as the description of the
record. This box is used to provide a brief explanation of the record that
allows you to differentiate it from similar records.

In the Tag box, type “DET” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.
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6.

The Positional Record Properties dialog should now look like this:
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Click OK to create the PODETAIL record.

Complete the following steps to create the PODESC record:

1.

Highlight the PODETAIL record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “PODESC” the record identification code.

In the Desc box, type “Description Record” as a description of the
record. This box is used to provide a brief explanation of the record that
allows you to differentiate it from similar records.

In the Tag box, type “DES” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.
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The Looping section of the Positional Record Properties dialog enables
you to specify the minimum and maximum number of times this record
can repeat, and whether a record is mandatory or conditional. Alter this
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section only if the record is a looping structure. Otherwise, accept the
defaults.

Accept the default of “0” in the Min Usage box. This is the minimum
amount of times the record must repeat.

6. Inthe Max Usage box, type “5” as the maximum amount of times the
record can repeat.
The Positional Record Properties dialog should now look like this:
Fozitional Hecord Hroporticz
dertfication m
Mame|FODESC -
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Diezc |DE::r'|:|Ijnn Ferard -
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7. Click OK to create the PODESC record.

Complete the following steps to create the POALLCHG record:

1.

April 2005

Highlight the PODESC record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “POALLCHG” the record identification code.

In the Desc box, type “Allowance/Charge Record” as a description of
the record. This box is used to provide a brief explanation of the record
that allows you to differentiate it from similar records.
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7.

Gentran:Director Application Integration ANSI Tutorial Guide

In the Tag box, type “ACG” as the record identification code <TAG>.
For example, a record is recognized by the system as:
<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

The Looping section of the Positional Record Properties dialog enables
you to specify the minimum and maximum number of times this record
can repeat, and whether a record is mandatory or conditional. Alter this
section only if the record is a looping structure. Otherwise, accept the
defaults.

Accept the default of “0” in the Min Usage box. This is the minimum
amount of times the record must repeat.

In the Max Usage box, type “5” as the maximum amount of times the
record can repeat.

The Positional Record Properties dialog should now look like this:
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Click OK to create the POALLCHG record.
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Creating the
POSUMMARY
Record

The final record you need to create (POSUMMARY) is at the same level as
the POHEADER record and the PODetailGroup.

The POSUMMARY (summary) record contains the total number of line
items in the purchase order. The POSUMMARY record occurs once for each
purchase order translated.

Complete the following steps to create the POSUMMARY record:

1. Highlight the PODetailGroup and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

Use “Insert” from the Edit menu when you want to
create equal records/groups and to use “Create Sub” to
create subordinate groups/records/fields.

2. In the Name box, type “POSUMMARY™ as the record identification
code.

3. Inthe Desc box, type “PO Summary Record” as the description of the
record. This box is used to provide a brief explanation of the record that
allows you to differentiate it from similar records.

4. Inthe Tag box, type “SUM?” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that

record and then determine the mapping requirements.

5. Inthe Position box, accept the default of “1” as the starting column
position of the tag in the data record.

Accept the default of “0” in the Min Usage box. This is the minimum
amount of times the record must repeat.

Also, accept the default of “1” in the Max Usage box so the summary
record only occurs once (not a looping structure).
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The Positional Record Properties dialog should now look like this:
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6. Click OK to create the POSUMMARY record.

The application side of the map (output) should now look like this:

OUTPUT - €5
FOHEADER -M- 1 PO Header Record
PODetailGroup -C- 100000 PO Detail Gruupﬁ
PODETAIL -C-1 PO Detail Recard
PODESC -C- & Description Aecard
POALLCHG -C- 5 Allowance/Charge Recaord
POSUMMARY -C- 1 Summary Record

Creating the

Application Each record you create contains a group of logically-related application
Fields fields. These fields define the structure and content of the data that your
system needs to process the purchase order.

The easiest way to add application fields to a record is to use the Positional

Field Editor. Generally, you create the fields for the first record in the
application file (POHEADER), and then proceed with each sequential
record.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005

51



Defining Your Application File Format Inbound Purchase Order (850)

The application fields that you need to create are listed under their respective
records in the following table. The name, mandatory status, description, data
type, and field length for each field is given in the table.

Field Name Description L;\f]ig?th Lg/lne;xth
Header Record (POHEADER) 1 per document
CUSTNUMHDR X Customer Number String 1 8
PODATEHDR X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMHDR X Purchase Order Number String 1 22
POTYPCODE Purchase Order Type Code String 0 2
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD?2 Ship To Address Line 2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
BILLTONAME Bill To Name String 0 35
BILLTOADD1 Bill To Address Line 1 String 0 35
BILLTOADD2 Bill To Address Line 2 String 0 35
BILLTOCITY Bill To City String 0 30
BILLTOSTATE Bill To State String 0 2
BILLTOPOSTALCODE Bill To Postal Code String 0 9
DELDATE X Delivery Date Dt/Tm 6 6
(MMDDYY)
CANCELDATE X Cancel By Date Dt/Tm 6 6
(MMDDYY)
NUMLINEITEMS X Number of Line Items Number (NO) 1 6
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Field Name

Description

Length

PO Detail Group (PODetailGroup) up to 100,000 per document

Max

Length

Detail Record (PODETAIL) 1 per document

CUSTNUMDET X Customer Number String 1 8

PODATEDET X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDET X Purchase Order Number String 1 22

CUSTPROCODE X Customer Product Code String 1 30

UPCCODE X UPC Code String 1 30

uoM Unit of Measure String 0 7

UNITPR Unit Price Number (N2) 0 14

QTYORD X Quantity Ordered Number (NO) 1 9

Description Record (PODESC) up to 5 per document

CUSTNUMDESC X Customer Number String 1 8

PODATEDESC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMDESC X Purchase Order Number String 1 22

DESC Description String 0 80

Allowance/Charge Record (POALLCHG) up to 5 per document

CUSTNUMAC X Customer Number String 1 8

PODATEAC X Purchase Order Date Dt/Tm 6 6
(MMDDYY)

PONUMAC X Purchase Order Number String 1 22

ACIND Allowance or Charge Indicator | String 0 1

ACMETHAND Allowance or Change Method | String 0 2

of Handling Code
ACTOTAMT Allowance or Charge Total Number (N2) 0 9
Amount
Summary Record (POSUMMARY) 1 per document
CUSTNUMSUM X Customer Number String 1 8
Gentran:Director Application Integration ANSI Tutorial Guide April 2005 53



Defining Your Application File Format Inbound Purchase Order (850)

Field Name Description 'Il?yagi L;\f]ignth Lg/lnzxth
PODATESUM X Purchase Order Date Dt/Tm 6 6
(MMDDYY)
PONUMSUM X Purchase Order Number String 1 22
NUMLINEITEMSUM X Number of Line Items Number (NO) 1 6

Complete the following steps to create the application fields for the
POHEADER record:

1. Click the POHEADER application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

I'ozilianal 1eld Lditar
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3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.
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10.
11.

12.

13.

In the Name box, type “CUSTNUMHDR?”, which is the name of the
first field in the POHEADER record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “HDR” for the Header record.

Select the Mandatory check box to identify it as a required field. For this
example, the customer number must be present or else your system
cannot identify who sent the Purchase Order.

In the Description box, type “Customer Number” as the description of
the box. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

in the record, you would type the starting position of
the field in the Start Pos box. You want to specify field
start positions if, for example, you are only using a few
fields but you want them positioned exactly in the
record.

Q If you wanted to indicate the exact position of the field

In this tutorial, you use the alternative to specifying the
start position of each field, which is to add the fields
sequentially in the record and then use the Auto
Position function. Please see step 14. below for more
information on the Auto Position function.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “8” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 52.

Click DELETE to stop adding fields.
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14. .After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.

It is only valid to use the Auto Position function if you
define a record tag on the Positional Record Properties
dialog, and if you define every field in the record in the
sequence that each field occurs, as you are doing in this
tutorial.

The Positional Field Editor dialog should now look like the following
(only the last eleven fields in the record are currently visible in the
Fields list):
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15. When you are completely finished adding fields to the POHEADER
record, click CLOSE.
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Complete the following steps to create the application fields for the
PODETAIL record:

1. Click the PODETAIL application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. Inthe Name box, type “CUSTNUMDET”, which is the name of the first
field in the PODETAIL record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “DET” for the detail record.

5. Select the Mandatory check box to identify it as a required field. For this
example, the customer number must be present or else your system
cannot identify who sent the Purchase Order.

6. Inthe Description box, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

7. From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

8. If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9. Inthe Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

10. Inthe Max Length box, type “8” as the maximum length of the field.

11. To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

12. Create the rest of the fields according to the record layout table on
page 52.

13. Click DELETE to stop adding fields.

14. .After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 57



Defining Your Application File Format

Inbound Purchase Order (850)

58

positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.

The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the PODETAIL

record, click CLOSE.

Complete the following steps to create the application fields for the
PODESC record:

1.
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Click the PODESC application record with the right mouse button to
access the shortcut menu.

Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

If the field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

In the Name box, type “CUSTNUMDESC”, which is the name of the
first field in the PODESC record. Each application field must have a
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unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “DESC” for the description record.

5. Select the Mandatory check box to identify it as a required field. For this
example, the customer number must be present or else your system
cannot identify who sent the Purchase Order.

6. Inthe Description box, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

7. From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

8. If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9. Inthe Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

10. In the Max Length box, type “8” as the maximum length of the field.

11. To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

12. Create the rest of the fields according to the record layout table on
page 52.

13. Click DELETE to stop adding fields.

14. After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the PODESC record,

click CLOSE.

Complete the following steps to create the application fields for the
POALLCHG record:

1.
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Click the POALLCHG application record with the right mouse button to
access the shortcut menu.

Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

If the field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

In the Name box, type “CUSTNUMAC”, which is the name of the first
field in the POALLCHG record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “AC” for the allowance/charge record.
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5. Select the Mandatory check box to identify it as a required field. For this
example, the customer number must be present or else your system
cannot identify who sent the Purchase Order.

6. Inthe Description box, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

7. From the Data Type list, select “String” as the type of field, to specify
that this field must contain alphanumeric data.

8. If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9. Inthe Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

10. In the Min Length box, type “1” as the minimum field length. If the
minimum length is “0,” then just accept that default in the Min Length
field.

11. In the Max Length box, type “8” as the maximum length of the field.

12. To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

13. Create the rest of the fields according to the record layout table on
page 52.

14. Click DELETE to stop adding fields.

15. After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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16. When you are completely finished adding fields to the POALLCHG

record, click CLOSE.

Complete the following steps to create the application fields for the

POSUMMARY record:

1. Click the POSUMMARY application record with the right mouse
button to access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. In the Name box, type “CUSTNUMSUM?”, which is the name of the
first field in the POSUMMARY record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “SUM” for the summary record.
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5. Select the Mandatory check box to identify it as a required field. For this
example, the customer number must be present or else your system
cannot identify who sent the Purchase Order.

6. Inthe Description box, type “Customer Number” as the description of
the field. The description is used to provide a brief explanation of the
field that allows you to differentiate it from similar fields.

7. From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

8. If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

9. Inthe Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

10. In the Max Length box, type “8” as the maximum length of the field.

11. To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

12. Create the rest of the fields according to the record layout table on
page 52.

13. Click DELETE to stop adding fields.

14. After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the POSUMMARY
record, click CLOSE.

After defining your application file format to Gentran:Director, you must
map the necessary data from the EDI file to your application fields.
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Mapping Your Data

POHEADER
Record

CUSTNUMHDR

Each record contains a group of logically-related application fields. These
fields contains the information from the EDI file that your system needs to
process the purchase order. The group contains logically-related application
records.

Each record contains a three-field record key that ensures that the same
identifying information is located at the beginning of each record. Your
application file format contains a record key so that each record can be
identified individually. The record key for this purchase order consists of
your partner’s customer number, the purchase order date, and the purchase
order number.

This section examines each application field sequentially and describes the
mapping operations that you need to perform to map the appropriate data
into each field.

This section describes the actions necessary for you to map to each field in
the POHEADER (header) record. The POHEADER (header) record contains
the purchase order type code, shipping and billing information, delivery and
cancel by date information, and the number of line items in the purchase
order. This header record is mandatory and occurs once for each purchase
order translated.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner database in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner record.

For this map, you need to pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
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definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the
document record:

1.

Double-click the CUSTNUMHDR field (in the POHEADER record) to
display the Field Properties dialog:
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2.
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If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

The Advanced section is displayed only if you
previously clicked ADVANCED>> on a Field Properties
dialog (during this session of Gentran:Director
Application Integration), and did not click
<<ADVANCED to hide this section before closing the
Field Properties dialog.

In the Advanced section, select the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

From the Table list, select “Document record.” This indicates that the
system updates this field with selected information from the document
record.

Select the Exclusive check box to indicate that a compliance error
should be generated if the select does not find a valid entry

From the Map From list, choose “Partner Key.” This is the field that
contains the customer number for this partner.

From the Map To list, choose “CUSTNUMHDR.” This is the field to
which the information from the Partner Editor is mapped.
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The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK to add the standard rule to the CUSTNUMHDR field.

PODATEHDR You can map the PODATEHDR field directly from the BEGO5 (Purchase
Order Date) field, by using the Link function. The Link function allows you
to map a field or element from the Input side of the map to a field or element
on the QOutput side of the map. The link between the two fields is visually
represented with a line connecting the two fields.

Complete the following steps to map the purchase order date:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the BEGOS5 element in the BEG record. When you click the
element, the cursor changes to a “Link Arrow™: | .4k

Click the application field PODATEHDR in the POHEADER record.

4. Aline is displayed, visually illustrating the link between the BEG05
element and the PODATEHDR field.

PONUMHDR  You can map the PONUMHDR field directly from the BEGO03 (Purchase
Order Number) field, by using the Link function. The Link function allows
you to map a field or element from the Input side of the map to a field or
element on the Output side of the map. The link between the two fields is
visually represented with a line connecting the two fields.
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Mapping the purchase
order number

Setting up the document
name

Also, we recommend that you set up a Document Name for each map, to
make the identification of a document created by this map easier in
Gentran:Director. This allows you to differentiate between documents in the
document browsers in Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map.
Then, the Name field of the document browsers that contain this document
contains the data from the selected element or field.

You can choose any element or field as the Document
Name, but we strongly recommend that you select an
element or field that occurs only once in the document
and has a data type of “String.” For a Purchase Order,
the document name is typically the Purchase Order
Number.

Complete the following steps to map the purchase order number:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

2. Click the BEGO3 element in the BEG record. When you click the
element, the cursor changes to a “Link Arrow™: | .

Click the application field PONUMHDR in the POHEADER record.

4. Aline is displayed, visually illustrating the link between the BEG03
element and the PONUMHDR field.

Then, complete the following steps to set up the Document Name for this
Purchase Order:

1. Double-click the BEGO03 (0324) element to display the Field Properties
dialog.
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2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Select the Use Standard Rule check box in the Advanced section, to
display the rule options.

4. Click the Update option.

From the Table/Key list, choose “Document record.” This indicates that
you are updating the document record in Gentran:Director.

6. From the Field list, choose “Document Name.” This indicates that you
are updating the Name field in the document browsers with the contents
of this element.

The Advanced section of the Field Properties dialog should now look
like this:
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7. Click OK to set up the document name.

POTYPCODE You can map the POTYPCODE field directly from the BEG02 (Purchase
Order Type Code) field, by using the Link function. The Link function
allows you to map a field or element from the Input side of the map to a field
or element on the Output side of the map. The link between the two fields is
visually represented with a line connecting the two fields.

Complete the following steps to map the purchase order type code:

1. Ifthe Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.
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2. Click the BEGO2 element in the BEG record. When you click the
element, the cursor changes to a “Link Arrow™: |

3. Click the application field POTYPCODE in the POHEADER record.

4. Aline is displayed, visually illustrating the link between the BEG02
element and the POTYPCODE field.

SHIPTONAME On the EDI side of the map, the name and address information is contained
in a series of segments that are logically grouped in the N1 group. The N1
group contains shipping and billing name and address information, and
repeats multiple times. If the Entity Identifier Code (in the N1 segment) is
“ST,” that iteration of the N1 group contains shipping information. You need
to map the shipping information to the Ship To fields in the application
header record. If the Entity Identifier Code is “BT,” that iteration of the N1
group contains billing information. You need to map the billing information
to the Bill To fields in the application header record.

However, to map the correct information (e.g., either bill to or ship to) from
the N1 group to the Bill To and Ship To fields in the application header
record, you must extract the billing and the shipping information after
determining the type. Also, you have determined that your partner only
sends you one N3 segment (address information), so you must change the
maximum usage allowed for that segment.

Therefore, to map the shipping and billing information to your application
file format, you need to create temporary storage segments and elements on
the EDI side of the map that do not repeat. You can use an extended rule to
extract the shipping and billing information from the N1 group and move it
to the appropriate temporary storage elements. Then, you can map the
shipping and billing information directly from the temporary storage
elements to your application fields.

Creating temporary  The following table lists the temporary storage segments that you are
storage segments creating.

Ta Min Max
9 Usage Usage
BillToDet Bill To Details $$$ 0 1
ShipToDet Ship To Details $$$ 0 1
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Creating the shipping Complete the following steps to create the ShipToDet temporary storage
temporary storage segment:

segment -
Highlight the N1 group. The two temporary storage segments are

located after the N1 group, at the same level.

2. Select Insert from the Edit menu. Select Record from the submenu. The
EDI Segment Properties dialog is displayed.
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In the Name box, type “ShipToDet”.
4. In the Description box, type “Ship To Details”.

5. Inthe Tag box, type “$$$”. The system does not read a segment with a
value of “$$$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.
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The EDI Segment Properties dialog should now look like this:
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6. Click OK to create the ShipToDet temporary storage segment.
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Creating the billing Complete the following steps to create the BillToDet temporary storage

temporary storage segment:
segment

Gentran:Director Application Integration ANSI Tutorial Guide

1. Highlight the ShipToDet segment.

2. Select Insert from the Edit menu. Select Record from the submenu. The
EDI Segment Properties dialog is displayed.
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3. Inthe Name box, type “BillToDet”.
4. In the Description box, type “Bill To Details”.

In the Tag box, type “$$$”. The system does not read a segment with a
value of “$3$$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.

April 2005

73



Mapping Your Data

Inbound Purchase Order (850)

6.

The EDI Segment Properties dialog should now look like this:
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Click OK to create the BillToDet temporary storage segment.

Creating the temporary Now, you can add elements to the temporary storage segments you just
storage elements  created. The following table lists the temporary storage elements.
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Max
EDI Segment EDI Element Length
ShipToDet SHIPTONAME 35
SHIPTOADDR1 35
SHIPTOADDR2 35
SHIPTOCITY 30
SHIPTOSTATE 2
SHIPTOPCODE 9
BillToDet BILLTONAME 35
BILLTOADDR1 35
BILLTOADDR2 35
BILLTOCITY 30
BILLTOSTATE 2
BILLTOPCODE 9
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Creating the shipping Complete the following steps to create the ShipToDet elements:

t t A . .
emporar)élzrcl)qr;?é 1. Highlight the ShipToDet segment. Select Create Sub from the Edit
menu to create a subordinate element.

2. Select Field from the submenu. The Field Properties dialog is displayed
so you can define the characteristics of the new element.
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3. Inthe Name box, type “SHIPTONAME”.
4. Inthe Max box, type “35” as the maximum length.
The Field Properties dialog should now look like this:
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5. Click OK to create the SHIPTONAME element.

6. Now you can create the remaining Ship To elements. With the
SHIPTONAME element highlighted, select Insert from the Edit menu.
Then, select Field from the submenu to display the Field Properties
dialog.
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7. Repeat steps 3 through 6 to complete the remaining elements according
to the following table.

Max
EDI Segment EDI Element Length
ShipToDet SHIPTONAME 35
SHIPTOADDR1 35
SHIPTOADDR2 35
SHIPTOCITY 30
SHIPTOSTATE 2
SHIPTOPCODE 9

Creating the billing Complete following steps to create the BillToDet elements:
temporary storage

clements Highlight the BillToDet segment. Select Create Sub from the Edit menu

to create a subordinate element.

2. Select Field from the submenu. The Field Properties dialog is displayed
so you can define the characteristics of the new element.

bicld Properics
Nare |
Descriplice I
Data YWaidatian Advancad s
Mitn Mzt Typs Frmat —
[ Mandatony |[I I':' ISIrihg H Ix Corddiliors

3. Inthe Name box, type “BILLTONAME”".
4. Inthe Max box, type “35” as the maximum length.
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The Field Properties dialog should now look like this:
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Changing the max use of
the N3 segment

5. Click OK to create the BILLTONAME element.

6. Now you can create the remaining Bill To elements. With the
BILLTONAME element highlighted, select Insert from the Edit menu.
Then, select Field from the submenu to display the Field Properties
dialog.

7. Repeat steps 3 through 6 to complete the remaining elements according
to the following table.

Max
EDI Segment EDI Element Length
BillToDet BILLTONAME 35
BILLTOADDR1 35
BILLTOADDR2 35
BILLTOCITY 30
BILLTOSTATE 2
BILLTOPCODE 9

You have determined that your partner only sends you one N3 segment
(address information), so you must change the maximum usage allowed for
that segment.

Complete the following steps to make the N3 a nonrepeating segment:

1. Click the N3 segment (in the N1 group) with the right mouse button to
access the shortcut menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

3. Inthe Max Usage box, type “1” to make the N3 a nonrepeating segment.
This box is currently set to “2.”

4. Click OK to accept the change to the N3 segment.
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Using an extended rule  Now you can use an extended rule to extract the shipping and billing

78

information from the N1 group and move it to the appropriate temporary
storage elements. The extended rule should be executed after the system
reads an occurrence of the N1 group.

Complete the following steps to create the extended rule:

1. Click the N1 group with the right mouse button, to access the shortcut
menu.

2. From the shortcut menu, select Rules... to display the Loop Level
Extended Rules dialog.

i Loop Level Extended Rules [_ O] =]

& 0nBegin " OnEnd
E ditar

Compile

[ e

1y of

Compile Errars

3. Click the On End option. This specifies that the rule is executed when
the loop terminates. The system loads an occurrence of the N1 group
(containing the billing or shipping information), and then executes this
rule.

4. In the Editor list, type the following:

IF #0098 = “BT” THEN

BEGIN
$850.#BILLTONAME = #0093;
$850.#BILLTOADDR1 = #0166;
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$850.#BILLTOADDR? = #0166:2;
$850.#BILLTOCITY =#0019;
$850.#BILLTOSTATE = #0156;
$850.#BILLTOPCODE = #0116;
END
IF #0098 = “ST” THEN
BEGIN
$850.#SHIPTONAME = #0093;
$850.#SHIPTOADDRL1 = #0166;
$850.#SHIPTOADDR?2 = #0166:2;
$850.#SHIPTOCITY =#0019;
$850.#SHIPTOSTATE = #0156;
$850.#SHIPTOPCODE = #0116;
END

If a segment/record or element/field occurs more than
once in a map it is identified by its name <ID>. The
second and subsequent occurrences are identified by
<ID>:n, where “n” is the number of the occurrence in
the map.

5. Click COMPILE to validate the syntax of the extended rule. Every rule
in the map is compiled when you compile the translation object, after
you complete the map. However, the system allows you to compile each
rule individually, so that you can verify the accuracy of the rule after
you create it.

This compiles the rule interactively, and allows you to
correct any errors that are generated. Any errors or
warnings generated in the compilation process are
displayed in the Errors list.

6. Click OK to add the extended rule to the N1 group.

Mapping the ship to  After creating the temporary storage segments and elements and adding the
name information  extended rule, you can map the shipping and billing information directly
from the temporary storage elements to your application fields.

Complete the following steps to map the ship to name:

1. If the Linking function is not currently active, click the Link button on
the Main Toolbar to turn on the Linking function.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 79



Mapping Your Data

Inbound Purchase Order (850)

SHIPTOADD1

SHIPTOADD?2

SHIPTOCITY

SHIPTOSTATE

SHIPTOPCODE

BILLTONAME

BILLTOADD1

BILLTOADD?2

2. Click the SHIPTONAME element in the ShipToDet temporary storage
segment. When you click the element, the cursor changes to a “Link
AMrow™: ||k

Click the application field SHIPTONAME in the POHEADER record.

4. Aline is displayed, visually illustrating the link between the
SHIPTONAME element and the SHIPTONAME application field.

To map the SHIPTOADDZ, link the SHIPTOADDRL element in the
ShipToDet temporary storage segment to the application field
SHIPTOADD1 in the POHEADER record.

To map the SHIPTOADD?2, link the SHIPTOADDR2 element in the
ShipToDet temporary storage segment to the application field
SHIPTOADD? in the POHEADER record.

To map the SHIPTOCITY, link the SHIPTOCITY element in the ShipToDet
temporary storage segment to the application field SHIPTOCITY in the
POHEADER record.

To map the SHIPTOSTATE, link the SHIPTOSTATE element in the
ShipToDet temporary storage segment to the application field
SHIPTOSTATE in the POHEADER record.

To map the SHIPTOPCODE (postal code), link the SHIPTOPCODE element
in the ShipToDet temporary storage segment to the application field
SHIPTOPOSTALCODE in the POHEADER record.

BILLTONAME element in the BillToDet temporary storage segment to the
application field BILLTONAME in the POHEADER record.

To map the BILLTOADD1, link the BILLTOADDR1 element in the
BillToDet temporary storage segment to the application field BILLTOADD1
in the POHEADER record.

To map the BILLTOADDZ2, link the BILLTOADDR?2 element in the
BillToDet temporary storage segment to the application field BILLTOADD2
in the POHEADER record.
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BILLTOCITY To map the BILLTOCITY, link the BILLTOCITY element in the BillToDet
temporary storage segment to the application field BILLTOCITY in the
POHEADER record.

BILLTOSTATE To map the BILLTOSTATE, link the BILLTOSTATE element in the
BillToDet temporary storage segment to the application field
BILLTOSTATE in the POHEADER record.

BILLTOPCODE To map the BILLTOPCODE (postal code), link the BILLTOPCODE element
in the BillToDet temporary storage segment to the application field
BILLTOPOSTALCODE in the POHEADER record.

DELDATE The DTM segment contains all the date information for the purchase order,
and repeats multiple times. If the Date/Time Qualifier (in the DTM segment)
is “001,” that iteration of the DTM segment contains Delivery Date
information. You need to map the delivery information to the DELDATE
field in the application header record. If the Date/Time Qualifier is “002, that
iteration of the DTM segment contains Cancel By Date information. You
need to map the cancel by date information to the CANCELDATE field in
the application header record.

However, you do not know the order in which these dates appear in the EDI
data. Therefore, to map the delivery and cancel by date information to your
application file, you need to create a temporary storage segment and
elements on the EDI side of the map. You can use an extended rule to extract
the delivery and cancel by date information from the DTM segment and
move it to the appropriate temporary storage elements. Then, you can map
the delivery and cancel by date information directly from the temporary
storage elements to your application fields.
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Creating a temporary Complete the following steps to create the TEMPDATES temporary storage
storage date segment segment:

1. Highlight the DTM segment. The temporary storage segment is located
after the DTM segment, at the same level.

2. Select Insert from the Edit menu. Select Record from the submenu. The
EDI Segment Properties dialog is displayed.
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In the Name box, type “TEMPDATES".
4. In the Description box, type “Temporary Storage Dates”.

5. Inthe Tag box, type “$$3$”. The system does not read a segment with a
value of “$3$$” in the Tag box. Therefore, it does not flag this temporary
storage segment as an error during compliance checking.
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The EDI Segment Properties dialog should now look like this:
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6. Click OK to create the TEMPDATES temporary storage segment.

Creating temporary Now, you can add elements to the temporary storage segment you just
storage date elements created.

Complete the following steps to create the TEMPDATES elements:

1. Highlight the TEMPDATES segment. Select Create Sub from the Edit
menu to create a subordinate element.

2. Select Field from the submenu. The Field Properties dialog is displayed
so you can define the characteristics of the new element.
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In the Name box, type “DELDATE”.

In the Description box, type “Delivery Date”.

In the Min box, type “6” as the minimum length.
In the Max box, type “6” as the maximum length.

From the Type list, select Dt/Tm. This indicates that this is a date/time
element. The system prompts you with a message that changing the
field’s data type will invalidate its format. Click YES to acknowledge
this message and proceed.

To turn off the message prompt, select Preferences
from the Options menu. Select the Confirmations tab

8.

and clear the “Confirm everything” check box. From
the “Confirm when 1...” list, clear the “Change a
format or datatype of a field” check box. Select OK to
save.

From the Format list, select “YYMMDD,” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits contain the day.

The Field Properties dialog should now look like this:
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9. Click OK to create the DELDATE element.

10. Now you can create the CANCELDATE element. With the DELDATE
element highlighted, select Insert from the Edit menu. Then, select Field
from the submenu to display the Field Properties dialog.

11. In the Name box, type “CANCELDATE”.

12. In the Description box, type “Cancel By Date”.

13. In the Min box, type “6” as the minimum length.

14. In the Max box, type “6” as the maximum length.
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15. From the Type list, select Dt/Tm. This indicates that this is a date/time
element.

16. From the Format list, select “YYMMDD,” to indicate that the first two
digits contain the year, the second two digits contain the month, and the
last two digits contain the day. The Field Properties dialog should now
look like this:
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17. Click OK to create the CANCELDATE element.

Using an extended rule Use an extended rule to extract the delivery and cancel by date information
from the DTM segment and move it to the appropriate temporary storage
elements. The extended rule should be executed after the system reads the
DTMO1 (Date/Time Qualifier).

Complete the following steps to create the extended rule:
1. Double-click the DTMO01 element to access the Field Properties dialog.
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Click RULE... to display the Field Level Extended Rule dialog.
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In the Rule list, type the following:

IF #0374:6 = “002” THEN
BEGIN

$850.#DELDATE = #0373:6;
END
IF #0374:6 = “001” THEN
BEGIN

$850.#CANCELDATE = #0373:6;
END

The system loads the DTMO02 element (containing the delivery and
cancel by date information), and then executes this rule.

Click COMP I LE to validate the syntax of the extended rule. Every rule
in the map is compiled when you compile the translation object, after
you complete the map. However, the system allows you to compile each
rule individually, so that you can verify the accuracy of the rule after
you create it.

Click OK to add the extended rule to the DTMO01 element.
Click CLOSE to exit the Field Properties dialog.
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Mapping the delivery ~ After creating the temporary storage segment and elements and adding the
date information extended rule, you can map the delivery and cancel by date information
directly from the temporary storage elements to your application fields.

To map the delivery date, link the DELDATE element in the TEMPDATES
temporary storage segment to the application field DELDATE in the
—| POHEADER record.

CANCELDATE To map the cancel by date, link the CANCELDATE element in the
TEMPDATES temporary storage segment to the application field
CANCELDATE in the POHEADER record.

NUMLINEITEMS  You can map the NUMLINEITEMS field directly from the CTTO1 (Number
of Line Items) element, by using the Link function to link the CTTO01
element in the CTT segment to the application field NUMLINEITEMS in
the POHEADER record.

PODetailGroup ) . . . o
The PODetailGroup (detail information) contains all the line item

information for the order, including the item, unit of measure, price, quantity
ordered, description, and the allowance and charge information. Each
PODetailGroup can occur up to 100,000 times per order translated. This
equals a maximum order of 100,000 items. The information within the
PODetailGroup is further segregated by record (PODETAIL, PODESC,
POALLCHG).

PODETAIL

Record This section describes the actions necessary for you to map to each field in
the PODETAIL (detail) record. The PODETAIL (detail) record contains line
item code number, unit of measure, price, and quantity ordered. The
PODETAIL record occurs once per PODetailGroup.

CUSTNUMDET ' The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
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Since the Customer Number is a part of the record key for each record, it
appears five times in the application, once in each record (CUSTNUMHDR,
CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC, and
CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application. It identifies which trading partner sent the purchase order.
This customer number is already part of the partner definition for this
partner, so you can map it from the partner definition to each customer
number field.

Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMDET field (in the PODETAIL record) to
display the Field Properties dialog:
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

4. From the Table list, select “Document record.” This indicates that the
system updates this field with selected information from the document
record.

5. Select the Exclusive check box to indicate that a compliance error
should be generated if the select does not find a valid entry.

6. From the Map From list, choose “Partner Key.” This is the field that
contains the customer number for this partner.

7. From the Map To list, choose “CUSTNUMDET.” This is the field to
which the information from the Partner Editor is mapped.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMDET field.

PODATEDET The BEGO5 (Purchase Order Date) element contains the date of the purchase
order. The BEG segment does not repeat. You need to map the information
from the BEGO5 element to the PODATEDET field. However, the
PODATEDET field is included in the PODetailGroup, which repeats
100,000 times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order date in the BEG segment
directly to your application PODATEDET field.

Therefore, to map the purchase order date to this application field, you need
to use an extended rule to extract the purchase order date from the BEG05
element and move it to the PODATEDET field.
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Using an extended rule  Complete the following steps to create the extended rule:
1. Double-click the PODATEDET field to access the Field Properties

dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:
#PODATEDET = $850.#0323;
The “$850.#0323" is the addressing for the BEG05 element. The system
executes this rule when it processes the PODATEDET field.
4. Click COMPILE to validate the syntax of the extended rule.
Click OK to add the extended rule to the PODATEDET field.
6. Click CLOSE to exit the Field Properties dialog.
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PONUMDET

Using an extended rule

The BEGO3 (Purchase Order Number) element contains the purchase order
number. The BEG segment does not repeat. You need to map the information
from the BEGO03 element to the PONUMDET field. However, the
PONUMDET field is included in the PODetailGroup, which repeats 100,000
times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order number in the BEG segment
directly to your application PONUMDET field.

Therefore, to map the purchase order number to this application field, you
need to use an extended rule to extract the purchase order number from the
BEGO3 element and move it to the PONUMDET field.

Complete the following steps to create the extended rule:

1. Double-click the PONUMDET field to access the Field Properties
dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:
#PONUMDET = $850.#0324;

The “$850.#0324" is the addressing for the BEG03 element. The system
executes this rule when it processes the PONUMDET field.

4. Click COMPILE to validate the syntax of the extended rule.
Click OK to add the extended rule to the PONUMDET field.
6. Click CLOSE to exit the Field Properties dialog.

CUSTPROCODE
UPCCODE The Application Integration subsystem enables you to use selected
information from the Gentran:Director partner database in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner record.

For this map, you need to map information from a cross-reference table for
the PETZONE partner profile, to translate your partner’s code for a
purchased item and your code for the same item. Your partner uses a
customer product code (CUSTPROCODE) for each item that is meaningful
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to him. However, your company uses a UPC code (UPCCODE) for each
item. After you and your partner determine what the equivalent customer
product code is for each UPC code, you can create a cross-reference table in
the Partner Editor and use that information in your map.

A cross-reference table is used when you and your partner each reference an
item by a different name (or number). For example, if your unique name for
a “widget” is “wid” and your partner’s unique name for the same “widget” is
“1234,” the system uses the cross-reference table to translate the two names
for the “widget” item.

In this map, you have one code (UPC code) for each item ordered. Your
partner refers to the same item by a different code (customer product code).
You need to map the customer product code from the PO107 element
(Product/Service ID) to the customer product code field (CUSTPROCODE)
on the application side of the map. Therefore, you must use a cross-reference
table to translate the customer product code to your UPC code. You and your
partner determined what the equivalent customer product code is for each
UPC code. In this tutorial, the cross-reference table is included with the
partner (PETZONE.PAR) you import into Partner Editor later in this tutorial.

The following table contains the information in the cross-reference table.
The “My Value” field contains your UPC code for the item. The “Partner
Value” field contains your partner’s customer product code for the item. The
“Description” field contains a description (and size, if applicable) of the
item, and the Reference Data field contains additional quantity or colour

information.

My Value Partner Value Description Reference Data
12345678901234 555666411 Large Dog Collar Red
23456789012345 555666817 Spring Breeze Cat Litter 10# Bag
34567890123456 555666908 Small Beef Basted Rawhide Bones Bag of 12
45678901234567 555666321 X-Large Food Bowl Black
56789012345678 555666287 FatKat Kitty Bed Blue with White Trim
67890123456789 555666413 Catnip Mouse Toy

You do not need to create this cross-reference table — it
is included with the PETZONE partner
(PETZONE.PAR) that is provided with the tutorial
data when you install Gentran:Director.

Finally, you need to use a standard rule to map the translated value from the
CUSTPROCODE field to the UPCCODE field.
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To map the customer product code, link the PO107 element in the PO1

product code  segment (in the PO1 group) to the application field CUSTPROCODE in the
PODETAIL record.

Translating Complete the following steps to translate your partner’s customer product
CUSTPROCODE to  code to your UPC Code for each item your partner ordered:

UPCCODE 1

Double-click the CUSTPROCODE field (in the PODETAIL record).
The Field Properties dialog is displayed.
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In the Advanced section, select the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

From the Table box, select “Partner xref by partner item.” This indicates
that you are using a cross-reference table and translating by your item.

In the Sub Table box, type “PRODCODE”. This is the name of the
cross-reference table you created.

Select the Exclusive check box to signal the system that if this transla-
tion fails, you want the system to generate an error.

From the Map From list, choose “My Item.” This is the field from which
the contents are mapped.

From the Map To list, choose “UPCCODE.” This is the field to which
the information from the Partner Editor is mapped.
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UOoM

UNITPR

QTYORD

The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK to map from the cross-reference table.

You can map the UOM (Unit of Measurement) field directly from the PO103
(Unit or Basis for Measurement) field, by using the Link function.

Link the PO103 element in the PO1 segment (in the PO1 group) to the
application field UOM in the PODETAIL record.

You can map the UNITPR (unit price) field directly from the PO104
element, by using the Link function.

Link the PO104 element in the PO1 segment (in the PO1 group) to the
application field UNITPR in the PODETAIL record.

You can map the QTYORD (quantity ordered) field directly from the PO102
element, by using the Link function.

Link the PO102 element in the PO1 segment (in the PO1 group) to the
application field QTYORD in the PODETAIL record.
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CUSTNUMDESC

This section describes the actions necessary for you to map to each field in
the PODESC (description) record. The PODESC (description) record
contains descriptive information about the line item ordered. The PODESC
record can occur up to five times per PODetailGroup, so multiple descriptive
terms can be used for each item. For example, if the line item is a “dog
collar,” the description fields may be “red,” “large,” and “leather.”

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner key.

For this map, you must use information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMDESC field (in the PODESC record) to
display the Field Properties dialog:
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.
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Verify that the Select option is selected.

From the Table list, select “Document record.” This indicates that the

system updates this field with selected information from the document
record.

5. Select the Exclusive check box to indicate that a compliance error
should be generated if the select does not find a valid entry.

6. From the Map From list, choose “Partner Key.” This is the field that
contains the customer number for this partner.

7. From the Map To list, choose “CUSTNUMDESC.” This is the field to
which the information from the Partner Editor is mapped.

The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMDESC field.

PODATEDESC The BEGO5 (Purchase Order Date) element contains the date of the purchase
order. The BEG segment does not repeat. You need to map the information
from the BEGO5 element to the PODATEDESC field. However, the
PODATEDESC field is included in the PODetailGroup, which repeats
100,000 times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order date in the BEG segment
directly to your application PODATEDESC field.
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Therefore, to map the purchase order date to this application field, you need
to use an extended rule to extract the purchase order date from the BEG05
element and move it to the PODATEDESC field.

Using an extended rule Complete the following steps to create the extended rule:
1. Double-click the PODATEDESC field to access the Field Properties

dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:
#PODATEDESC = $850.#0323;
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The system executes this rule when it processes the PODATEDESC
field.

4. Click COMPILE to validate the syntax of the extended rule.
5. Click OK to add the extended rule to the PODATEDESC field.
6. Click CLOSE to exit the Field Properties dialog.

PONUMDESC The BEGO03 (Purchase Order Number) element contains the purchase order
number. The BEG segment does not repeat. You need to map the information
from the BEGO03 element to the PONUMDESC field. However, the
PONUMDESC field is included in the PODetailGroup, which repeats
100,000 times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order number in the BEG segment
directly to your application PONUMDESC field.

Therefore, to map the purchase order number to this application field, you
need to use an extended rule to extract the purchase order number from the
BEGO3 element and move it to the PONUMDESC field.

Using an extended rule  Complete the following steps to create the extended rule:

1. Double-click the PONUMDESC field to access the Field Properties
dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:
#PONUMDESC = $850.#0324;
The system executes this rule when it processes the PONUMDESC
field.
4, Click COMPILE to validate the syntax of the extended rule.
Click OK to add the extended rule to the PONUMDESC field.
6. Click CLOSE to exit the Field Properties dialog.

DESC The DESC field is available so your partner can describe the item in a free-
form format. You can map the DESC (description) field directly from the
PIDO05 element, by using the Link function.

Link the PIDO5 element in the PID segment (in the PID group) to the
application field DESC in the PODESC record.

100 April 2005 Gentran:Director Application Integration ANSI Tutorial Guide



Inbound Purchase Order (850) Mapping Your Data

POALLCHG
Record

CUSTNUMAC

This section describes the actions necessary for you to map to each field in
the POALLCHG (allowance/charge) record. The POALLCHG (allowance
and charge) record contains the allowance or charge indicator, method of
handling code, and total allowance or charge amount. The POALLCHG
record can occur up to five times per PODetailGroup, so multiple allowances
and/or charges can be used for each item.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.

Complete the following steps to map the customer number from the partner
definition:

1. Double-click the CUSTNUMAC field (in the POALLCHG record) to
display the Field Properties dialog.

— [CUSTHUMAC
Deccriion | Custames Nuribes
alaalddtior—
R e el e | o
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

4. From the Table list, select “Document record.” This indicates that the
system updates this field with selected information from the document
record.

5. Select the Exclusive check box to indicate that a compliance error
should be generated if the select does not find a valid entry.

6. From the Map From list, choose “Partner Key.” This is the field that
contains the customer number for this partner.

7. From the Map To list, choose “CUSTNUMAC.” This is the field to
which the information from the Partner Editor is mapped.

The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMAC field.

PODATEAC The BEGO5 (Purchase Order Date) element contains the date of the purchase
order. The BEG segment does not repeat. You need to map the information
from the BEGO5 element to the PODATEAC field. However, the
PODATEAC field is included in the PODetailGroup, which repeats 200,000
times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
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example, you cannot map the purchase order date in the BEG segment
directly to your application PODATEAC field.

Therefore, to map the purchase order date to this application field, you need
to use an extended rule to extract the purchase order date from the BEG05
element and move it to the PODATEAC field.

Using an extended rule Complete the following steps to create the extended rule:
1. Double-click the PODATEAC field to access the Field Properties

dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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PONUMAC

3. Inthe Rule list, type the following:
#PODATEAC = $850.#0323;

The system executes this rule when it processes the PODATEAC field.
4, Click COMPILE to validate the syntax of the extended rule.

Click OK to add the extended rule to the PODATEAC field.
6. Click CLOSE to exit the Field Properties dialog.

The BEGO3 (Purchase Order Number) element contains the purchase order
number. The BEG segment does not repeat. You need to map the information
from the BEGO03 element to the PONUMAC field. However, the
PONUMAC field is included in the PODetailGroup, which repeats 200,000
times.

You can only map fields and elements that are at the same level. This means
that you cannot map to a group from a segment that does not repeat. For
example, you cannot map the purchase order number in the BEG segment
directly to your application PONUMAC field.

Therefore, to map the purchase order number to this application field, you
need to use an extended rule to extract the purchase order number from the
BEGO03 element and move it to the PONUMAC field.

Using an extended rule Complete the following steps to create the extended rule:

104

1. Double-click the PONUMAC field to access the Field Properties dialog.
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2. Click RULE... to display the Field Level Extended Rule dialog.
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3. Inthe Rule list, type the following:
#PONUMAC = $850.#0324;

The system executes this rule when it processes the PONUMAC field.
4, Click COMPILE to validate the syntax of the extended rule.

Click OK to add the extended rule to the PONUMAC field.
6. Click CLOSE to exit the Field Properties dialog.

ACIND You can map the ACIND (allowance or charge indicator) field directly from
the ITAO1 element, which indicates whether the total amount is an allowance
or charge.

Link the ITAOL element in the ITA segment to the application field ACIND
in the POALLCHG record.

ACMETHAND  You can map the ACMETHAND (allowance or charge method of handling
code) directly from the ITAO4 element, which indicates the method of
handling the allowance or charge.

Link the ITAO4 element in the ITA segment to the application field
ACMETHAND in the POALLCHG record.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 105



Mapping Your Data

Inbound Purchase Order (850)

ACTOTAMT

POSUMMARY
Record

CUSTNUMSUM

You can map the ACTOTAMT (allowance or charge total amount) directly
from the ITAO7 element.

Link the ITAO7 element in the ITA segment to the application field
ACTOTAMT in the POALLCHG record.

This section describes the actions necessary for you to map to each field in
the POSUMMARY (summary) record. The POSUMMARY (summary)
record contains the total number of line items in the purchase order. The
POSUMMARY record occurs once for each purchase order translated.

The Application Integration subsystem allows you to use selected
information from the Gentran:Director Partner Editor in your maps via a
standard rule. You can map information from your trading partner's profile in
the Partner Editor to a selected element or field in the map. The information
that you can use in the map includes any field in a table (location, lookup, or
cross-reference) or data from the partner key.

For this map, you need to pull information from the partner definition to
populate the Customer Number fields on the application side of the map.
Since the Customer Number is a part of the record key for each record, it
appears five times in the application file format, once in each record
(CUSTNUMHDR, CUSTNUMDET, CUSTNUMDESC, CUSTNUMAC,
and CUSTNUMSUM).

Your partner’s customer number is part of the record key for each record in
the application file format. It identifies which trading partner sent the
purchase order. This customer number is already part of the partner
definition for this partner, so you can map it from the partner definition to
each customer number field.
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Complete the following steps to map the customer number from the partner

definition:

1. Double-click the CUSTNUMSUM field (in the POSUMMARY record)
to display the Field Properties dialog:
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Verify that the Select option is selected.

4. From the Table list, select “Document record.” This indicates that the
system updates this field with selected information from the document
record.

5. Select the Exclusive check box to indicate that a compliance error
should be generated if the select does not find a valid entry.

6. From the Map From list, choose “Partner Key.” This is the field that
contains the customer number for this partner.

7. From the Map To list, choose “CUSTNUMSUM.” This is the field to
which the information from the Partner Editor is mapped.
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The Advanced section of the Field Properties dialog should now look
like this:
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8. Click OK to add the standard rule to the CUSTNUMSUM field.

PODATESUM  You can map the PODATESUM field directly from the BEG05 (Purchase
Order Date) field, by using the Link function.

Link the BEGO5 element in the BEG record to the application field
PODATESUM in the POSUMMARY record.

PONUMSUM  You can map the PONUMSUM field directly from the BEG03 (Purchase
Order Number) field, by using the Link function.

Link the BEGO3 element in the BEG record to the application field
PONUMSUM in the POSUMMARY record.

NUMLINEITEM  You can map the NUMLINEITEMSUM field directly from the CTTO1
SUM  (Number of Line Items) field, by using the Link function. The CTTO1
element is already directly linked to the NUMLINEITEMS field in the
POHEADER record, but Gentran:Director allows you to link an input
element to multiple output fields.

Link the CTTO1 element in the CTT record to the application field
NUMLINEITEMSUM in the POSUMMARY record.

After you complete the mapping operation for this final application field, the
icons representing each of the application fields should should be bisected
by a red checkmark. The red checkmark indicates that a mapping operation
has been performed against the field.
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Finalizing the Map

After you create the map, define your application file format, and perform
the appropriate mapping operations, you need to finalize the map. To
complete the mapping process, you need to save the map, compile the
translation object, print and review the Gentran:Director report, and test the
map.

Compiling the
Map The Compile function compiles the map and generates a translation object.
The map that you created using Gentran:Director (PET_850.MAP) is a
source map. When that source map is compiled, the result is a compiled
translation object.

This translation object must be registered with the Gentran:Director system
before you can use it.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Hame BE
Save in; I 3] Trans0b; ; ==

Pet_=10stpl

File name:  |PET_850.TFL

Save az bupe: ITransIatiDn Objects [*.TFL) j Cancel |
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3. The “File name” box automatically contains “pet_850.tpl.” This is the
name of the translation object, using the default .TPL file extension and
our recommendation that you name the translation object (. TPL file) the
same file name (1-8 characters long) as you named the map (.MAP file).
Preserving the same file name (with different file extensions) means that
the relationship between the source map and the compiled translation
object remains evident.

Do not overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.

4. Change the Drive and Folder where the compiled translation object is
stored, if necessary.

Do not store the compiled translation object in the
GENTRAN Director\RegTransObj subfolder. This
subfolder is reserved for storing a copy of each
translation object you register with Gentran:Director.

o

Click SAVE and the system compiles the map and generate a translation
object. The Compile Error dialog is displayed. Verify that no errors
occurred (scroll down to the bottom of the list). Click OK to exit the
dialog. The date on which the translation object was compiled is
automatically loaded into the Compiled on box on the Translation
Obiject Details dialog.

At Dasodptin TiwetonCtiscd Frcdss S m
[shing  [PETH I EDEMck | [Eact B
eskn Gl
Marwvewon [1 | Hroovenm [0 Conpledn [1B0X1 G
EDIA
pd Ouipd
Sz B |
Yfarscn UWEE | [AHE XI2VEFSLN
Trwwcion  [A0 [PURCHASE OFGE
L [
Favn [ I

6. Select Save from the File menu to save the source map with the
Compiled on date.

You must register this translation object with the
Gentran:Director system before you can use it. See the
Gentran:Director User’s Guide for information on
registering a translation object.
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Printing the

Report The Gentran:Director report enables you to validate and review the map, and
make modifications as needed. If you review the report and determine that
the map is incorrect, you should refine the mapping process as many times as
necessary (make the modifications, save the map, recompile the translation
object, and print the report again).

Complete the following steps to print the Gentran:Director report:

1. Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.

— Repart zections

¥ Print branching diagram

¥ Print record details Cancel |

¥ Print mapping details

¥ Fiint extended rules

¥ Print code lists

¥ Include only active objects

2. Accept the defaults on this dialog (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog is displayed.

3. Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report is printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialog is displayed.

4. Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog. Click OK on the Print dialog and the
mapping report is printed.

Click OPTIONS... if you need to access printer setup options
information. The Options dialog is displayed.

5. Set the appropriate options. Click OK to return to the Print Setup dialog.
Click OK on the Print Setup dialog to return to the Print dialog. Click
OK on the Print dialog and the mapping report is printed.
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Testing the

Translation After you compile the map, print and verify the report, and register the
Object translation object with Gentran:Director, you should test the translation
object to verify that the data is translated correctly. To test the compiled
translation object, you should obtain test data from your partners and process
the data. You should also verify acknowledgement processing (if applicable)
and verify communications with your trading partner.

Complete the following steps to test the inbound (Export) translation object
you just created:

1.
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Register the PET_850.TPL translation object with Gentran:Director.
Please see the Gentran:Director User’s Guide for more information on
registering a translation object.

Import the PETZONE.PAR partner relationship into Gentran:Director.
Please see the Gentran:Director User’s Guide for more information on
importing a partner.

The default full path for the partner file is:
C:\Program Files\Sterling Commerce\GENTRAN Director\
TUTORIAL\PETZONE.PAR

Verify (in Partner Editor) that the PET X 3030 850 Export translation
object is selected for the Inbound Relationship. Please see the
Gentran:Director User’s Guide for more information on selecting
inbound translation objects.

Use the Process File option in Gentran:Director to process the data file

(PETTEST.INT) through the translation object. The data file is located

in the TUTORIAL subfolder under the folder where Gentran:Director is
installed.

The default full path for the data file is: C:\Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PETTEST.INT

After the document is translated, it is located in the In Documents in
Gentran:Director. Export the document to ensure that it was translated
correctly. Please see the Gentran:Director User’s Guide for more
information on exporting files.
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This tutorial exercise delineates the step-by-step tasks that are necessary to
create a map that is used to translate your application file to ANSI X12
invoices (810) that you send to your trading partner.

This chapter explains all the tasks and processes associated with creating a
map for an outbound invoice, including the following:

Mapping analysis

Creating the new map

Defining constants

Activating groups, segments, and elements

Defining the application side of the map

Mapping your data

Finalizing the map
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Getting Started

114

Outbound
Mapping
Scenario

Mapping
Analysis

This tutorial exercise is meant to be completed in its entirety. We
recommend that you complete each task sequentially, without referring to
the completed map that is provided with the installation program (although
you may want to verify your completed map with the model).

The purpose of completing each task in this tutorial in sequential order as if
it were your own scenario, is to teach you not only how to perform the
individual mapping tasks, but also to teach you a logical approach and
methods that should be utilized when you create your own map.

For outbound translation, you must set up a system import map and an
import map. Generally, you create one system import map for each message
type and create one import map for each partner to whom you send
messages.

In this tutorial exercise, your company is MWT Manufacturing Co., which
manufactures a wide variety of supplies for pet stores. Your company sells
pet supplies directly to large pet supply retail chains. You need to create a
map that enables your company to translate your application file to the
invoices that you send to one of your trading partners, Pet Zone (a large pet
supply retailer). After you ship an order to Pet Zone, generate the
corresponding invoice, and once your application file is translated into an
EDI invoice, your company can send the invoice to Pet Zone.

You have an existing application file layout from your accounts payable
department, that defines the information your system generates for the
invoice. And from discussions with the Pet Zone, you know the
requirements for the EDI invoices that you are sending them.

The first step in creating a map is the analysis of the mapping requirements.
This is the most important step in creating a successful map. If the analysis
you perform is complete, you have all the information you need to create the
map in an efficient and logical manner. If you omit this critical step and
proceed directly to creating the map, it is likely that creating the map will be
a much longer and arduous task, and the map may be invalid due to
oversights and omissions.
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Regardless of whether you are translating data inbound or outbound,
mapping analysis involves the following steps:

1. Analyzing your application file format
2. Analyzing your partners EDI file
3. Correlating your application file format and the EDI file

After you complete these steps, you can begin creating the map.

Analyzing Your The first step of mapping analysis is analyzing your application file format,
Application File because this is probably the component that is the most familiar to you. For
Format an outbound map, your application file contains the data that you need to
convert to an EDI file so your system can generate the document correctly.
In this tutorial, your application file contains all the information that you
need to generate the invoice that you send your partner, so that your
company can bill your partner correctly for the goods you shipped to them.

You must define your application file to Gentran:Director. If your company
has an existing application file, as in this tutorial, you should obtain the
record layout from the appropriate person. If you did not have an existing
application file layout, you would need to create one by determining which
fields are necessary to process the data correctly, and then grouping the
fields logically under records.

The application file layout for the system import map in this tutorial is as

follows:
Field Name Description Max
Length
Header Record (HEADER) 1 per document
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1
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The application file layout for the import map in this tutorial is as follows:

Field Name Description Lg/lnzxth
Header Record (HEADER) 1 per document
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1
Beginning Record (INVBEGIN) 1 per document
BILLTOACCTBEG X Bill to Acct Number String 1 9
DOCTYPBEG X Document Type String 1 6
INVNUMBEG X Invoice Number String 1 10
INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)
PONUM Purchase Order Number String 0 20
PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)
VENDNAME Vendor Name String 0 35
VENDADD1 Vendor Address Line 1 String 0 35
VENDADD2 Vendor Address Line2 String 0 35
VENDCITY Vendor City String 0 30
VENDSTATE Vendor State String 0 2
VENDPOSTALCODE Vendor Postal Code String 0 9
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD?2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
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Field Name Description Lg/lnzxth
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
SHIPTOLOC Ship To Store Location String 0 9
SHIPTODEPTNUM Ship To Dept Number String 0 4
REMITTONAME Remit To Name String 0 35
REMITTOADD1 Remit To Address Line 1 String 0 35
REMITTOADD2 Remit To Address Line 2 String 0 35
REMITTOCITY Remit To City String 0 30
REMITTOSTATE Remit To State String 0 2
REMITTOPOSTALCODE Remit To Postal Code String 0 9
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6

(YYMMDD)
TERMS_WHOLE Terms Percent Whole Number (N2) 0 3
TERMSNETDUE Terms Net Due Days Number (NO) 0 3
TERMSDISDUE Terms Discount Due Days | Number (NO) 0 3

Comment Group (INVCommentGroup) 1 per document

Comment Record 1 (INVCOMMENT1) 1 per document

BILLTOACCTCM1 X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
REFNUM X Reference Number String 1 30

Comment Record 2 (INVCOMMENTZ2) 10 per document

BILLTOACCTCM2 X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232
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Max

Field Name Length

Description

Detail Record (INVDETAIL) up to 200,000 per document

BILLTOACCTDET X Bill To Acct Number String 9
DOCTYPDET X Document Type String 6
INVNUMDET X Invoice Number String 10
ITEMNUM X Item Number (Our Item) String 6
QTYSHIP X Quantity Shipped Number (NO) 5
QTYORD X Quantity Ordered Number (NO) 5
UNITPRICE X Unit Price Number (N2) 7
uoMm X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
TERMSTYPE Terms Type Code String 0 2
TERMSDISP Terms Discount Percent Number (N2) 0 6
Summary Record (INVSUMMARY) 1 per document
BILLTOACCTSUM X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT X Total Monetary Value Number (N2) 1 10
Summary
TRANSTOTAL X Transaction Totals Number (NO) 1 6
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The above table contains the minimum information necessary to define your
application file to Gentran:Director (hame, mandatory status, description,
data type, and field length). Each record contains a group of logically-related
application fields. These fields contain the information that your system
needs to generate the invoice.

Each record (except the HEADER record, which is used for selecting the
appropriate trading relationship) contains a three-field record key that
ensures that the same identifying information is located at the beginning of
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each record. Your application file format contains a record key so that each
record can be identified individually. The record key for this invoice consists
of your partner’s bill to account number, the document type, and the invoice
number. The records are defined as follows:

B The HEADER (header) record contains the five-field key (partner
identifier, standard, version, transaction set, and test/production flag),
which is used for selecting the appropriate trading relationship. This
header record is mandatory and occurs once for each invoice translated.

B The INVBEGIN (beginning) record contains the purchase order number
and date; the vendor, ship to, and remit to address information; and the
bill of lading number, ship date, and term of the invoice. The beginning
record is mandatory and occurs once for each invoice.

B The INVCommentGroup (comment information) groups all the
comment information for the invoice, including the reference number
and the message text. The INVCommentGroup occurs once per invoice
translated. The information within the INVCommentGroup is further
segregated by record.

B The INVCOMMENTL (first comment) record contains the reference
number. The first comment record is mandatory and occurs once per
invoice translated (once for each comment line).

B The INVCOMMENT?2 (second comment) record contains message text.
The second comment record is mandatory and occurs up to ten times per
invoice translated (once for each comment line).

B The INVDETAIL (detail) record contains line item number and
description, quantity shipped, quantity ordered, unit of measure, price,
product code, and invoice terms. The detail record is mandatory and
occurs up to 200,000 times per invoice translated (once for each line
item invoiced).

B The INVSUMMARY (summary) record contains the total invoice
amount and the total transaction amount. The summary record is
mandatory and occurs once per invoice translated.

Now that you have analyzed your application file, the next step is to
determine the requirements of the invoice that you send to your partners.

To analyze the EDI file, you must first determine what you need to send
your trading partner and what your partner expects to receive. You and your
partners must agree on which standard, version, and transaction set you are
using. In this tutorial, we are using an ANSI X12 version 003030 810
invoice. It is important to know the information that your partners expects
you to send within the invoice, and what data is contained in each element
used.
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Before you analyze the EDI file, it is helpful to review the EDI standard(s)
that you will use. Obtain an EDI standards manual for each standard and
version that you are using. Standards manuals are available from EDI

standard agencies.

After discussing with your partner what you will send, determining which
segments and elements your partner requires, and reviewing the EDI
standard, make a list of the map components that you must make available

for use (activate).

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elements that are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.

For this tutorial, the map components that are required are the following:

Segment Element
BIG BIGO3
(already active) BIG0O4
REF REF02
N1 N1 N102
N3 N302
N4 N401
N402
N403
REF:2 REF02
ITD ITDO3
ITDO5
ITDO7
DTM DTMO2
N9 N9 N902
MSG

April 2005
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Groups Segment Element
IT1 IT1 IT101
IT106
IT107
IT108
IT109
QTY

PID PID:2 PIDO5
ITD:2 ITDO1
ITDO3
CTT CTT02

(already active)

When you activate a conditional group or segment, the
mandatory subordinate segments and elements are
automatically activated.

We recommend that you set up a Document Name for each map, to make the
identification of a document created by this map easier in Gentran:Director.
This allows you to differentiate between documents in the document
browsers in Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map.
Then, the Name field of the document browsers that contain this document
contain the data from the selected element or field. You can choose any
element or field as the Document Name, but we strongly recommend that
you select an element or field that occurs only once in the document and has
a data type of “String.” In this tutorial, the document name for the import
map in this tutorial is the invoice number.

You can also establish a Document Reference for each map, which also
assists you in differentiating between documents in the document browsers
in Gentran:Director. When you set up the Reference in the Application
Integration subsystem, the RefData field of the document browsers that
contain this document in Gentran:Director contains the data from that
mapped field. In this tutorial, the document reference for the import map in
this tutorial is the purchase order number.

Since you are creating an import map to create outbound data, you must
define constants in the qualifier elements on the EDI (output) side of the
map. Part of the mapping analysis for an import map is determining in which
elements you must define and use qualifiers, and determining which

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 121



Getting Started

Outbound Invoice (810)

elements they qualify. You must use constant values that are compliant with
the EDI standard.

For this tutorial, you must define the following constants to create the
required qualifier elements:

Element Element
. Constant .
Using Constant ID value it

Constant Qualifies
REFO01 BILL_OF_LADING BM REF02
N101 VENDOR VN N102
(N1_Vendor) (N1_Vendor)
N101 SHIP_TO ST N102
(N1_ShipTo) (N1_ShipTo)
REFO01 DEPT_NUMBER DP REF02
(N1_ShipTo) (N1_ShipTo)
REFO01 STORE_NUMBER SN REF02
(N1_ShipTo) (N1_ShipTo)
N101 REMIT_TO RI N102
(N1_RemitTo) (N1_RemitTo)
DTMO1 DATE DTM DTMO02
N901 VENDOR_NUMBER v N902
IT106 UPC_CODE ul IT107
1IT108 BUYER_CODE BP IT109
QTYO1 ORIGINAL_QUANTITY OR QTY02
PIDO1 FREE_FORM F PID05

Correlating Your
Application File
and the EDI File

After you complete the analysis of the EDI file and your application file
format, the final step in mapping analysis is correlating the two components.

When you are translating data outbound, you need to build an import map
and a system import map. The system import map is used by
Gentran:Director to find the partner relationship for a document, to
determine which import map is used to translate the data. The system import
map builds the key that the translator uses to find the partner relationship.
The sole function of the system import map is to identify the appropriate
partner relationship; the system import map does not map any data.
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There are two ways to build the key in a system import map: the five-field
key (six-field for TRADACOMS standard) or the three-field key.

The method that we recommend, and demonstrate in this tutorial, requires
six EDI-specific fields in the header record: partner key, standard, version,
transaction set, release (for TRADACOMS only), and test/production status.
The combination of these six fields defines a unique key that identifies the
appropriate partner relationship. We recommend using this method because
it is very flexible. Typically, you use this method when you are defining
your application from scratch and can easily add the EDI-specific fields that
are not already present in the header record.

The second method is easier to build because it only requires three fields in
the header record (partner key, application ID, and application alias value).
Please note that an empty string is a valid value in the application ID and
application alias value fields. The combination of these three fields defines a
unique key that identifies the appropriate partner relationship. However,
because only three fields are combining to build the key, this method is not
as flexible as the preferred method. Typically, you use this method when you
are using a legacy (existing) application definition, and you do not want to
add EDI-specific information.

To reconcile your application file with the EDI file, for each application field
you must determine which EDI element you need to populate with that
information, and how you can map that information to the EDI file. To map
information to an element, you can use linking, standard rules, extended
rules, or a combination of the three.

Linking (simple mapping) enables you to map a field or element from the
input side of the map to a field or element on the output side of the map. The
link between two map components (hereafter referred to as fields) is visually
represented with a line connecting the two fields. Standard rules give you
access to functions that are necessary for mapping operations that are more
complex than simple linking, but less involved than extended rules.
Extended rules enable you to use a Gentran:Director proprietary
programming language to perform virtually any mapping operation you
require.

We recommend that you determine which mapping operations are required
on a field-by-field basis for your application file.
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The following mapping operations (by application field) are required for the
system import map in this tutorial:

Mapping
Operations

Field Name Description

Header Record (HEADER) 1 per document

PARTNER_ID Partner Identifier Select standard rule to match
the EDI Code in the Partner
record (Partner by EDI Code)

STANDARD Standard Update standard rule to update
the Agency field on the
Document record

VERSION Version Update standard rule to update
the Version field on the
Document record

TRANSACTION_SET Transaction Set Update standard rule to update
the Transaction Set ID field on
the Document record

TEST_PROD Test/Production Flag Update standard rule to update
the Test Mode field on the
Document record

The following mapping operations (by application field) are required for the
import map in this tutorial:

Mapping
Operations

Field Name Description

Header Record (HEADER) 1 per document

PARTNER_ID Partner Identifier No mapping required
STANDARD Standard No mapping required
VERSION Version No mapping required
TRANSACTION_SET Transaction Set No mapping required
TEST_PROD Test/Production Flag No mapping required

Beginning Record (INVBEGIN) 1 per document

BILLTOACCTBEG Bill to Acct Number No mapping required

DOCTYPBEG Document Type No mapping required
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Field Name

Description

Mapping
Operations

INVNUMBEG Invoice Number Link to BIG02

INVDATE Invoice Date Link to BIGO1

PONUM Purchase Order Number Link to BIGO4

PODATE Purchase Order Date Link to BIGO3

VENDNAME Vendor Name Link to (N1_Vendor) N102
VENDADD1 Vendor Address Line 1 Link to (N1_Vendor) N301
VENDADD2 Vendor Address Line2 Link to (N1_Vendor) N302
VENDCITY Vendor City Link to (N1_Vendor) N401
VENDSTATE Vendor State Link to (N1_Vendor) N402
VENDPOSTALCODE Vendor Postal Code Link to (N1_Vendor) N403
SHIPTONAME Ship To Name Link to (N1_ShipTo) N102
SHIPTOADD1 Ship To Address Line 1 Link to (N1_ShipTo) N301
SHIPTOADD?2 Ship To Address Line2 Link to (N1_ShipTo) N302
SHIPTOCITY Ship To City Link to (N1_ShipTo) N401

SHIPTOSTATE

Ship To State

Link to (N1_ShipTo) N402

SHIPTOPOSTALCODE

Ship To Postal Code

Link to (N1_ShipTo) N403

SHIPTOLOC

Ship To Store Location

Link to (N1_ShipTo) REF02

SHIPTODEPTNUM

Ship To Dept Number

Link to (N1_ShipTo) REF02

REMITTONAME

Remit To Name

Link to (N1_RemitTo) N102

REMITTOADD1

Remit To Address Line 1

Link to (N1_RemitTo) N301

REMITTOADD2

Remit To Address Line2

Link to (N1_RemitTo) N302

REMITTOCITY

Remit To City

Link to (N1_RemitTo) N401

REMITTOSTATE

Remit To State

Link to (N1_RemitTo) N402

REMITTOPOSTALCODE

Remit To Postal Code

Link to (N1_RemitTo) N403

BOLNUM

Bill of Lading Number

Link to REFO2

SHIPDATE

Ship Date

Link to DTM02
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Field Name

Description

Mapping
Operations

TERMS_WHOLE Terms Percent Whole Link to ITDO3
TERMSNETDUE Terms Net Due Days Link to ITDO7
TERMSDISDUE Terms Discount Due Days Link to ITDO5

Comment Group (INVCommentGroup) 1 per document

Comment Record 1 (INVCOMMENT1) 1 per document

BILLTOACCTCM1

Bill To Acct Number

No mapping required

DOCTYPCM1 Document Type No mapping required
INVNUMCM1 Invoice Number No mapping required
REFNUM Reference Number Link to N902

Comment Record 2 (INVCOMMENT?2) 10 per document

BILLTOACCTCM2

Bill To Acct Number

No mapping required

DOCTYPCM2 Document Type No mapping required
INVNUMCM2 Invoice Number No mapping required
MESSAGETEST Message Text Link to MSGO01
Detail Record (INVDETAIL) up to 200,000 per document

BILLTOACCT Bill To Acct Number No mapping required
DOCTYPDET Document Type No mapping required
INVNUMDET Invoice Number No mapping required
ITEMNUM Item Number (Our Item) Link to IT101
QTYSHIP Quantity Shipped Link to IT102
QTYORD Quantity Ordered Link to QTY02
UNITPRICE Unit Price Link to IT104

UoMm Unit of Measure Link to IT103
CUSTPROCODE Customer Product Code Link to IT107
UPCCODE UPC Code Link to IT109
ITEMDESC Item Description Link to PID0O5
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Field Name Description Mappl_ng
Operations
TERMSTYPE Terms Type Code Link to ITDO1
TERMSDISP Terms Discount Percent Link to ITDO3

Summary Record (INVSUMMARY) 1 per document

BILLTOACCTSUM Bill To Acct Number No mapping required
DOCTYPSUM Document Type No mapping required
INVNUMSUM Invoice Number No mapping required
TOTALAMOUNT Total Monetary Value Summary Link to TDS01
TRANSTOTAL Transaction Totals Link to CTTO1

After you finish correlating your application file and EDI file on paper, you
can begin creating the system import and import maps.
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For outbound translation, you must set up a system import map and an
import map. Generally, you create one system import map for each
document type, and set up an import map for each partner you are sending
documents to.

A system import map is used by the system to find the partner relationship
for a document (flat file definition), to determine which import map is used
to translate the data. The system import map builds the key that the translator
uses to find the partner relationship. The sole function of the system import
map is to identify the appropriate partner relationship; the system import
map does not map any data.

Complete the following steps to create the system import map:

1. Select New from the File menu to create a new map. The Create New
Translation Object dialog is displayed.

Create Hew Transzlation Object

Function ||mpc,,t

[ate Saurze I

— Input Faormat

Tupe I 'I ™ Ise Standard:

Sgency I j
Y ErsiaT I j
[ [rarisacton I j

Eelease I 'l

r— Output Farmat
Type I vi = [se Standards

LAEGY I j
= el I j
IR E=ir =il I j

Eelease I 'l

From the Function list, select “System Import.”

From the Input Format Type list, select “Positional.”

4. From the Output Format Type list, select “Positional.” The system

actually ignores the Output side of the map and only processes the Input
side.
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Click OK to create the new system import map (this may take a few
seconds).

After you create the new map, it is important to define the details of the
map and save it.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of information.

Select Save from the File menu to display the Translation Object Details
dialog.

Trarslativn Mlgenc! Trelails

rSummony
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I I IS_I.I:tem Imporl |i| r Im
Wermon Conrot
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Irput Output
= |l [
‘ersmn I I I I
Tramsachon I I I I
Releass I_ I_
aon [ | |

10.

In the Author box, type your name. This box typically contains the name
of the person who created the map.

In the Description box, type “System Import HDR”. For system import
maps, we recommend that you type “System Import *”, where “*” is the
identifier for this system import map. The Imports tab of the System
Configuration program describes which system import translation
object is used to begin translation during the import process. Please see
the Administration Guide for more information about how your system
administrator must modify the system configuration program.

Verify that the Translation Object Function list contains “System
Import.”

Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version number in the Major box
and accept the “0” as the release humber in the Minor box.
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%

Whenever any major changes are made to your map,
increase the version to the next real number (e.g., 2.0).
If you make a minor change to the map, increase the
version by a percentage point (e.g., 2.1).

11. The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides

of the

map are of EDI format. For the tutorial, DO NOT change the

information in these boxes.

%

The system allows you to change the information in the
Input and Output boxes, but modifying this
information does not alter the content of the map. An
example of when you may wish to alter these boxes is if
you want the map to reflect a standard version that is
not loaded on your system. You can change the version
on this dialog, and then physically alter the map to be
compliant with that version.

The Translation Object Details dialog should now look like this:

~Eammay

Bulhor Dxmiption Trarclstion Object Furction.~ System iD

; =
I5Iuiru IS}qu'nIrrpulll'DH Iﬁyshnlnwt H I—II
~¥essiom Condinl

M sjer veiion |1 Mirai varsion II:I Compiled o

rEDI A

Inpk: Ouiput
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12. Click OK to save the translation object details and access the Save As

dialog.

Save As EHE

Save in: Ia M aps

File pame:  [SENTRANT.map N
Save as type: IMaps [*.map] j Cancel |

13. The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN Director\Maps.
If the current subfolder is not the correct one, select the appropriate
subfolder.

14. In the “File name” box, type “HEADER.MAP” as the name of the map.
You allocate a file name to a map when you save the map for the first
time or use the Save As function to save a copy of the map under a
different name. The name of the map must be 1-8 unique characters that
define the map in a meaningful way. The default file extension is
“.MAP”. Using this extension distinguishes map files from other types
of files, such as translation objects. The naming conventions in
Gentran:Director are as follows:

n  The source map (map created in Gentran:Director) should be
named using the file extension .MAP (i.e., HEADER.MAP).

n  The compiled translation object (translation object that is the result
of compiling the source map) should be named using the same file
name that was allocated to the source map BUT with the file
extension .TPL (i.e., HEADER.TPL).

Do not to overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.

15. Click SAVE to save the map.

After creating the system import map, you need to define the header
record for the system import map. You use the six-field key (this is the
preferred method) in this tutorial.
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Creating the

HEADER The only record that you define for the system import map is the header
Record record. The header record is subordinate to the icon on the input side of the
map

The HEADER (header) record contains the five fields that comprise the
system import map key. This header record is mandatory and occurs only
once.

Complete the following steps to create the header record (HEADER):

1. Click the Positional File icon on the input side of the map, to highlight
it.

2. Select Create Sub from the Edit menu. Select Record from the submenu.

The Positional Record Properties dialog is displayed.

I'ozilianal Hecoid 'roperbics
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C
MaxUzage |1 " Loop End
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® Mol
! Floating
O widoad  Sberse Tea | Postion [I

3. In the Name box, type “HEADER?” as the record identification code.

Do not use spaces or dashes (-) in the Name box. You
can use the underscore () to separate words.
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4. Inthe Desc box, type “Header Record” as the description of the record.
This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

5. Inthe Tag box, type “HDR” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

You must define the record tag on the Positional
Record Properties dialog for outbound maps, instead
of defining fields with the purpose of explicitly
containing the record tag.

6. Inthe Position box, accept the default of “1” for the starting column
position of the tag in the data record.

7. Inthe Min Usage box, type “1” to make the header record mandatory.
This is the minimum amount of times the record must repeat.

If the Min Usage box contains a “0” (zero), the record
is conditional. If the Min Usage box contains a “1” or
greater, the record is mandatory.
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The Positional Record Properties dialog should now look like this:
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8. Click OK to create the HEADER record.

Now you have to define the five fields that make up the system import key.

Creating the

HEADER To use the preferred method of building the system import key, you need to
Fields define at least five fields for the header record (partner key, standard,
version, transaction, and test/production status). These fields do not have to
be in any order or sequence, but they must be part of the header record.

After you define the header record and fields, you must set up the mapping
operations that define the key that the translator uses to find the partner
relationship.

The easiest way to add fields to a record is to use the Positional Field Editor.
The fields that you need to create are listed in the following table. The name,
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mandatory status, description, data type, and field length for each field is
given in the table.

Field Name Description 'Il?yapi L(Df]igth L(E/Ir%)(th
Header Record (HEADER) 1 per document
PARTNER_ID X Partner Identifier String 1 9
STANDARD X Standard String 1 1
VERSION X Version String 6 6
TRANSACTION_SET | X Transaction Set String 1 6
TEST_PROD X Test/Production Flag String 1 1

Complete the following steps to create the fields for the HEADER record:

1. Click the HEADER record with the right mouse button to access the
shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

Fozitional Ficld Edior
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10.

11.

12.

13.
14.

The field you are creating is the first field in the record, so click NEW. A
highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

In the Name box, type “PARTNER_ID”, which is the name of the first
field in the HEADER record. Each field must have a unique name.

Select the Mandatory check box to identify it as a required field. For the
system import map, each field in the key is mandatory.

In the Description box, type “Partner Identifier” as the description of the
field. The description is used to provide a brief explanation of the field
that allows you to differentiate it from similar fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length.
In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 134.

Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length field. Click YES to acknowledge the warning
message that fields are sequenced in order.

Please note that it is only valid to use the Auto Position
function if you define a record tag on the Positional
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Record Properties dialog, and if you define every field
in the record in the sequence that each field occurs, as
you are doing in this tutorial.
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The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the HEADER
record, click CLOSE.

Defining the

Key After you define the header record and fields, you can set up the mapping

operations that define the key that the translator uses to find the partner
relationship.
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Defining the Complete the following steps to define the partner key:

Partner Key 4 pouble-click the PARTNER_ID field to display the Field Properties
dialog.

| 1zld 'vopoatizs

— IF'.-!\FIT HEF_ID
Descripian | Patree Ientifier
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2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

4. \Verify that the Select option is selected.

From the Table list, select “Partner by EDI Code.” This indicates that
the system looks up the indicated partner key in the partner database and
updates this field.

The Advanced section of the Field Properties dialog should now look
like this:

Bdvancad

[¥ Uz Stndaid Rue
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6. Click OK to add the standard rule to the partner key field.
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Defining the Complete the following steps to define the EDI standard field:

Standard Field 1 poyple-click the STANDARD field to display the Field Properties
dialog.

Fizld Fropoiticz
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.
Click the Update option.

4. From the Table/Key list, choose “Document record.” This indicates that
you wish to store an item of data in the Gentran:Director tracking
database for the document.

5. From the Field list, choose “Agency.” This indicates that you are
updating the agency (standard) field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:

Advanced

[¥ Use Sland=rd Aule
1 Sekect (8 Updste ' Cangtant (O Uee docum O Loop Count ) Use Code

TablesKap |D|:||:umen| record H
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6. Click OK to add the standard rule to the STANDARD field.
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Defining the Complete the following steps to define the version:
Version Field 1. Double-click the VERSION field to display the Field Properties dialog.

| 1zld 'vopoatizs
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.
3. Click the Update option.

4. From the Table/Key list, choose “Document record.” This indicates that
you wish to store an item of data in the Gentran:Director tracking
database for the document.

5. From the Field list, choose “Version.” This indicates that you are
updating the standard version field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:

Bdvancad
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6. Click OK to add the standard rule to the VERSION field.
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Defining the Complete the following steps to define the transaction set (document):

Transaction Field 1 poyple-click the TRANSACTION_SET field to display the Field
Properties dialog.

| 1zld 'vopoatizs
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.
Click the Update option.

4. From the Table/Key list, choose “Document record.” This indicates that
you wish to store an item of data in the Gentran:Director tracking
database for the document.

5.  From the Field list, choose “Transaction Set ID.” This indicates that you
are updating the transaction set field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to add the standard rule to the TRANSACTION_SET field.
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Defining the Test/ Complete the following steps to define the test or production status field:
Production Field 1. Double-click the TEST_PROD field to display the Field Properties

dialog.
Fiald Propemties Ed
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D escription ITE:zr.-Prudu:Iil:n Flag
alaValdetion Ldvancad x»
Win Max  Tppe Formnat —
W Mendalos [1 [1 [coiea (2] [ Sl

2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Click the Update option.

4. From the Table/Key list, choose “Document record.” This indicates that
you wish to store an item of data in the Gentran:Director tracking
database for the document.

5. From the Field list, choose “Test Mode.” This indicates that you are
updating the release field in the system buffer.

The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to add the standard rule to the TEST_PROD field.
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Compiling the

|\/|ap The Compile function compiles the map and generates a translation object.
The map that you created using the Application Integration subsystem
(HEADER.MAP) is a source map. When that source map is compiled, the
result is a compiled translation object.

After you save the translation object, you must register it with
Gentran:Director before you can use it.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Mame E I
Savein | =4 TransDbi =l & =5 e =

File name:  [HEADER.TFL

Save as lype: | Translation Objects [* TPL) =] Cancel |

3. The “File name” box automatically contains “header.tpl.” This is the
name of the translation object, using the default .TPL file extension and
our recommendation that you name the translation object (. TPL file) the
same file name (1-8 characters long) as you named the map (.MAP file).
Preserving the same file name (with different file extensions) means that
the relationship between the source map and the compiled translation
object remains evident.

Do not overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.
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4. Change the Drive and Folder where the compiled translation object is
stored, if necessary.

5. Click SAVE and the system compiles the map and generates a
translation object. The Compile Error dialog is displayed. Verify that no
errors occurred and click OK to exit the dialog. The date on which the
translation object was compiled is automatically loaded into the
Compiled on box on the Translation Object Details dialog.
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6. Select Save from the File menu to save the source map with the
Compiled on date.

You must register this translation object with the
Gentran:Director system before you can use it. See the
Gentran:Director User’s Guide for information on
registering a translation object.

Printing the

Report The Gentran:Director report enables you to validate and review the map, and
make modifications as needed. If you review the report and determine that
the map is incorrect, you should refine the mapping process as many times as
necessary (make the modifications, save the map, recompile the translation
object, and print the report again).
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Testing the
Translation
Object

Complete the following steps to print the Gentran:Director report:

Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.

Print Options |

— Report zections

¥ Print branching diagram
v Prirt record details ﬂl
W Print mapping details
¥ Print extended rulss

W Prirt code lists

W Inchude only active objects

Accept the defaults on this dialog (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog is displayed.

Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report is printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialog is displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog. Click OK on the Print dialog and the
mapping report is printed.

Click OPTIONS... if you need to access printer setup options
information. The Options dialog is displayed.

Set the appropriate options. Click OK to return to the Print Setup dialog.
Click OK on the Print Setup dialog to return to the Print dialog. Click
OK on the Print dialog and the mapping report is printed.

After you compile the map, print and verify the report, and register the
translation object with Gentran:Director, you should test the translation
object to verify that the data is translated correctly. You test the system
import translation object (HEADER.TPL) when you test the import
translation object (on page 230).
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The first task in creating a new map is to define the format that is used for
the input and output sides of the map. In this example, you are creating an
import map so Gentran:Director can translate your application file to an
invoice that you are sending to your partner. Therefore, the input side of the
map needs to reflect your application file. The output side of the map needs
to reflect the ANSI X12 810 invoice that you send to your partner. Instead of
defining the 810 document to the system yourself, you want
Gentran:Director to use the standards database on your system to build the
invoice according to the standard.

Complete the following steps to create the import map for the outbound
invoice:

1. Select New from the File menu to display the Create New Translation
Object dialog.

Function [1mport N
[Vata Sauree I j Cancel |
 Input Format

Type Iﬁ = Wse Standand:

AaenEy I j

Y Ersn I j

Irarsachion I j
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Type Iﬂ I= | sz Standard
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Ersit I j
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2. Accept the default of “Import” in the Translation Object Function list.

Complete the Input Format section of the dialog. This is the format of
the data that is translated by the Gentran:Director system.

3. From the (Input Format) Type list, select “Positional” as the type of

format for the output data. Gentran:Director uses the term “positional”
to describe any flat file that you create.
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Now you need to complete the Output Format section of the dialog.

From the (Output Format) Type list, select “EDI” as the type of format
for the output data.

Select the Use Standards check box, because you selected “EDI” in the
Type box and because you want the system to use the standards
database on your system to build the invoice according to the standard.

To select a data source name from which Application Integration
accesses EDI standards, select one from the Data Source list. This DSN
is prompted the next time you create a map.

Select “[X] X12” as the EDI standard you are using for the input side of
the map from the Agency list.

Select “[003030] ANSI X12 VERSION 3 RELEASE 3” as the version
of the standard from the Version list. The versions that are available
depend on which standard you selected.

Select “[810] INVOICE” as the transaction set (document or message)
from the Transaction list. The transactions that are available depend on
which standard and version you selected.

The Create New Translation Object dialog should now look like this:

Create Hew Translation Object

Function I Imnpart
Data Source IGENTHAN Standards j Care] |
— Input Format

Tupe Im = Wse Gtandard:

SOency I j

TSIt I j

rarEaction I j

Helease I i I
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Agency {112 =]
Version  |(003030] ANSI 12 VERSION 3 RELEZ ¥
Transaction | [810] INVDICE =l

Releaze I hd I
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10. Click OK to generate the new map (this may take a few seconds). The
new map is displayed in the Gentran:Director - Application Integration

Window.
#* GENTRAN:Director - Application Integration [810]
&Eile Edit Functions “iew Dptionz 'Window Help _|5’|i|
I =2 = e Y 1 e e 50 e e e e
£ INPUT -H- - 210 M- INVDIEEﬂ‘_;
BEGINMING SEGMEMT FOR IMNWOICE
-
-
- 4 -
1 | 3 i | »
For Help, press F1 MUK 4

11. After you create a new map, it is important to define the details of the
map and save it. The Save function writes (saves) the map with current
focus to disk.

We recommend that you save your maps as often as
possible, to mitigate the possible loss of information.
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Select Save from the File menu to display the Translation Object Details
dialog.
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12. In the Author box, type your name. This box typically contains the name
of the person who created the map.

13. In the Description box, type “PET X 3030 810 Import”. This box must
be unique because it is used by the system to identify the map. We
recommend that you use the following identifying characteristics: the
partner that this map is used for, the standard, the version, the type of
transaction this map uses, and the direction of the map (i.e., Import,
Export, etc.). For example, “PET X 3030 810 Import” is the description
of a map used with partner Pet Zone, for an ANSI X12 version 003030
Invoice (810), that is sent outbound (Import).

14. Verify that the type of map shown in the Translation Object Function
list is “Import.”

15. Complete the Major and Minor boxes to designate a version number for
this translation object. Type “1” as the version number in the Major box
and accept the “0” as the release number in the Minor box.

Whenever any major changes are made to your map,
increase the version to the next real number (e.g., 2.0).
For minor map changes, increase the version by a
percentage point (e.g., 2.1).
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16. The Input and Output boxes (Agency, Version, Transaction, Release,
and F Group) contain information only if the Input and/or Output sides
of the map are of EDI format. For the tutorial, DO NOT change the
information in these boxes.

%

The system allows you to change the information in the
Input and Output boxes, but modifying this
information does not alter the content of the map. An
example of when you may wish to alter these es is if you
want the map to reflect a standard version that is not
loaded on your system. You can change the version on
this dialog, and then physically alter the map to be
compliant with that version.

The Translation Object Details dialog should now look like this:
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17. Click OK to save the translation object details and access the Save As
dialog.

Save As E E

Save jn: IaMaps j gl I_

File name:  [GENTRANT.map

Save as type: IMaps [*.map] j Cancel |

18. The “Save in” list should reflect the drive\folder where
Gentran:Director is installed. The default is GENTRAN DirectorMaps.
If the current subfolder is not the correct one, select the appropriate
subfolder.

19. Type “PET_810.MAP” as the name of the map in the “File name” box.
The file name should be unique. In our example, “PET_810.MAP” is
the name of a map for an ANSI invoice (810) for partner Pet Zone.

20. Click SAVE to save the map.
After you complete each section of this tutorial or when
any changes are applied to the map, you should save
the map by selecting Save from the File menu.

Now that you’ve finished creating and saving the new Export map, you need
to define the Input and Output sides of the map.
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Activating EDI Map Components

The map components for an EDI File are the following:

EDI File

Segment

Loop (Group)
Composite Element
Element

« PO

The map components for a Positional File are the following:
[ Positional File

] Record
] Loop (Group)
” Field

The specific EDI map components that you use depend on the type of map
you are creating, the standard, version, and transaction set (document)
selected, and which segments and elements your company requires. We
recommend that you determine which segments and elements you are using
before starting this step.

When Gentran:Director generates the EDI sides of the map, the system
includes all the groups, segments, composites, and elements that are defined
by the standards agency for the version of the document you selected. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. By default, Gentran:Director displays active map components
with a black font, and inactive map components with a grey (dimmed) font.

When translating data, the system does not process groups, segments,
composites, and elements (or records and fields) that are not activated.
Therefore, you must activate the groups, segments, composites, and
elements that are not defined as mandatory by the standard, but that you have
determined that you need to use in mapping.
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Complete the following steps to activate the required conditional groups,
segments, and elements:

1. Double-click the segments and groups in the table below to open them.
These are the groups, subgroups, segments, and elements that you must
activate. Opening all the necessary segments and groups before you
start to activate allows you to scroll down the map and activate the
segments and elements sequentially.

Groups Segment Element
BIG BIGO3
(already active) BIG04
REF REF02
N1 N1 N102
N3 N302
N4 N401
N402
N403
REF:2 REF02
ITD ITDO3
ITDO5
ITDO7
DTM DTMO02
N9 N9 N902
MSG
IT1 IT1 IT101
IT106
IT107
IT108
1T109
QTY
PID PID:2 PID05
ITD:2 ITDO1
ITDO3
CTT CTTO02
(already active)
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Defining Literal
Constants

When you activate a group or segment, the mandatory
subordinate segments and elements are automatically

activated.
2. Click the Activate button on the Main Toolbar.
3. Click each inactive group that you need to use. This activates the

groups.

If you click a group, segment, or element that you did
not mean to activate, click it with the right mouse
button to access the shortcut menu. Select Deactivate
from the shortcut menu.

4. Click each inactive segment that you need to use. This activates the
segments.

5. Click each inactive element that you need to use. This activates the
elements.

6. Once you have activated all the necessary groups, segments, and
elements, click the Activate button on the Main Toolbar to turn
activation mode off.

Literal constants are used by the system as a repository to store information
that is used later in the map. For an outbound map, constants are typically
used to define qualifying relationships. A qualifying relationship establishes
a relationship between an element and its qualifier. A qualifier contains a
code that further defines the element or the elements with which it is
associated. Qualifying relationships are typically defined in outbound maps.
Qualifying relationships are defined using an standard rule, as explained
later in this tutorial.

Since you are creating an import map to translate outbound data, you must
define constants to define the qualifying relationships on the EDI (output)
side of the map. After you determine which constants are used in a map, it
saves time later in the map creation process if you define all the constants at
one time.
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For this tutorial, you must define the following constants:

Constant ID

Constant
Type

Constant
Value

BILL_OF_LADING String BM
VENDOR String VN
SHIP_TO String ST
DEPT_NUMBER String DP
STORE_NUMBER String SN
REMIT_TO String RI
DATE String DTM
VENDOR_NUMBER String v
UPC_CODE String ul
BUYER_CODE String BP
ORIGINAL_QUANTITY String OR
FREE_FORM String F

Complete the following steps to create the literal constants that are used in

the import map for this tutorial:
1. Select Constants from the Edit menu or the Main Toolbar. The

Translation Object Constants dialog is displayed.
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2.

Click NEW... to access the Edit Constant dialog.

[ TGS E G T
Ir} T, —
| i
p

In the 1D box, type the “BILL_OF_LADING”, which is the first literal
constant identifier in the table. This is typically a description of the field
or element in which the constant is used.

From the Type list, select “String” as the category of this literal
constant.

In the Value box, type “BM” as the actual constant expression. This is
the value of the literal constant.

Click OK to add the constant to the system.

Repeat steps 2 — 6 to create the rest of the constants, according to the
table on page 154.

Verifying EDI

Delimiters If you are using an EDI standard that contains composite elements or
subelements, you must verify that Gentran:Director is specifying the correct
EDI delimiters. Delimiters are flags that you define to the system as
separating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the data is compressed (and the
leading zeroes and trailing blanks are removed). Since the fields vary in
length, the system needs a flag to determine where one element ends and
another begins. For example, an element delimiter marks the beginning of a
new element.

Although verifying EDI delimiters in Gentran:Director
is mandatory only if you are using a standard with

composite elements or subelements, we recommend
that perform this task regardless of which standard
you use.

Complete the following steps to verify EDI delimiters:

1.

April 2005

Click the 810 INVOICE file icon with the right mouse button to access
the shortcut menu. Select Properties... from the shortcut menu.
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The EDI File Format Properties dialog is displayed.
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2. Inthe EDI Syntax section, verify that the Specify defaults check box is
selected.

3. Verify the required delimiters for the ANSI X12 standard. If the
delimiters differ from the default in the table below, type either the
character or the hexadecimal value in the correct box. The default
delimiters for ANSI X12 are the following (the tag delimiter, release
character, and decimal separator are not used for ANSI):

ANSI X12 ANSI X12 Default
Default Hex Value
Character
Tag Delimiter
Element Delimiter * (asterisk) 0x2A
Segment Delimiter ~ (tilde) OX7E
Sub Element Delimiter : (colon) 0x3A

Release Character

Decimal Separator

4, Click OK to exit the EDI File Format Properties dialog.
Now you can define your application file layout to Gentran:Director.
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Defining the Rest of Your Application File Format

Copying the
HEADER
Record

At this point, you have already defined the header record (in the system
import map) that you can copy and use in your import map. Now you must
define the rest of your application file to Gentran:Director. In the import
map, the input side of the map is positional. Your application file must
contain all the information that you need to generate the EDI document that
you are sending to your partner.

Before you define your application file format, you should obtain a layout of
the necessary records, fields, and groups. The records contain related fields
and the groups contain related records. Each level of your application file
format must be created sequentially.

For example, your application file format contains records and groups. The
records contain fields and the group contains records. This means that you
must create records and the group before you create the subordinate fields
and records.

Since you have already defined the header record for your application file
format in the system import map, you can copy that header record to the
import map. The copied record contains subordinate fields, which is also be
copied. Copied map components retain all the information of the original
map component, so you must remove the standard rules you created for the
fields in the header record for the system import map.

Complete the following steps to copy the HEADER record from the system
import map to the import map:

1. Open the HEADER.MAP system import map, if it is not already open.
2. Highlight the HEADER record.

3. Click the Copy button on the Main Toolbar.

4. Open the PET_810.MAP import map, if it is not already open.

5

Highlight the INPUT positional file icon that you want the copied
record pasted after.

6. Select Paste from the Edit menu or the Main Toolbar to paste the
contents of the Clipboard.

The HEADER record is pasted as a subordinate map component to the
INPUT positional file icon.
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Removing the The HEADER record that you just copied from the system import map
HEADER Standard contains five fields. The first field (PARTNER_ID) has a Select standard
Rules rule applied to it in the system import map. The remaining four fields in the
copied HEADER record in the import map (STANDARD, VERSION,
TRANSACTION_SET, and TEST_PROD) have Update standard rules
applied to them in the system import map. These standard rules are not
applicable to the import map, so you must remove them.

Complete the following steps to remove the standard rules from the
HEADER record in the import map:

1. Double-click the PARTNER_ID field in the HEADER record to display
the Field Properties dialog.

|1z [ 'vepeibizs
Narne |PARTHER_ID
Descripian st |dentifer
ala W aldation
M Max T Foemat
M Mandalom I] Ig IEP::,; H IH
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2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

3. Inthe Advanced section, select the Use Standard Rule check box to
remove the standard rule.

4. The system asks you confirm the removal of the standard rule from the
field.

5. Click YES to remove the standard rule.
6. Click OK to save the change to the field.

7. Repeat steps 1 — 6 for the STANDARD, VERSION,
TRANSACTION_SET, and TEST_PROD fields.
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Creating the

INVBEGIN The second record in your application file format you need to create
Record (INVBEGIN) is at the same level as the HEADER record.

The INVBEGIN (beginning) record contains the purchase order number and
date; the vendor, ship to, and remit to address information; and the bill of
lading number, ship date, and terms of the invoice. The beginning record is
mandatory and occurs once for each invoice.

Complete the following steps to create the INVBEGIN record:

1. Highlight the HEADER record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

Use “Insert” from the Edit menu when you want to
create equal records/groups and to use “Create Sub” to
create subordinate groups/records/fields.

2. Inthe Name box, type “INVBEGIN” as the record identification code.
Do not use spaces or dashes (-) in the Name box. You
can use the underscore (_) to separate words.

3. Inthe Desc box, type “Beginning Record” as the description of the
record. This box is used to provide a brief explanation of the record that
allows you to differentiate it from similar records.

4. Inthe Tag box, type “BEG” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]

The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

You must define the record tag on the Positional
Record Properties dialog for outbound maps, instead
of defining fields with the purpose of explicitly
containing the record tag.

5. Inthe Position box, accept the default of “1” for the starting column
position of the tag in the data record.
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Creating the
INVCOMMENT
Group
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6. Inthe Min Usage box, type “1” to make the record mandatory. This box

contains the minimum amount of times the record must repeat.
If the Min Usage box contains a “0” (zero), the record
is conditional. If the Min Usage box contains a “1” or
greater, the record is mandatory.

Accept the default of “1” in the Max Usage box so the beginning record
only occurs once (not a looping structure).

The Positional Record Properties dialog should now look like this:

Pozitianal Recoid Properties
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7. Click OK to create the INVBEGIN record.

The INVCommentGroup (comment information) groups all the comment
information for the invoice, including the reference number and the message
text. The INVCommentGroup occurs once per invoice translated. The
information within the INVCommentGroup is further segregated by related
records.
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Complete the following steps to create the INVCommentGroup:

1.

6.

April 2005

To create a group that is at the same level as the INVBEGIN record,
highlight the INVBEGIN record and select Insert from the Edit menu.
Select Group from the submenu.

The Group Properties dialog is displayed.

Liroup | 'rapcrtics
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In the Name box, type “INVCommentGroup” to indicate that this group
contains all of the comment records. This is the segment loop
identification code.

In the Description box, type “Comment Group” as the loop description.
This box is used to provide a brief explanation of the loop.

In the Minimum Usage box, type “1” to make the loop mandatory. This
is the minimum number of times the loop must be repeated. For a
conditional loop, the minimum usage should always be “0” (zero). For a
mandatory loop, the minimum usage should be “1” or greater.

Accept the default of “1” in the Maximum Usage box. This indicates
that this group of records occurs only once. The Group Properties dialog
should now look like this:

Lroup 1"ropcrhics
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Cancel
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Click OK to create the INVCommentGroup.
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and
INVCOMMENT?2
Records
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In this tutorial, the INVCommentGroup contains two subordinate records:
INVCOMMENT1 and INVCOMMENT?2. After you create the first

subordinate record (INVCOMMENTL1), you can define the subsequent
record at the same level (INVCOMMENT?2).

The INVCOMMENT?1 (first comment) record contains the reference
number. The first comment record is mandatory and occurs once per invoice
translated (once for each comment line).

Complete the following steps to create the INVCOMMENT?1 record:
Click the INVCommentGroup to highlight it and select Create Sub from

1.

the Edit menu. Select Record from the submenu.

The Positional Record Properties dialog is displayed.
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In the Name box, type “INVCOMMENTL” as the record identification

code.

In the Desc box, type “Header Comment Record 1” as the description of
the record. This box is used to provide a brief explanation of the record

that allows you to differentiate it from similar records.
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4. In the Tag box, type “CM1” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that
record and then determine the mapping requirements.

5. Inthe Position box, accept the default of “1” for the starting column
position of the tag in the data record.

6. Inthe Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

Accept the default of “1” in the Max Usage box so this record only
occurs once.

The Positional Record Properties dialog should now look like this:
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7. Click OK to create the INVCOMMENT1 record.

The INVCOMMENT?2 (second comment) record contains message text. The
second comment record is mandatory and occurs up to ten times per invoice
translated (once for each comment line).
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Complete the following steps to create the INVCOMMENT?2 record:

1.

Highlight the INVCOMMENT1 record and select Insert from the Edit
menu. Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “INVCOMMENT?2” the record identification
code.

In the Desc box, type “Header Comment Record 2” as a description of
the record. This box is used to provide a brief explanation of the record
that allows you to differentiate it from similar records.

In the Tag box, type “CM2” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that

record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

In the Max Usage box, type “10” as the maximum amount of times the
record can repeat.
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The Positional Record Properties dialog should now look like this:
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8. Click OK to create the INVCOMMENT?2 record.

Creating the
INVDETAIL The INVDETAIL (detail) record is at the same level as the HEADER and
Record INVBEGIN records and the INVCommentGroup.

The INVDETALIL record contains line item number and description, quantity
shipped, quantity ordered, unit of measure, price, product code, and invoice
terms. The detail record is mandatory and occurs up to 200,000 times per
invoice translated (once for each line item invoiced).

Complete the following steps to create the INVDETAIL record:

1. Highlight the INVCommentGroup and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

2. Inthe Name box, type “INVDETAIL” the record identification code.

3. Inthe Desc box, type “Detail Record” as a description of the record.
This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.
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8.

In the Tag box, type “DET” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that

record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

In the Max Usage box, type “200000” as the maximum amount of times
the record can repeat.

The Positional Record Properties dialog should now look like this:
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Click OK to create the INVDETAIL record.
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Creating the

INVSUMMARY  The final record that you need to create is the INVSUMMARY (summary)
Record record, which is at the same level as the INVDETAIL record.

The INVSUMMARY (summary) record contains the total invoice amount
and the total transaction amount. The summary record is mandatory and
occurs once per invoice translated.

Complete the following steps to create the INVSUMMARY record:

1.

168 April 2005

Highlight the INVDETAIL record and select Insert from the Edit menu.
Select Record from the submenu to display the Positional Record
Properties dialog.

In the Name box, type “INVSUMMARY™ the record identification
code.

In the Desc box, type “Summary Record” as a description of the record.
This box is used to provide a brief explanation of the record that allows
you to differentiate it from similar records.

In the Tag box, type “SUM” as the record identification code <TAG>.
For example, a record is recognized by the system as:

<TAG>[Field_1][Field_2]
The record TAG for each record enables the system to recognize that

record and then determine the mapping requirements.

In the Position box, accept the default of “1” as the starting column
position of the tag in the data record.

In the Min Usage box, type “1” to make the record mandatory. This box
contains the minimum amount of times the record must repeat.

Accept the default of “1” in the Max Usage box. This is the maximum
amount of times the record can repeat.
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The Positional Record Properties dialog should now look like this:
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8. Click OK to create the INVSUMMARY record.

Now that you have created the record structure of the application file, you
can define the application fields.

The application side of the map (input) should now look like this:

EFINPUT M- Input Fecard

:8HE£—‘«DEFH M- 1 Header Recard
IMYBEGIM -M- 1 Eeginning Record
—ﬁlNVEnmmentErnup -M- 1 Comment Group
tgmvmmmwﬁ M- 1 Header Camment Recard 1
IMYCOMMEMT 2 -b4- 10 Header Comment Record 2
:SINVDET.-'-‘-.IL -b- 200000 Detail Record
IMYSUMMARY -1 Summary Fecord
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Creating the

Application Each record you create contains a group of logically-related application
Fields fields. These fields define the structure and content of the data that your
system needs to process the invoice.

The easiest way to add application fields to a record is to use the Positional
Field Editor. Generally, you create the fields for each sequential record,
starting with the INVBEGIN record.

The application fields that you need to create are listed under their respective
records in the following table. The name, mandatory status, description, data
type, and field length for each field is given in the table.

Max
Length

Field Name Description

Header Record (HEADER) 1 per document

PARTNER_ID X Partner Identifier String 1 9

STANDARD X Standard String 1 1

VERSION X Version String 6 6

TRANSACTION_SET X Transaction Set String 1 6

TEST_PROD X Test/Production Flag String 1 1

Beginning Record (INVBEGIN) 1 per document

BILLTOACCTBEG X Bill to Acct Number String 1 9

DOCTYPBEG X Document Type String 1 6

INVNUMBEG X Invoice Number String 1 10

INVDATE X Invoice Date Dt/Tm 6 6
(YYMMDD)

PONUM Purchase Order Number String 0 20

PODATE Purchase Order Date Dt/Tm 6 6
(YYMMDD)

VENDNAME Vendor Name String 0 35

VENDADD1 Vendor Address Line 1 String 0 35

VENDADD2 Vendor Address Line2 String 0 35

VENDCITY Vendor City String 0 30
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Field Name

Description

Min
Length

Max
Length

VENDSTATE Vendor State String 0 2
VENDPOSTALCODE Vendor Postal Code String 0 9
SHIPTONAME Ship To Name String 0 35
SHIPTOADD1 Ship To Address Line 1 String 0 35
SHIPTOADD2 Ship To Address Line2 String 0 35
SHIPTOCITY Ship To City String 0 30
SHIPTOSTATE Ship To State String 0 2
SHIPTOPOSTALCODE Ship To Postal Code String 0 9
SHIPTOLOC Ship To Store Location String 0 9
SHIPTODEPTNUM Ship To Dept Number String 0 4
REMITTONAME Remit To Name String 0 35
REMITTOADD1 Remit To Address Line 1 String 0 35
REMITTOADD2 Remit To Address Line 2 String 0 35
REMITTOCITY Remit To City String 0 30
REMITTOSTATE Remit To State String 0 2
REMITTOPOSTALCODE Remit To Postal Code String 0 9
BOLNUM Bill of Lading Number String 0 12
SHIPDATE Ship Date Dt/Tm 6 6
(YYMMDD)
TERMS_WHOLE Terms Percent Whole Number (N2) 0 3
TERMSNETDUE Terms Net Due Days Number (NO) 0 3
TERMSDISDUE Terms Discount Due Days Number (NO) 0 3
Comment Group (INVCommentGroup) 1 per document
Comment Record 1 (INVCOMMENT1) 1 per document
BILLTOACCTCM1 X Bill To Acct Number String 1 9
DOCTYPCM1 X Document Type String 1 6
INVNUMCM1 X Invoice Number String 1 10
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Field Name Description Lg/lnzxth
REFNUM X Reference Number String 1 30
Comment Record 2 (INVCOMMENT?2) 10 per document
BILLTOACCTCM2 X Bill To Acct Number String 1 9
DOCTYPCM2 X Document Type String 1 6
INVNUMCM2 X Invoice Number String 1 10
MESSAGETEXT X Message Text String 1 232
Detail Record (INVDETAIL) up to 200,000 per document
BILLTOACCTDET X Bill To Acct Number String 1 9
DOCTYPDET X Document Type String 1 6
INVNUMDET X Invoice Number String 1 10
ITEMNUM X Item Number (Our Item) String 1 6
QTYSHIP X Quantity Shipped Number (NO) 1 5
QTYORD X Quantity Ordered Number (NO) 1 5
UNITPRICE X Unit Price Number (N2) 1 7
uoMm X Unit of Measure String 1 4
CUSTPROCODE X Customer Product Code String 1 10
UPCCODE X UPC Code String 1 12
ITEMDESC Item Description String 0 30
TERMSTYPE Terms Type Code String 0 2
TERMSDISP Terms Discount Percent Number (N2) 0 6
Summary Record (INVSUMMARY) 1 per document
BILLTOACCTSUM X Bill To Acct Number String 1 9
DOCTYPSUM X Document Type String 1 6
INVNUMSUM X Invoice Number String 1 10
TOTALAMOUNT X Total Monetary Value Number (N2) 1 10
Summary
TRANSTOTAL X Transaction Totals Number (NO) 1 6
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You already created the fields for the HEADER record in the system import
map, and then copied the fields to the import map and removed the standard
rules from those fields. Therefore the first record for which you need to
define fields, is the INVBEGIN record.

Complete the following steps to create the application fields for the
INVBEGIN record:

1. Click the INVBEGIN application record with the right mouse button to
access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.
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3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. Inthe Name box, type “BILLTOACCTBEG”, which is the name of the
first field in the INVBEGIN record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
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multiple records with a suffix that identifies the record that contains it.
For example, “BEG” for the Beginning record.

Select the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the
description of the field. The description is used to provide a brief
explanation of the field that allows you to differentiate it from similar
fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If you wanted to indicate the exact position of the field
in the record, you would type the starting position of
the field in the Start Pos box. You want to specify field
start positions if, for example, you are only using a few
fields but you want them positioned exactly in the
record.

In this tutorial, you use the alternative to specifying the
start position of each field, which is to add the fields
sequentially in the record and then use the Auto
Position function. Please see step 14. below for more
information on the Auto Position function.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 170.

Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
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15. When you are completely finished adding fields to the INVBEGIN

in the Max Length box. Click YES to acknowledge the warning

message that fields are sequenced in order.

Please note that it is only valid to use the Auto Position
function if you define a record tag on the Positional

Record Properties dialog, and if you define every field
in the record in the sequence that each field occurs, as

you are doing in this tutorial.

Fields list):
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record, click CLOSE.

Complete the following steps to create the application fields for the
INVCOMMENT1 record:

1.
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The Positional Field Editor dialog should now look like the following
(only the last eleven fields in the record are currently visible in the

Click the INVCOMMENT?1 application record with the right mouse
button to access the shortcut menu.
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Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

If the field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

In the Name box, type “BILLTOACCTCML1”, which is the name of the
first field in the INVCOMMENT1 record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “CM1” for the first comment record.

Select the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the
description of the field. The description is used to provide a brief
explanation of the field that allows you to differentiate it from similar
fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 170.

Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the
INVCOMMENT1 record, click CLOSE.

Complete the following steps to create the application fields for the
INVCOMMENT?2 record:

1. Click the INVCOMMENT?2 application record with the right mouse
button to access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. In the Name box, type “BILLTOACCTCM2”, which is the name of the
first field in the INVCOMMENT2 record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “CM2” for the second comment record.
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Select the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the
description of the field. The description is used to provide a brief
explanation of the field that allows you to differentiate it from similar
fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 170.

Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following:
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15. When you are completely finished adding fields to the
INVCOMMENT? record, click CLOSE.

Complete the following steps to create the application fields for the
INVDETAIL record:

1. Click the INVDETAIL application record with the right mouse button
to access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. In the Name box, type “BILLTOACCTDET”, which is the name of the
first field in the INVDETAIL record. Each application field must have a
unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “DET” for the detail record.
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Select the Mandatory check box to identify it as a required field.

In the Description box, type “Bill To Account Number” as the
description of the field. The description is used to provide a brief
explanation of the field that allows you to differentiate it from similar
fields.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 170.

Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. This automatically calculates the start
position in the record of each field based on the criteria that each field is
positioned directly after the previous field and is of the length specified
in the Max Length box. Click YES to acknowledge the warning
message that fields are sequenced in order.
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The Positional Field Editor dialog should now look like the following
(only the last eleven fields in the record are currently visible in the

Fields list):
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15. When you are completely finished adding fields to the INVDETAIL
record, click CLOSE.

Complete the following steps to create the application fields for the
INVSUMMARY record:

1. Click the INVSUMMARY application record with the right mouse
button to access the shortcut menu.

2. Select Edit Fields... from the shortcut menu to access the Positional
Field Editor dialog.

3. Ifthe field you are creating is the first field in the record, just click NEW.
A highlight bar is displayed in the Fields section where the new field is
positioned. You need to fill in the field values in the Field Details
section.

4. Inthe Name box, type “BILLTOACCTSUM?”, which is the name of the
first field in the INVSUMMARY record. Each application field must
have a unique name. It is useful to tag the end of the fields that occur in
multiple records with a suffix that identifies the record that contains it.
For example, “SUM?” for the summary record.

5. Select the Mandatory check box to identify it as a required field.
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In the Description box, type “Bill To Account Number” as the
description of the field.

From the Data Type list, select “String” as the type of the field, to
specify that this field must contain alphanumeric data.

If the Data Type is “Number” or “Dt/Tm,” select the appropriate format
from the Format list.

In the Min Length box, type “1” as the minimum field length. If the
minimum length of the field is “0,” then accept that default in the Min
Length box.

In the Max Length box, type “9” as the maximum length of the field.

To add the field and to create the next field positioned after it, press
ENTER. A new field with blank values ready for you to identify is
positioned below the field.

Create the rest of the fields according to the record layout table on
page 170.
Click DELETE to stop adding fields.

After adding the last field, click AUTO POSITION to automatically
position the fields in the record. Click YES to acknowledge the warning
message that fields are sequenced in order.

The Positional Field Editor dialog should now look like the following:
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When you are completely finished adding fields to the INVSUMMARY
record, click CLOSE.
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Mapping Your Data

HEADER Record

INVBEGIN
Record

BILLTOACCTBEG

DOCTYPBEG

Each record in the import map contains a group of logically-related
application fields. These fields contain the information that your system
needs to generate the invoice. The group contains logically-related
application records.

Each record (except the HEADER record that you defined for the system
import map using an explicit six-field key) contains a three-field record key
that ensures that the same identifying information is located at the beginning
of each record. Your application file format contains a record key so that
each record can be identified individually. The record key for this invoice
consists of your partner’s bill to account number, the document type, and the
invoice number.

This section examines each application field sequentially and describes the
mapping operations that you need to perform to map the appropriate data
from each field.

For the import map, you will not map from any of the fields in the HEADER
(header) record. This record contains the five fields that comprise the key in
the system import map. However, since this header record is a part of your
application file, it must be defined in the import map, as well. You did this
when you copied the HEADER record from the system import map to this
import map. This header record is mandatory and occurs only once.

This section describes the actions necessary for you to map from each field
in the INVBEGIN (beginning) record. The INVBEGIN (beginning) record
contains the purchase order number and date; the vendor, ship to, and remit
to address information; and the bill of lading number, ship date, and term of
the invoice. The beginning record is mandatory and occurs once for each
invoice.

The BILLTOACCTBEG field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The DOCTYPBEG field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.
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INVNUMBEG

Mapping the invoice
number

You can map the INVNUMBEG field directly to the BIG02 (Invoice
Number) field, by using the Link function. The Link function allows you to
map a field or element from the Input side of the map to a field or element on
the Output side of the map. The link between the two fields is visually
represented with a line connecting the two fields.

Also, we recommend that you set up a Document Name for each map, to
make the identification of a document created by this map easier in
Gentran:Director. This allows you to differentiate between documents in the
document browsers in Gentran:Director.

To set up a Document Name, you must select an element or field in the map
that contains data that distinguishes the documents translated by this map.
Then, the Name field of the document browsers that contain this document
contains the data from the selected element or field.

We strongly recommend that you select an element or
field that occurs only once in the document and has a
data type of “String.” For an Invoice, the document
name is typically the Invoice Number.

Link the application field INVNUMBEG in the INVBEGIN record to the
BIG02 element in the BIG segment.

Setting up the document Then, complete the following steps to set up the Document Name for this

184

name

Invoice:

1. Double-click the BIG02 (0076) element to display the Field Properties
dialog.
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2. Select the Use Standard Rule check box in the Advanced section, to
display the rule options.

3. Click the Update option.
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4. From the Table/Key list, choose “Document record.” This indicates that
you are updating the document record in Gentran:Director.

5. From the Field list, choose “Document Name.” This indicates that you
are updating the Name field in the document browsers with the contents
of this element.

The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to set up the document name.

INVDATE You can map the INVDATE field directly to the BIGO1 (Invoice Date) field,
by using the Link function.

Link the application field INVDATE in the INVBEGIN record to the BIGO1
element in the BIG segment.

PONUM  You can map the PONUM field directly to the BIG04 (Purchase Order
Number) field, by using the Link function. The Link function allows you to
map a field or element from the Input side of the map to a field or element on
the Output side of the map. The link between the two fields is visually
represented with a line connecting the two fields.

Also, we recommend that you set up a Document Reference for each map, to
make the identification of a document created by this map easier in
Gentran:Director. This allows you to differentiate between documents in the
document browsers in Gentran:Director.

To set up a Document Reference, you must select an element or field in the
map that contains data that distinguishes the documents translated by this
map. If you set up the Reference in the Application Integration subsystem,
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the RefData field of the document browsers that contain this document in
Gentran:Director contains the data from that mapped field.

You can choose any element or field as the Document
Reference, but we strongly recommend that you select
an element or field that occurs only once in the
document and has a data type of “String.” For an
Invoice, the document reference is typically the
Purchase Order Number.

Mapping the purchase Link the application field PONUM in the INVBEGIN record to the BIG04
order number element in the BIG segment.

Setting up the document Then, complete the following steps to set up the Document Reference for
reference  this Invoice:

1. Double-click the BIG04 (0324) element to display the Field Properties

dialog.
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2. Select the Use Standard Rule check box in the Advanced section, to
display the rule options.

Click the Update option.

From the Table/Key list, choose “Document record.” This indicates that
you are updating the document record in Gentran:Director.

5. From the Field list, choose “Reference Data.” This indicates that you are
updating the RefData field in the document browsers with the contents
of this element.
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PODATE

VENDNAME

The Advanced section of the Field Properties dialog should now look
like this:
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6. Click OK to set up the document reference.

You can map the PODATE field directly to the BIGO3 (Purchase Order
Date) field, by using the Link function.

Link the application field PODATE in the INVBEGIN record to the BIG03
element in the BIG segment.

A loop is a group of two or more segments that repeat, in sequence, more
than once. The N1 group contains vendor, shipping, and billing name and
address information, and repeats multiple times. Your application file
contains Vendor, Ship To, and Remit To information that you need to map to
the N1 group. However, you can only map fields and elements that are at the
same level. This means that you cannot map from a non-repeating record to a
group. Specifically, you cannot map the vendor, shipping, and remittance
information in the INVBEGIN record directly to the N1 group, because the
INVBEGIN record does not repeat. Also, you cannot map to the N3 (address
information) repeating segment from your application file Ship To fields
(which are in the INVBEGIN record that does not repeat).

Therefore, to map vendor, shipping, and remittance information from your
application file format, you must create three single iterations of the N1
group, so that the links between the application fields in the INVBEGIN
record and the N1 groups are valid. The Split function extracts the specified
number of iterations (instances) of a group (or repeating segment). This
enables you to map unique data from your application file and enter a
specialized definition for each N1 group (N1_Vendor, N1_ShipTo, and
N1_RemitTo).
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Changing the max use of
the N3 segment

Splitting the N1 group
and adding a specialized
definition

You can then map a constant to the Entity Identifier Code (in the N1
segment) for each iteration of the N1 group. If the Entity Identifier Code is
“VN,” that iteration of the N1 group contains shipping information. You
need to map the Vendor name and address fields in your application file
format to the N1_Vendor group. If the Entity Identifier Code is “ST,” that
iteration of the N1 group contains shipping information. You need to map
the Ship To name and address fields in your application file format to the
N1_ShipTo group. If the Entity Identifier Code is “RI,” that iteration of the
N1 group contains remittance information. You need to map the remittance
name and address fields in your application file format to the N1_RemitTo
group.

You cannot map from your application file format Vendor, Ship To, and
Remit To fields (which are in the INVBEGIN record that does not repeat) to
the N3 (address information) repeating segment. Therefore, before you split
the N1 group, you need to change the maximum usage of the N3 segment
from “2” to “1” (to make the N3 a nonrepeating segment for each iteration of
the group).

Complete the following steps to make the N3 a nonrepeating segment:

1. Click the N3 segment (in the N1 group) with the right mouse button to
access the shortcut menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

3. Inthe Max Usage box, type “1” to make the N3 a nonrepeating segment.
This box is currently set to “2.”

4, Click OK to accept the change to the N3 segment.

You cannot map from a non-repeating record (INVBEGIN) to a group (N1).
Therefore, to map vendor, shipping, and remittance information from your
application file format, you must split three single iterations of the N1 group,
so that the links between the application fields in the INVBEGIN record and
the N1 groups are valid.

Complete the following steps to map to split three iterations of the N1 group
and add specialize definitions:

1. Highlight the N1 group.
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13.

14.
15.

Click the SPLIT button on the Main Toolbar. The Split dialog is
displayed.

S plit

First Loop Entries ID

Cancel |

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

Click OK to exit the Split dialog.

Select Properties from the Edit menu to access the Group Properties
dialog for the new group.
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In the Name box, type “N1_Vendor”, which is a specialized definition
to identify this group as containing vendor information.

Click OK to save the change and exit the Group Properties dialog.
Highlight the original N1 group (that now repeats 199 times) again.

Click the SPLIT button on the Main Toolbar to extract another single
instance of the N1. The Split dialog is displayed.

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

Click OK to exit the Split dialog.

Select Properties from the Edit menu to access the Group Properties
dialog for the new group.

In the Name box, type “N1_ShipTo”, which is a specialized definition
to identify this group as containing shipping information.

Click OK to save the change and exit the Group Properties dialog.
Highlight the original N1 group (that now repeats 198 times) again.

Gentran:Director Application Integration ANSI Tutorial Guide April 2005 189



Mapping Your Data

Outbound Invoice (810)

16.

17.

18.
19.

20.

21.
22.

23.

24.

Click the SPLIT button on the Main Toolbar to extract another single
instance of the N1. The Split dialog is displayed.

In the First Loop Entries box, type “1” to indicate the sequential number
of iterations where you want the group or repeating segment split.

Click OK to exit the Split dialog.

Select Properties from the Edit menu to access the Group Properties
dialog for the new group.

In the Name box, type “N1_RemitTo”, which is a specialized definition
to identify this group as containing remittance information.

Click OK to save the change and exit the Group Properties dialog.

Click the DEACTIVATE button on the Main Toolbar and then click the
original N1 group (that now repeats 197 times), so the system does not
process it.

Also click the REF:6 segment (in the N1_Vendor group) and the REF:8
segment (in the N1_RemitTo group), so the system does not process
them.

Click the DEACT IVATE button on the Main Toolbar again to turn
Deactivation mode off.

Setting the entity You need to set the Entity Identifier Code for the N1_Vendor, N1_ShipTo,
identifier code and N1_RemitTo groups, so the system is able to distinguish the type of
name and address information each N1 group should contain.

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to each Entity Identifier Code element.

Complete the following steps to set the Entity Identifier Code for the
N1_Vendor group:

1.

Double-click the N1:301 element (Entity Identifier Code) in the N1:3
segment to access the Field Properties dialog.

Field Properties
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2.
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Select the Use Standard Rule check box.
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3. Click the Constant option.

4. Click the second Constant option.
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5. From the Constants list, select the “VN” constant, to identify this
iteration of the N1 group as containing vendor name and address
information.

6. From the Qualifies list, select the “0093:5 NAME,” to set up a
qualifying relationship with the Name element.

The Qualifies list contains only the other active
elements in the same segment as the qualifying
element.

7. Click OK and the “VN” code is loaded in the Entity Identifier Code

element and the qualifying relationship between the N1:301 and N1:302
elements is established.
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Complete the following steps to set the Entity Identifier Code for the
N1_ShipTo group:

1.

Double-click the N1:401 element (Entity Identifier Code) in the N1:4
segment to access the Field Properties dialog.

Field Properties

Name fo0ss 0
Description IENTITY IDENTIFIER CODE Cancel
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Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

From the Constants list, select the “ST” constant, to identify this
iteration of the N1 group as containing shipping name and address
information.

From the Qualifies list, select the “0093:5 NAME,” to set up a
qualifying relationship with the Name element.

Click OK and the “ST” code is loaded in the Entity Identifier Code

element and the qualifying relationship between the N1:401 and N1:402

elements is established.

Complete the following steps to set the Entity Identifier Code for the
N1_RemitTo group:

1.

Double-click the N1:501 element (Entity Identifier Code) in the N1:5
segment to access the Field Properties dialog.

Field Properties
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Mapping the vendor
name

VENDADD1
VENDADD?2

VENDCITY

VENDSTATE

2. If the Advanced section of the dialog is not currently displayed, click
ADVANCED>> to access this section, which enables you to define rules.

Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

o Uk~ w

From the Constants list, select the “RI”” constant, to identify this
iteration of the N1 group as containing vendor name and address
information.

7. From the Qualifies list, select the “0093:5 NAME,” to set up a
qualifying relationship with the Name element.

8. Click OK and the “RI” code is loaded in the Entity Identifier Code
element and the qualifying relationship between the N1:501 and N1:502
elements is established.

Now you can link the elements in your Vendor application fields in the
single occurrence of the INVBEGIN record to the appropriate single
occurrence of the N1 that contains vending information (N1_Vendor).
You can link the elements in your Ship To application fields in the
single occurrence of the INVBEGIN record to the appropriate single
occurrence of the N1 that contains shipping information (N1_ShipTo).
And, you can link the elements in your RemitTo application fields in the
single occurrence of the INVBEGIN record to the appropriate single
occurrence of the N1 that contains remittance information
(N1_RemitTo).

To map the vendor name, click the application field VENDNAME in the
INVBEGIN record to the N1:302 element in the N1:3 segment (N1_Vendor

group).

Link the application field VENDADDL1 in the INVBEGIN record to the
N3:301 element in the N3:3 segment (N1_Vendor group).

Link the application field VENDADD?2 in the INVBEGIN record to the
N3:302 element in the N3:3 segment (N1_Vendor group).

Link the application field VENDCITY in the INVBEGIN record to the
N4:301 element in the N4:3 segment (N1_Vendor group).

Link the application field VENDSTATE in the INVBEGIN record to the
N4:302 element in the N4:3 segment (N1_Vendor group).
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VENDPOSTALCODE

SHIPTONAME

SHIPTOADD1

SHIPTOADD2

SHIPTOCITY

SHIPTOSTATE

SHIPTOPOSTALCODE

SHIPTOLOC
SHIPTODEPTNUM

Link the application field VENDPOSTALCODE in the INVBEGIN record.
to the N4:303 element in the N4:3 segment (N1_Vendor group).

Link the application field SHIPTONAME in the INVBEGIN record to the
N1:402 element in the N1:4 segment (N1_ShipTo group).

Link the application field SHIPTOADDL1 in the INVBEGIN record to the
N3:401 element in the N3:4 segment (N1_ShipTo group).

Link the application field SHIPTOADD?2 in the INVBEGIN record to the
N3:402 element in the N3:4 segment (N1_ShipTo group).

Link the application field SHIPTOCITY in the INVBEGIN record to the
N4:401 element in the N4:4 segment (N1_ShipTo group).

Link the application field SHIPTOSTATE in the INVBEGIN record to the
N4:402 element in the N4:4 segment (N1_ShipTo group).

Link the application field SHIPTOPOSTALCODE in the INVBEGIN record
to the N4:403 element in the N4:4 segment (N1_ShipTo group).

The SHIPTOLOC (ship to location) and the SHIPTODEPTNUM (ship to
department number) fields both contain additional reference information
about the Ship To address. Both fields are in the INVBEGIN record that
occurs once. To map both these fields to the REF:7 (reference) segment in
the N1_ShipTo group, which repeats twelve times, you must promote a
single instance of the REF segment, so that two target fields exists to which
you can map the SHIPTOLOC and SHIPTODEPTNUM. And, because the
original REF segment (REF:7) still repeats eleven times, you must change
the maximum usage to one. Therefore, a link between the INVHEADER and
the original REF segment (REF:7) is valid.

You must also map a constant to the Reference Number Qualifier (REF01
element) and define a qualifying relationship with the Reference Number
(REFO02 element), for both instances of the REF segment (REF:9 and
REF:7). If the Reference Number Qualifier is “DP” (department number),
that iteration of the REF segment contains the ship to department number. If
the Reference Number Qualifier is “ST” (store number), that iteration of the
REF segment contains the ship to location.
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Promoting the REF
segment

Changing the max use of
the REF:7 segment

Setting the reference
number qualifier

To map both the SHIPTOLOC and SHIPTODEPTNUM fields to the REF
(reference) segment in the N1_ShipTo group, which repeats twelve times,
you must promote a single instance of the REF segment, so that two target
fields exists to which you can map the SHIPTOLOC and
SHIPTODEPTNUM.

Complete the following steps to map to promote a single instance of the REF
segment:

1. Highlight the REF:7 segment in the N1_ShipTo group.

2. Click the PROMOTE button on the Main Toolbar to extract a single
instance of the REF segment.

The REF:9 segment that only occurs once is extracted.

The original REF segment (REF:7) still repeats eleven times, so you need to
change the maximum usage to one. Therefore, a link between the
INVHEADER and the original REF segment (REF:7) is valid.

Complete the following steps to make the REF:7 a nonrepeating segment:

1. Click the REF:7 segment (in the N1_ShipTo group) with the right
mouse button to access the shortcut menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

3. Inthe Max Usage box, type “1” to make the REF:7 a nonrepeating
segment. This box is currently set to “11.”

4. Click OK to accept the change to the REF:7 segment.

You must map a constant to the Reference Number Qualifier (REF01
element) and define a qualifying relationship with the Reference Number
(REF02 element), for both instances of the REF segment (REF:9 and
REF:7).

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to each Reference Number Qualifier
element.
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Complete the following steps to set the Reference Number Qualifier for the
REF:9 segment:

1.

Double-click the REF:901 element (Reference Number Qualifier) in the
REF:9 segment in the N1_ShipTo group, to access the Field Properties
dialog.
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2. Select the Use Standard Rule check box.

3. Click the Constant option.

4. Click the second Constant option.

5. From the Constants list, select the “DP” constant, to identify this
iteration of the REF segment as containing the ship to department
number.

6. From the Qualifies list, select the “0127:2 REFERENCE NUMBER,” to
set up a qualifying relationship with the Reference Number element.

7. Click OK and the “DP” code is loaded in the Reference Number

April 2005

Qualifier element and the qualifying relationship between the REF:901
and REF:902 elements is established.
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Complete the following steps to set the Reference Number Qualifier for the
REF:7 segment:

1.

Double-click the REF:701 element (Reference Number Qualifier) in the
REF:7 segment in the N1_ShipTo group, to access the Field Properties
dialog.
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Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

From the Constants list, select the “SN” constant, to identify this
iteration of the REF segment as containing the store number.

From the Qualifies list, select the “0127 REFERENCE NUMBER,” to
set up a qualifying relationship with the Reference Number element.

Click OK and the “SN” code is loaded in the Reference Number
Qualifier element and the qualifying relationship between the REF:701
and REF:702 elements is established.

Mapping the shipping After promoting the REF segment, changing the maximum usage, mapping

reference information  constants to the Reference Number Qualifier elements, and establishing the
appropriate qualifying relationship, you can map the SHIPTOLOC and
SHIPTODEPTNUM fields.

Complete the following steps to map the SHIPTOLOC and
SHIPTODEPTNUM fields:

=] L

Link the application field SHIPTOLOC in the INVBEGIN record to the
REF7:02 element in the REF:7 segment (N1_ShipTo group).

Link the application field SHIPTODEPTNUM in the INVBEGIN
record to the REF9:02 element in the REF:9 segment (N1_ShipTo

group).
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REMITTONAME

REMITTOADD1

REMITTOADD?2

REMITTOCITY

REMITTOSTATE

REMITTOPOSTAL

CODE

BOLNUM

Changing the max use of
the REF segment

Link the application field REMITTONAME in the INVBEGIN record to the
N1:502 element in the N1:5 segment (N1_RemitTo group).

Link the application field REMITTOADDL in the INVBEGIN record to the
N3:501 element in the N3:5 segment (N1_RemitTo group).

Link the application field REMITTOADD?2 in the INVBEGIN record to the
N3:502 element in the N3:5 segment (N1_RemitTo group).

Link the application field REMITTOCITY in the INVBEGIN record to the
N4:501 element in the N4:5 segment (N1_RemitTo group).

Link the application field REMITTOSTATE in the INVBEGIN record to the
N4:502 element in the N4:5 segment (N1_RemitTo group).

Link the application field REMITTOPOSTALCODE in the INVBEGIN
record to the N4:503 element in the N4:5 segment (N1_RemitTo group).

You know that you only send one header REF segment to your trading
partner (typically the REF segment repeats up to 12 times). Therefore, after
you change the max usage of the REF segment to “1,” the BOLNUM (bill of
lading number) field can be directly mapped to the REF02 element.
However, you must map a constant to the Reference Number Qualifier
(REFO1 element) and define a qualifying relationship with the Reference
Number (REF02 element) to indicate that the REF02 contains the bill of
lading number.

You have determined that you only send your partner one header REF
segment (reference information), so you must change the maximum usage
allowed for that segment from “12” to “1.”

Complete the following steps to make the REF a nonrepeating segment:

1. Click the REF segment (in the header) with the right mouse button to
access the shortcut menu.

1. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

2. Inthe Max Usage box, type “1” to make the REF a nonrepeating
segment. This box is currently set to “12.”

3. Click OK to accept the change to the REF segment.
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Setting the reference  You already defined all the constants that you are using in this map, so now
number qualifier you can map the appropriate constant to the Reference Number Qualifier
element.

Complete the following steps to set the Reference Number Qualifier for the
REF segment:

1. Double-click the REF:01 element (Reference Number Qualifier) in the
REF segment, to access the Field Properties dialog.
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2. Select the Use Standard Rule check box.
3. Click the Constant option.
4. Click the second Constant option.
5. From the Constants list, select the “BM” constant, to identify this

iteration of the REF segment as containing the bill of lading number.

6. From the Qualifies list, select the “0127 REFERENCE NUMBER,” to
set up a qualifying relationship with the Reference Number element.

7. Click OK and the “BM” code is loaded in the Reference Number
Qualifier element and the qualifying relationship between the REF01
and REF02 elements is established.

Mapping the bill of lading  After mapping the constant to the Reference Number Qualifier element and
number establishing the appropriate qualifying relationship, you can map the
BOLNUM field.

Link the application field BOLNUM in the INVBEGIN record to the REF02
element in the REF segment.
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SHIPDATE

Changing the max use of

200

the DTM segment

Setting the ship date
qualifier

You know that you only send one header DTM segment to your trading
partner (typically the DTM segment repeats up to 10 times). Therefore, after
you change the max usage of the DTM segment to “1,” the SHIPDATE field
can be directly mapped to the DTMO2 element (in the DTM header
segment). However, you must map a constant to the Date/Time Qualifier
(DTMO1 element) and define a qualifying relationship with the Date
(DTMO2 element) to indicate that the DTMO02 contains the ship date.

You have determined that you only send your partner one header DTM
segment (date/time information), so you must change the maximum usage
allowed for that segment from “10” to “1.”

Complete the following steps to make the DTM a nonrepeating segment:

1. Click the DTM segment (in the header) with the right mouse button to
access the shortcut menu.

1. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

2. Inthe Max Usage box, type “1” to make the DTM a nonrepeating
segment. This box is currently set to “10.”

3. Click OK to accept the change to the DTM segment.

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to the Date/Time Qualifier element.

Complete the following steps to set the Date/Time Qualifier for the DTM
segment:

1. Double-click the DTM:01 element (Date/Time Qualifier) in the DTM
segment, to access the Field Properties dialog.
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2. Select the Use Standard Rule check box.
3. Click the Constant option.

April 2005 Gentran:Director Application Integration ANSI Tutorial Guide



Outbound Invoice (810)

Mapping Your Data

Mapping the ship date

TERMS_WHOLE

Changing the max use of
the ITD segment

Mapping the ship date

4. Click the second Constant option.

From the Constants list, select the “DTM?” constant, to identify this
iteration of the DTM segment as containing the bill of lading number.

6. From the Qualifies list, select the “0373:6 DATE,” to set up a qualifying
relationship with the Date element.

7. Click OK and the “DTM” code is loaded in the Date/Time Qualifier
element and the qualifying relationship between the DTMO01 and
DTMO02 elements is established.

After mapping the constant to the Date/Time Qualifier element and
establishing the appropriate qualifying relationship, you can map the
SHIPDATE field.

Link the application field SHIPDATE in the INVBEGIN record to the
DTMO02 element in the DTM segment.

You know that you only send one header ITD segment to your trading
partner (typically the ITD segment repeats up to 5 times). Therefore, after
you change the max usage of the ITD segment to “1,” the TERMS_WHOLE
field can be directly mapped to the ITDO03 element (in the ITD header
segment).

You have determined that you only send your partner one header ITD
segment (terms of sale/deferred terms of sale), so you must change the
maximum usage allowed for that segment from “5” to “1.”

Complete the following steps to make the ITD a nonrepeating segment:

1. Click the ITD segment (in the header) with the right mouse button to
access the shortcut menu.

1. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

2. Inthe Max Usage field, type “1” to make the ITD a nonrepeating
segment. This field is currently set to “5.”

3. Click OK to accept the change to the ITD segment.

Link the application field TERMS_WHOLE in the INVBEGIN record to the
ITDO3 element in the ITD segment (in the header).
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TERMSNETDUE

TERMSDISDUE

INVComment
Group

INVCOMMENT1
Record

BILLTOACCTCM1

DOCTYPCM1

INVNUMCM1

REFNUM

Link the application field TERMSNETDUE in the INVBEGIN record to the
ITDO7 element in the ITD segment.

Link the application field TERMSDISDUE in the INVBEGIN record to the
ITDOS element in the ITD segment.

The INVCommentGroup (comment information) groups all the comment
information for the invoice, including the reference number and the message
text. The INVCommentGroup occurs once per invoice translated. The
information within the INVCommentGroup is further segregated by record.

This section describes the actions necessary for you to map from each field
in the INVCOMMENT1 (first comment) record. The INVCOMMENT1
record contains the reference number. The first comment record is
mandatory and occurs once per invoice translated (once for each comment
line).

The BILLTOACCTCML field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The DOCTYPCML1 field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The INVNUMCML1 field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The REFNUM field can be directly mapped to the N902 element (in the N9
segment in the N9 group). However, you must map a constant to the
Reference Number Qualifier (N901 element) and define a qualifying
relationship with the Reference Number (N902 element) to indicate that the
N902 contains the reference number.

202 April 2005 Gentran:Director Application Integration ANSI Tutorial Guide



Outbound Invoice (810) Mapping Your Data

Setting the reference  You already defined all the constants that you are using in this map, so now
number qualifier you can map the appropriate constant to the Reference Number Qualifier
element.

Complete the following steps to set the Reference Number Qualifier for the
N9 segment:

1. Double-click the N901 element (Reference Number Qualifier) in the N9
segment (N9 group), to access the Field Properties dialog.
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Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.
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From the Constants list, select the “1V” constant, to identify this
iteration of the REF segment as containing the reference number
(related vendor order number). This number is in addition to the primary
order number.

6. From the Qualifies list, select the “0127 REFERENCE NUMBER,” to
set up a qualifying relationship with the Reference Number element.

7. Click OK and the “1V” code is loaded in the Reference Number
Qualifier element and the qualifying relationship between the N901 and
N902 elements is established.

Mapping the reference  After mapping the constant to the Reference Number Qualifier element and
number  establishing the appropriate qualifying relationship, you can map the
REFNUM field.

Link the application field REFNUM in the INVCOMMENT1 record to the
N902 element in the REF segment.
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INVCOMMENT?2
Record

BILLTOACCTCMZ2

DOCTYPCM2

INVNUMCM2

MESSAGETEXT

INVDETAIL
Record

BILLTOACCTDET

DOCTYPDET

This section describes the actions necessary for you to map from each field
in the INVCOMMENT?2 (first comment) record. The INVCOMMENT?2
record contains message text. The second comment record is mandatory and
occurs up to ten times per invoice translated (once for each comment line).

The BILLTOACCTCMZ2 field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The DOCTYPCM2 field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The INVNUMCM2 field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

Link the application field MESSAGETEXT in the INVCOMMENT2 record
to the MSGO1 element in the MSG segment (N9 group).

This section describes the actions necessary for you to map from each field
in the INVDETAIL (detail) record. The INVCOMMENT2 record contains
line item number and description, quantity shipped, quantity ordered, unit of
measure, price, product code, and invoice terms. The detail record is
mandatory and occurs up to 200,000 times per invoice translated (once for
each line item invoiced).

The BILLTOACCTDET field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The DOCTYPDET field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.
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INVNUMDET

ITEMNUM

Calculating the number
of line items

The INVNUMDET field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The ITEMNUM field can be directly mapped to the IT101 Assigned
Identification element in the IT1 segment (IT1 group). However, you also
need to calculate an incremental count of the number of line items, and you
want to use that total value in the Number of Line Items Total field.

Complete the following steps to count line items and generate a control total:

1. Double-click the IT101 element (in the IT1 segment in the IT1 group).
This is the field that you typically use to count the line items. The Field
Properties dialog is displayed.
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2. Select the Use Standard Rule check box to display the rule options.
3. Click the Use Accum option.
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4. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. From the Primary Accumulator list, select “0.” Before any calculations
are performed on an accumulator, its content is “0” (zero). When you
use an accumulator, the system adds a new accumulator to the bottom of
this list.

There is only one set of accumulators for each map.
This means that accumulator “0,” whether it is used in
the Primary Accumulator or Alternate Accum box is
the same accumulator with the same contents. If you
assign calculations to accumulator “0” at the beginning
of the map and then use accumulator “0” again later in
the map, the content of that accumulator is the result
of the earlier calculation. Any additional calculations
you assign to that accumulator are performed on the
contents resulting from an earlier calculation.

6. Inthe Name box, type “Line Item Number”. This is a descriptive alias
that enables you to differentiate what the accumulators you create are
used for.

7. From the First list, select “Increment primary.” This is the first
operation that the system performs. This specifies that the system
increments the value in this accumulator by one for each iteration of the
IT1 group.

The First box is active only after you select a Primary
Accumulator.
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8.

10.

Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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Click OK on the Field Properties dialog to add the standard rule to the
IT101 element.

Double-click the CTTO1 element (in the CTT segment). This is the field
that typically contains the total number of line items. The Field
Properties dialog is displayed.
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11.
12.
13.

14.

Select the Use Standard Rule check box to display the rule options.
Click the Use Accum option.

Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

From the Primary Accumulator list, select primary accumulator “0.”
This accumulator currently contains the total number of line items.
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15. From the First list, select “Use primary.” This specifies that the system
loads the current value of the accumulator into the CTT01 (Number of
Line Items Total) element.

The Edit Accumulator Entry dialog should now look like this.
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16. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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17. Click OK on the Field Properties dialog to add the standard rule to the
CTTO1 element.

The CTTO1 element now contains the total number of line items in the
invoice.
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Mapping the item
number

QTYSHIP

Calculating the number
of line items

After using an accumulator to calculate the incremental count of the number
of line items, you can map the ITEMNUM field directly to the 1T101
element.

Link the application field ITEMNUM in the INVDETAIL record to the
IT101 element in the IT1 segment (IT1 group).

The QTYSHIP field can be directly mapped to the IT102 Quantity Invoiced
element in the IT1 segment (IT1 group). However, you also need to count
the quantity invoiced for each line item and load the total quantity in the
CTTO02 (Hash Total) field.

Complete the following steps to count the quantity invoiced and generate a
hash total:

1. Double-click the IT102 element (in the IT1 segment in the IT1 group).
This is the field that you typically use to count the line items. The Field
Properties dialog is displayed.

Neme B
Descrobion — [quanTITY IMvOICED
alaWalidation
Mn  HMaz  Tpp= Frermat —
F Handaloy |1 |1|:| [Humbe: [2] [F= 2] Cordilioes. .

2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

4. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

5. From the Primary Accumulator list, select “1.” Before any calculations
are performed on an accumulator, its content is “0” (zero). When you
use an accumulator, the system adds a new accumulator to the bottom of
this list.

6. Inthe Name box, type “Total Quantity”. This is a descriptive alias that
enables you to differentiate what the accumulators you create are used
for.
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7. From the First list, select “Sum in primary.” This is the first operation
that the system performs. This specifies that the system adds the
numeric value (takes the positive or negative sign of the numbers into
account) of the field to the contents of the Primary Accumulator for
each iteration of the PO1 group.

The Edit Accumulator Entry dialog should now look like this:
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8. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:
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9. Click OK on the Field Properties dialog to add the standard rule to the
IT102 element.
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10. Double-click the CTTO02 element (in the CTT segment). This is the field
that typically contains the total quantity of the purchase order. The Field
Properties dialog is displayed.
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11. In the Advanced section, select the Use Standard Rule check box to
display the rule options.

12. Click the Use Accum option.

13. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

14. From the Primary Accumulator list, select primary accumulator “1.”
This accumulator currently contains the total quantity.

15. From the First list, select “Use primary.” This specifies that the system
loads the current value of the accumulator into the CTTO02 (Hash Total)

element.

The Edit Accumulator Entry dialog should now look like this:
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16. Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:
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17. Click OK on the Field Properties dialog to add the standard rule to the
CTTO2 element.

The CTTO02 element now contains the total quantity of the purchase
order.

Mapping the quantity ~After mapping the using an accumulator to calculate the quantity invoiced

shipped

QTYORD

for each line item and generate a hash total, you can map the QTYSHIP field
directly to the IT102 element.

Link the application field QTYSHIP in the INVDETAIL record to the 1T102
element in the IT1 segment (IT1 group).

You know that you only send one QTY segment (in the IT1 group) to your
trading partner (typically the QTY segment repeats up to 5 times).
Therefore, after you change the max usage of the QTY segment to “1,” the
QTYORD (quantity ordered) field can be directly mapped to the QTY02
element. However, you must map a constant to the Quantity Qualifier
(QTYO01 element) and define a qualifying relationship with the Quantity
(QTYO02 element) to indicate that the QTY02 contains the quantity ordered.
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Changing the max use of
the QTY segment

Setting the quantity
qualifier

You have determined that you only send your partner one QTY segment
(quantity), so you must change the maximum usage allowed for that segment
from “5” to “1.”

Complete the following steps to make the QTY a nonrepeating segment:

1. Click the QTY segment (in the IT1 group) with the right mouse button
to access the shortcut menu.

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

3. Inthe Max Usage box, type “1” to make the QTY a nonrepeating
segment. This box is currently set to “5.”

4, Click OK to accept the change to the QTY segment.

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to the Quantity Qualifier element.

Complete the following steps to set the Quantity Qualifier for the REF
segment:

1. Double-click the QTYO01 element (Quantity Qualifier) in the QTY
segment (IT1 group), to access the Field Properties dialog.

Fizld Fropeities E

Newe o673
Desoribion  [QUANTITY QUALIRER
ala Valdation Bdvancad =a
M Max  Tppe Format —
F Handalon |2 |2 |5tri'!.'| |£I IH Cordiliors..

Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

o M DN

From the Constants list, select the “OR” constant, to identify the
Quantity segment as containing the quantity ordered.

6. From the Qualifies list, select the “0380 QUANTITY,” to set up a
qualifying relationship with the Quantity element.

7. Click OK and the “OR” code is loaded in the Quantity Qualifier element
and the qualifying relationship between the QTYO01 and QTY02
elements is established.
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Mapping the quantity
ordered

UNITPRICE

Calculating the value
total

After mapping the constant to the Quantity Qualifier element and
establishing the appropriate qualifying relationship, you can map the
QTYORD field.

Link the application field QTYORD in the INVDETAIL record to the
QTYO02 element in the QTY segment (IT1 group).

The UNITPRICE field can be directly mapped to the 1T104 Unit Price
element in the IT1 segment (IT1 group). However, you also need to multiply
the quantity invoiced for each line item by the unit price to obtain the
extended price. You also need to generate a running total of the extended
price and load the final total in the TDSO01 (Total Invoice Amount) element.

Complete the following steps to multiply the quantity invoiced for each line
item by the unit price to obtain the extended price:

1. Double-click the IT102 element (in the IT1 segment in the IT1 group).
This is the field that you typically use to count the quantity invoiced.
The Field Properties dialog is displayed.

e [53
['e=rinfion |uuqm|w IMVTIICED
ala ' aidation
Mn Haz  Tpp= Format —
F Handalory |1 |'||:| INumI:ll:l |£I IFIEI m Cotudilices. .

2. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

3. From the Primary Accumulator list, select “2.” This number is a name
by which the accumulator is referred. Before any calculations are
performed on an accumulator, its content is “0” (zero). When you use an
accumulator, the system adds a new accumulator to the bottom of this
list.

4. Inthe Name box, type “Extended Price”. This is a descriptive alias that
enables you to differentiate what the accumulators you create are used
for.

5. From the First list, select “Load primary.” This is the first operation that
the system performs. This specifies that the system loads the contents of
the element into the Primary Accumulator for each iteration of the IT1
group.
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The Edit Accumulator Entry dialog should now look like this:

bdit Aecumulatar Entry E
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6. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:

Advancad
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1 Bakeat (1 Updste 1 Conclanl W Usa decumn O Loop Cowrt O U e Code

Primange Bocumulshon Op1 Op2 Op3 Op4
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Haw...

Charge...

Dakte

7. Click OK on the Field Properties dialog to add the standard rule to the
IT102 element.
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8.

Double-click the 1T104 element (in the IT1 segment in the IT1 group).
This is the field that contains the unit price for each line item. The Field
Properties dialog is displayed.

| 1zld 'vopoatizs
Nerne [cere
D e=rption IUNIT FRICE
ala W alidation
Mn  HMax  Tpp= Format —
F HMandalon |1 I'H IHumI:u:l |£I IFIEI |ﬂ Cordilint...

10.
11.

12.
13.

In the Advanced section, select the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.

From the list, select primary accumulator “2.”

From the First list, select “Multiply with primary.” This is the first
operation that the system performs. This specifies that the system
multiplies the value of the 1T104 (Unit Price) element with the contents
of the primary accumulator, and stores the result in the primary
accumulator for each iteration of the 1T1 group.

The Edit Accumulator Entry dialog should now look like this:

Ldit Accumulatar Lnkry

Primary Accuruiater |2 [#] Mama [Estanded Frice | i |
peralices ™ Corcel |
Firzl |h'||_l|i|:l_|,| with prirans |£| Allemate r.‘ur:r:m'ul |E|

Second | (2]

Thid | [z]

Foulh | [£]

14. Click OK to add the accumulator.
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like this:
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The Advanced section of the Field Properties dialog should now look

15. Click OK on the Field Properties dialog to add the standard rule to the

IT104 element.

Q If there is an extended price element in your EDI file,

you could load the total from the extended price
calculation into that element. To do this, you need to
use an accumulator on that extended price element

that specifies “Use primary” for accumulator 2.

Generating a running  Complete the following steps to generate a running total of the extended

total price:

1. Double-click the 1T104 element (in the IT1 segment in the IT1 group).
This is the field that contains the unit price for each line item. The Field

Properties dialog is displayed.

| izl 'opoitizs
[
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Click NEW... to access the Edit Accumulator Entry dialog to create
another calculation for this element.

From the Primary Accumulator list, select primary accumulator “3.”
In the Name box, type “Running Total”.

From the First list, select “Add primary to alternate.” This specifies that
the system adds the contents of the primary accumulator to the contents
of the alternate accumulator, and stores the result in the primary
accumulator for each iteration of the IT1 group.

From the Alternate Accum list, select “2.” This operation specifies that
the system add the value of accumulator “2” (which contains the
extended price for a line item) to the value of accumulator “3.” The
system stores the sum in accumulator “3,” which therefore contains a
running total of the extended price with each iteration of the IT1 group.

The Edit Accumulator Entry dialog should now look like this:

I-_dlt Acoumulatar Entry E
Priran Accurulshon |3 H Harra IFhrﬂirg Tatsd I i I
O peralioes Cancdl I

Click OK to add the accumulator.
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The Advanced section of the Field Properties dialog should now look
like this:

Advanzad

[ Use Standerd Auls
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8. Click OK on the Field Properties dialog to add the standard rule to the
IT104 element.

Loading the running total Complete the following steps to load the running total of the extended price
into the TDSO1 (Total Invoice Amount) element:

1. Double-click the TDSO01 element (in the TDS segment). This is the field
that contains the unit price for each line item. The Field Properties
dialog is displayed.

Fizld Fropoiticz
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2. Inthe Advanced section, select the Use Standard Rule check box to
display the rule options.

Click the Use Accum option.

4. Click NEW... to access the Edit Accumulator Entry dialog to create a
new calculation for this element.
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5. From the list, select primary accumulator “3.”

6. From the First list, select “Use primary.” This specifies that the system
loads the contents of the primary accumulator into the TDS01 (Total
Invoice Amount) element.

The Edit Accumulator Entry dialog should now look like this:

Edit Aecumulatar Entry Ed
Prirnany Accurukehon |3 |:I Harra IHLI"ﬂiI'g Tatdl l i I
0 peralicee Cancel I

Firel IU&E primaly EI Lllemate dccum I |i|
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7. Click OK to add the accumulator.

The Advanced section of the Field Properties dialog should now look
like this:

Adwanced
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8. Click OK on the Field Properties dialog to add the standard rule to the
TDSO01 element.
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Mapping the unit price  After using accumulators to multiply the quantity invoiced for each line item
by the unit price to obtain the extended price and generate a running total of
the extended price, you can map the UNITPRICE field directly to the 1T104
element.

Link the application field UNITPRICE in the INVDETAIL record to the
IT104 element in the IT1 segment (IT1 group).

UOM  Link the application field UOM in the INVDETAIL record to the 1T103
element in the 1T1 segment (IT1 group).

CUSTPROCODE You can map the CUSTPROCODE (customer product code) and
UPCCODE UPCCODE (your UPC code) fields directly to two Product/Service ID
elements IT1 segment. However, you must map a constant to each Product/
Service ID Qualifier and establish a qualifying relationship with the Product
Service ID. This enables you to specify which Product/Service ID element
contains your partner’s product code, and which contains your UPC code.

Setting the product/ You must map a constant to the Product/Service ID Qualifier (IT106 and
service ID qualifier 1T108 elements) and define a qualifying relationship with the Product/
Service ID (IT107 and IT109 elements).

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to each Product/Service ID Qualifier
element.

Complete the following steps to set the Product/Service ID Qualifiers for the
IT1 segment:

1. Double-click the IT106 element (Product/Service ID Qualifier) in the
IT1 segment in the IT1 group, to access the Field Properties dialog.

| izld | 'voprabics
Nerme EEE
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2. Select the Use Standard Rule check box.
3. Click the Constant option.
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Click the second Constant option.

From the Constants list, select the “BP” constant (buyer’s part number),
to identify the 1T107 element as containing the customer product code.

From the Qualifies list, select the “0234 PRODUCT/SERVICE ID,” to
set up a qualifying relationship with the Product/Service ID element.

Click OK and the “BP” code is loaded in the Product/Service 1D
Qualifier element and the qualifying relationship between the IT106 and
IT107 elements is established.

Double-click the 1T108 element (Product/Service ID Qualifier) in the
IT1 segment in the IT1 group, to access the Field Properties dialog.

| 1zl 'opoitics

M e

[ e=rphion

||::235

|PRODUCT/SERVICE ID GUALIFIER

ala Waldation

T Handalory Iz Ig [srre [2] [ Cowdilices. .

M Max  Tpp= Format

10.
11.
12.

13.

14.
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Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

From the Constants list, select the “Ul” constant (UPC identification), to
identify the IT109 element as containing the UPC code.

From the Qualifies list, select the “0234:2 PRODUCT/SERVICE ID,”
to set up a qualifying relationship with the Product/Service ID element.

Click OK and the “UlI” code is loaded in the Product/Service 1D
Qualifier element and the qualifying relationship between the IT108 and
IT109 elements is established.
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Mapping the product ~After establishing the appropriate qualifying relationships, you can map the
code information  CUSTPROCODE and UPCCODE fields.

Complete the following steps to map the product code information:

1. Link the application field CUSTPROCODE in the INVDETAIL record
to the IT107 element in the IT1 segment (IT1 group).

2. Link the application field UPCCODE in the INVDETAIL record to the
IT109 element in the IT1 segment (IT1 group).

ITEMDESC You know that you only send one PID:2 segment (in the PID subgroup in the
IT1 group) to your trading partner (typically the PID subgroup repeats up to
1,000 times). Therefore, after you change the max usage of the PID
subgroup to “1,” the ITEMDESC (item description) field can be directly
mapped to the PID:205 element. However, you must map a constant to the
Item Description Type (PID:201 element) and define a qualifying
relationship with the Description (PID2:05 element) to indicate that the
PID2:05 contains a free-form item description.

Changing the max use of You have determined that you only send your partner one PID:2 segment (in
the PID subgroup  the PID subgroup in the IT1 group), so you must change the maximum usage
allowed for that subgroup from 1,000 to “1.”

Complete the following steps to change the maximum usage of the PID
subgroup:

1. Click the PID subgroup (in the IT1 group) with the right mouse button
to access the shortcut menu.

2. Select Properties... from the shortcut menu to access the Group
Properties dialog.

3. Inthe Maximum Usage box, type “1” to make the PID subgroup a
nonrepeating group. This box is currently set to “1,000.”

4, Click OK to accept the change to the PID subgroup.

Setting the item You must map a constant to the Item Description Type (PID:201 element)
description type and define a qualifying relationship with the Description (P1D:205 element).

You already defined all the constants that you are using in this map, so now
you can map the appropriate constant to Item Description Type element.

Complete the following steps to set the Item Description Type (in the PI1D:2
segment in the PID subgroup in the 1T1 group):

1. Double-click the PID:201 element (Item Description Type) in the PID:2
segment in the PID subgroup in the IT1 group.
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The Field Properties dialog is displayed.
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Mapping the item
description

TERMSTYPE

Changing the max use of
the ITD:2 segment

Select the Use Standard Rule check box.
Click the Constant option.
Click the second Constant option.

a &~ D

From the Constants list, select the “F” constant (free-form), to identify
the PID:201 element as containing the free-form item description.

6. From the Qualifies list, select the “0352 DESCRIPTION,” to set up a
qualifying relationship with the Description element.

7. Click OK and the “F” code is loaded in the Item Description Type
element and the qualifying relationship between the PID2:01 and
P1D:205 elements is established.

Link the application field ITEMDESC in the INVDETAIL record to the
PID:205 element in the PID:2 segment (PID subgroup, IT1 group).

You know that you only send one ITD:2 segment (in the IT1 group) to your
trading partner (typically the ITD:2 segment repeats up to 2 times).
Therefore, after you change the max usage of the ITD:2 segment to “1,” the
TERMSTYPE (terms type code) field can be directly mapped to the
ITD:201 element.

You have determined that you only send your partner one ITD:2 segment
(quantity), so you must change the maximum usage allowed for that segment
from “2” to “1.”

Complete the following steps to make the ITD:2 a nonrepeating segment:

1. Click the ITD:2 segment (in the IT1 group) with the right mouse button
to access the shortcut menu.
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Mapping the terms type
code

TERMSDISP

INVSUMMARY
Record

BILLTOACCTSUM

DOCTYPSUM

INVNUMSUM

TOTALAMOUNT

2. Select Properties... from the shortcut menu to access the EDI Segment
Properties dialog.

3. Inthe Max Usage field, type “1” to make the ITD:2 a nonrepeating
segment. This field is currently set to “2.”

4, Click OK to accept the change to the ITD:2 segment.

Link the application field TERMSTYPE in the INVDETAIL record to the
ITD:201 element in the ITD:2 segment (IT1 group).

Link the application field TERMSDISP in the INVDETAIL record to the
ITD:203 element in the ITD:2 segment (IT1 group).

This section describes the actions necessary for you to map from each field
in the INVSUMMARY (summary) record. The INVSUMMARY record
contains the total invoice amount and the total transaction amount. The
summary record is mandatory and occurs once per invoice translated.

The BILLTOACCTSUM field is part of the application file format key, but
does not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The DOCTYPSUM field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

The INVNUMSUM field is part of the application file format key, but does
not contain data that the system needs to use to generate the invoice.
Therefore, you do not perform any mapping operations on this field.

For the system to create output segments, there must be at least one explicit
link to an element in that segment, and data to support that link. Therefore,
even though you are mapping the total amount with accumulators, you must
add an explicit link with an application field that contains data.

Link the application field TOTALAMOUNT in the INVSUMMARY record
to the TDSO1 element in the TDS segment.
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TRANSTOTAL For the system to create output segments, there must be at least one explicit
link to an element in that segment, and data to support that link. Therefore,
even though you are mapping the transaction total with accumulators, you
must add an explicit link with an application field that contains data.

Link the application field TRANSTOTAL in the INVSUMMARY record to
the CTTO1 element in the CTT segment.
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Finalizing the Map

After you create the import map, define your application file format, and
perform the appropriate mapping operations, you need to finalize the map.
To complete the mapping process, you need to save the map, compile the
translation object, print and review the Gentran:Director report, and test the
map.

Compiling the
Map The Compile function compiles the map and generates a translation object.
The map that you created using the Application Integration subsystem
(PET_810.MAP) is a source map. When that source map is compiled, the
result is a compiled translation object.

After you save the translation object, you must register it with
Gentran:Director before you can use it.

Complete the following steps to compile a map and generate a translation
object:

1. Select Save from the File menu to save the source map, prior to using
the Compile function.

2. Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

Run-Time Translation Object Mame EE3

Save jn: IanaﬁSUbi j gl E:

File pame:  [PET_810.TPL

Save as hupe; ITransIatinn Objects [* TPL] j Cancel |

3. The File name box already contains “PET_810.TPL.” This is the name
of the translation object, using the default . TPL file extension and our
recommendation that you name the translation object the same file name
(1-8 characters long) as you named the map. Preserving the same file
name (with different file extensions) makes the relationship between the
source map and the compiled translation object more evident.
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Do not to overlay the source map with the compiled
translation object. Use the .TPL file extension to
distinguish the translation object.

&

Change the Drive and Folder where the compiled translation object is
stored, if necessary.

Do not store the compiled translation object in the
GENTRAN Director\RegTransObj subfolder. This
subfolder is reserved for storing a copy of each
translation object you register with Gentran:Director.

o

Click SAVE and the system compiles the map and generates a
translation object. The Compile Error dialog is displayed. Verify that no
errors occurred and click OK to exit the dialog. The date on which the
translation object was compiled is automatically loaded into the
Compiled on box on the Translation Object Details dialog.

Tranzlation Dbjact Detailz:
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Irput Output
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Yershn | | Jora0an | [ANS1R12VERSION
Tramserfion | [ [oo [mwoice
Felearms I_ IIJ_
F Growp | | IIN |

6. Select Save from the File menu to save the source map with the
Compiled on date.

Gentran:Director system before you can use it. See the
Gentran:Director User’s Guide for information on
registering a translation object.

Q You must register this translation object with the
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Printing the

Report The Gentran:Director report enables you to validate and review the map, and

make modifications as needed. If you review the report and determine that
the map is incorrect, you should reiterate the mapping process as many times
as necessary (make the modifications, save the map, recompile the
translation object, and print the report again).

Complete the following steps to print the Gentran:Director report:

Select Print from the File menu or the Main Toolbar to access the Print
Options dialog.

Print O ptions

— Report zections

¥ Frirt branching diagranm

v Print record details Eancel |

¥ Print mapping details

¥ Fiint extended rules

¥ PFrint code lists

W Include only active objects

Accept the defaults on this dialog (all options checked), so the report
includes all sections and only the activated map components. Click OK
and the Print dialog is displayed.

Set the appropriate options. Click OK if you do not need to change
Setup options, and the mapping report is printed.

Click SETUP... if you need to access printer setup information (to select
a specific printer, paper orientation, or size and source of paper). The
Print Setup dialog is displayed.

Set the appropriate options. Click OK if you do not need to change Print
Options (dithering, intensity control, or print true type as graphics), and
you return to the Print dialog. Click OK on the Print dialog and the
mapping report is printed.

Click OPTIONS... if you need to access printer setup options
information. The Options dialog is displayed.

Set the appropriate options. Click OK to return to the Print Setup dialog.
Click OK on the Print Setup dialog to return to the Print dialog. Click
OK on the Print dialog and the report is printed.
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Testing the

Translation After you compile the map, print and verify the report, and register the
Object translation object with Gentran:Director, you should test the translation
object to verify that the data is translated correctly. To test the compiled
translation object, you should obtain test data from your partners and process
the data. You should also verify acknowledgement processing (if applicable)
and verify communications with your network.

Complete the following steps to test the system import (HEADER.TPL) and
import (PET_810.TPL) translation objects:

1.

April 2005

Register the HEADER.TPL and PET_810.TPL translation objects with
Gentran:Director. Please see the Gentran:Director User’s Guide for
more information on registering a translation object.

If you have not already done so, import the PETZONE.PAR partner
relationship into Gentran:Director. Please see the Gentran:Director
User’s Guide for more information on importing a partner.

The default full path for the partner file is: C:\Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PETZONE.PAR

Verify (in Partner Editor) that the PET X 3030 810 Import translation
object is selected for the Outbound Relationship. Please see the
Gentran:Director User’s Guide for more information on selecting
outbound translation objects.

Ask your system administrator to add the system import translation
object (HEADER.TPL) to the System Configuration program. Please
see the Administration Guide for more information about how your
system administrator must modify the system configuration program.

Use the Import option in Gentran:Director to process the data file
(PET_810.TXT) through the translation object. The data file is located
in the TUTORIAL subfolder under the folder where Gentran:Director is
installed.

The default full path for the data file is: C:Program Files\Sterling
Commerce\GENTRAN DirectonTUTORIAL\PET 810.TXT

Please see the Gentran:Director User’s Guide for more information on
importing files.

After the document is translated, it is located in the Workspace in
Gentran:Director. View the EDI data to ensure that the document was
translated correctly. Please see the Gentran:Director User’s Guide for
more information on viewing raw EDI data.

Gentran:Director Application Integration ANSI Tutorial Guide



G L O S S A R Y

Glossary

?In Documents This Gentran:Director browser contains a list of documents that were
received by the system but failed compliance checking or that do not have an
identifiable partner or transaction set.

?0ut Documents This Gentran:Director browser contains a list of documents that were
imported into the system via unattended processing but are invalid.

acknowledgement This term is used to indicate the ANSI 997 functional acknowledgement, the
EDIA 999 acceptance/rejection advice, and the EDIFACT CNTRL
document.

activation This function enables you to make map components available for use. The
system activates all the groups, segments, composites, and elements that are
defined as “mandatory” (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, composites,
and elements. When translating data, the system does not process groups,
segments, composites, and elements (or records and fields) that are not
activated. Therefore, you must activate the groups, segments, composites,
and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) is the standards-setting
group for the automotive industry. The standards form a subset of the ANSI
X12 standard.

ANA  Article Numbering Association.

ANSI American National Standards Institute. ANSI sets standards for many
products and services, such as safety glasses and battery capacities. The
ANSI X12 committee is the chief EDI standards-setting organization for the
United States.

application file If you are creating an import or export map, you must define your
application to Gentran:Director. In Gentran:Director terminology, your
application file is also referred to as a fixed-format file or a positional file.
Your application file must contain all the information that you either need to
extract from your partner’s document (if the map is inbound) or need to send
to your partner (if the map is outbound), so that your system can accurately
process the data.
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button

code list tables

colours
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Communicator
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compliant

component data
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composite data
element
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Computer systems, outside of EDI, designed to fulfill specific business
functions. These include accounting, purchasing, materials control, human
resources, shipping, and other systems.

A browser is a window that displays a list of items, such as documents
(transaction sets), interchanges, translation objects, etc. A document browser
displays only documents.

A button enables you to execute a command. You select a button either by
clicking it or by pressing TAB until the button you want is selected and then
pressing ENTER. Unavailable buttons are dimmed, and the currently
selected button has a darker border than the other buttons.

These are used by EDI standards as repositories for lists of codes. Each EDI
standard provides a code list for each element that can be further defined
with a code.

This feature enables you to select foreground and background colours to
visually define the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one
continuous period of connection. This could include sending two or three
interchange envelopes to a network, each for a different trading partner.

This is the Gentran:Director communications software. The Communicator
enables you to send, receive, resend, establish communication port
definitions, establish communication profiles, establish communication
scripts, and view and delete communication sessions.

This function compiles the map and creates a translation object. The map
that you create using Gentran:Director is a source map. When that source
map is compiled, the result is a compiled translation object. This translation
object must be registered with the Gentran:Director system before you can
use it.

This means that the document conforms to the EDI standards as defined by
the translation object.

A simple data element that belongs to a composite data element. Component
data elements are also called subelements.

A contains two or more component data elements or subelements.
Composites are defined by the EDI standards that use them (EDIFACT,
TRADACOMS, and certain ANSI X12 standards).

See relational conditions.
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cross-reference table

date/time

deactivation

default

dialog box

document

double-click

EANA
EDI

This standard rule enables you to move a literal constant value to the
specified element or field, indicate a qualifying relationship with another
element or field, and map the current date or time to the specified element or
field.

This table is created in Partner Editor and is used to convert your values to
your trading partner's values during outbound processing, or your partner's
values to your values during inbound processing.

This type of field or element contains a date or time. If you specify that a
field or element is a date/time type, you must specify exactly how the date or
time must be formatted.

This function enables you to make map components unavailable for use by
the system. The system does not enable you to deactivate the mandatory
groups, segments, composites, and elements.

A predefined value — programs use these built-in values unless you
specifically override them.

A dialog box (or dialog) contains additional information or options that you
need to act on. If you specify any options, you can select a button to execute
the command. Some dialog boxes display warnings or messages indicating
why a requested task cannot be accomplished. If the dialog box has a title
bar, you can move it to another location on your desktop.

One transaction set containing actual data and treated as a single entity. The
amount of data does not affect whether something is a document or not, only
the fact that it is treated as a single entity. For example, regardless of whether
a purchase order contains one item or ten thousand, if it is one purchase
order, it is one document.

If a trading partner sends you a communication containing 10 purchase
orders, you have received 10 documents. If the communication contained 15
invoices, you have received 15 documents.

This indicates that you should position your cursor on top of the designated
item and quickly press and release your primary mouse button twice. The
primary mouse button is the button you access with your index finger,
regardless of whether you are utilizing right-handed or left-handed mouse
operation.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.
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EDI standard
EDIA

EDIFACT

element

envelope

This is the rules for turning a business document into an EDI document.

The Electronic Data Interchange Association, formerly known as the
Transportation Data Coordinating Committee (TDCC).

This is the standards organization of the United Nations Economic and
Social Council. The acronym is short for the Electronic Data Interchange for
Administration, Commerce, and Transport.

The smallest piece of usable information defined by the standards. Examples
might include a quantity, unit price, or description. An individual element
can have somewhat different meanings depending on context. Therefore,
elements are normally not considered to have useful meaning until they are
combined into segments. An element is the EDI map component that is
mapped (linked) to a corresponding application field to move data to and
from the EDI file.

There are three types of data elements, as illustrated in the table below:

Data Element Definition

Simple data element A single piece of information defined
by the standards.

Composite data A data element that is made up of
element multiple component elements.
Component data A simple data element that belongs to
element a composite data element.

Component data elements are also
called subelements.

A way of separating information in transmissions for ease of processing.
Each envelope contains a header segment and a trailer segment, which
separate the envelope from other envelopes and provide information about
the contents of the envelope.

There are three levels of envelopes, as follows:

Transaction Set
Each transaction set (business document) is contained within a transaction
set envelope.

Functional Group

An envelope containing related business documents. The standards define
which transaction sets should be placed together into a functional group
envelope.

Interchange Envelope
All material being sent to one trading partner in one communication. The
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term Interchange Envelope is the term used by ANSI. EDIA uses the term
Transmission Envelope to refer to this level of envelope. Since we use the
term transmission for other uses, we will refer to Interchange Envelope only.

A communications session could easily include a

number of interchange envelopes. For this reason, the
standards-setting bodies are considering a fourth level
of envelope to cover an entire communications session.

equalize This function enables you to reinstate the two sides of the map with focus in
equal dimensions. The use of the Equalize function is optional.

export map This map defines how to move data from the EDI standard-formatted
documents that your partners send you to your application file (flat file
definition). An export map is necessary for inbound processing.

export translation See export map.

object
extended I’LJJ|eS These rules enable you to use a Gentran:Director proprietary programming

language to perform virtually any mapping operation you require.

field The smallest piece of information defined in the application file. A field is
the application map component that is mapped (linked) to a corresponding
EDI element to move data to and from your application file.

fixed-format file See application file.

font This feature enables you to globally change the font that is used in the
display of all maps. The default font that Gentran:Director uses is a Sans
Serif 9 point. The Font feature enables you to change the font type, style, and
point size. This gives you the flexibility to shrink the font if you need to
view more of the map on your monitor, enlarge the font, or change the type
and style to be more easily readable by you.

functional group A group of transaction sets that the standards-setting body (such as ANSI)
has defined as fitting together with other related transaction sets. An
example might be a Functional Group defined as containing all purchasing
transaction sets.

group A looping structure that contains related records/segments and/or groups that
repeat in sequence until either the group data ends or the maximum number
of times that the loop is allowed to repeat is exhausted. If you create a group
that is subordinate to another group (a subgroup), this corresponds to a
nested looping structure (a loop within a loop). The application (positional)
file and the EDI file are both groups and therefore, they is visually
represented the same way as other groups and subgroups in
Gentran:Director.
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This command enables you to import data from an external application file.
Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information.

This map defines how to move data from your application file (flat file
definition), which may contain multiple documents, to the EDI standard-
formatted documents that your partners expect to receive from you. An
import map is necessary for outbound processing.

See import map.

This Gentran:Director browser contains a list of documents that the system
received but that have not yet been processed by the user. Once the
documents are processed (printed or exported) the documents are transferred
to the In Drawer.

The system translates your trading partner’s EDI standard formatted
business document to your application file format, so you can receive
documents from you partners. To translate inbound data, you need to create
an export map.

This Gentran:Director browser contains a list of documents that were
received and processed.

An integer is a number that has an implied decimal point (e.g., “2.01” is
formatted as “201").

The interchange contains all the functional groups of documents (transaction
sets) sent from one sender to one receiver in the same transmission.

This Gentran:Director browser enables you to view a hierarchical list of all
the interchanges that were sent or received. It contains status information
about the interchanges, (e.g., whether or not a functional acknowledgement
was received and the status of that acknowledgement). This browser also
enables you to access the documents within the interchanges. The
Interchanges browser can always be accessed.

This function enables you to map a field or element from the Input side of
the map to a field or element on the Output side of the map. The link
between two map components (hereafter referred to as fields) is visually
represented with a line connecting the two fields.

These are used by the system as a repository to store information that is used
at a later point in the map. Typically, constants are used in an outbound map
to generate a qualifier.

This is a table created in Partner Editor that is used to contain address-related
information about the partner.
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number

ODETTE

Out Documents

outbound mapping
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This is a table created in Partner Editor that is used to select information
related to a value in inbound or outbound data.

This standard rule enables you to count the number of times a loop is
repeated, if the element or field is part of a loop. If the loop is a nested loop,
you can track the current loop or the outer loop. For example, if the Y loop is
nested within the X loop, and the Y loop has cycled through 15 iterations
and the X loop has cycled through 3 iterations, you can choose to count
either the “15” (Y loop) or the “3” (X loop).

Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS
and LE segments differentiate between two or more loops of the same type.
If the transaction contains LS and LE segments and depending on whether
your map is inbound or outbound, you must define the LS and LE segments
for the loops you are using in the map in one of two different ways.

A set of instructions you define in the Gentran:Director Application
Integration subsystem that indicates the corresponding relationship between
your application file and the EDI standards, and defines how the system
should translate data.

A list of items from which you can choose. Each item represents a
command. Unavailable items on a menu are dimmed to inform you they are
disabled.

This contains the list of menus for the application.

Also known as a Third Party Network or Value-Added Network (VAN). A
service, such as Commerce:Network, that accepts and holds transmissions
from companies until it is convenient for a trading partner to accept them.

This type of field or element contains either an integer or real number. If you
specify that a field or element is a number type, you must designate the
format by specifying a format of either “N” (integer) or “R” (real) and the
number of decimal places.

The Organization for Data Exchange by Tele-Transmission in Europe.

This Gentran:Director browser contains a list of documents that are ready to
be sent. After the documents are successfully sent, they are automatically
transferred to the Out Drawer.

The system translates your application file format to EDI standard formats,
S0 you can send documents to your partners. To translate outbound data, you
need to create an import map and a system import map in Gentran:Director.

This Gentran:Director browser contains a list of documents that were
successfully sent out by the system.
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partner

Partner Editor

positional file

post

predefined

printout

promote

qualifier

real number

receive

record

relational condition

Another firm with which your company trades documents. Also referred to
as a trading partner.

This Gentran:Director function enables you to define, edit, and delete all
partner information for your company and all of your trading partners.

See application file.

This Gentran:Director function enables you to move compliant documents
from the Workspace to the Out Documents.

On a data entry translation object, a default value for a particular element.
You can change the value as necessary.

This is produced when data received from a trading partner passes through a
print translation object. You do not have to actually print the data. The
printout could be to a file on your hard disk.

This function extracts one iteration (instance) of a group or repeating
segment. This enables you to map unique data from your application file,
and/or enter a specialized definition. Gentran:Director specifies that only
one-to-one (no loops) or many-to-many (loop) mapping relationships are
valid.

This is an element that has a value expressed as a code that gives a specific

meaning to the function of another element. A qualifying relationship is the
interaction between an element and its qualifier. The function of the element
changes depending on which code the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01” is formatted as
“2.01™), and truncates trailing zeroes.

This Gentran:Director function enables you to manually initiate a
communications session to receive data from your trading partner.

Contains a group of related fields. A record can occur once or can repeat
multiple times.

This function enables to connect fields together for syntax or compliance
reasons. For example, Field A is invalid unless Field B is present. Therefore,
if you set up a condition that pairs Fields A and B, the system generates a
compliance error if one of those fields is not present.

respond This Gentran:Director function enables you to create a turnaround document
(using the Turn Around translation object in the partner relationship) in
response to one or more selected documents in the In Drawer.
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responsible agency An organization that develops and updates standards for EDI
communications. These organizations include ANSI, EDIA, AIAG, UCS,
EDIFACT, ODETTE, and VICS.

segment A group of related elements or composite data elements that combine to
communicate useful data. Segments are defined by the EDI standards. A
segment can occur once or can repeat multiple times. For example, a catalog
price segment might consist of elements for item description, volume, price,
lead time, etc. By themselves, none of these elements would communicate
useful information. Together, they provide the information necessary for
someone to tell if the item is what is desired, whether the price is reasonable,
etc. A number of segments together form a transaction set.

select This standard rule enables you to select entries from a location table, cross-
reference table, partner table, or lookup table (all tables created in the
Gentran:Director Partner Editor). You can then map the fields in those tables
to one or more fields in the data. The Select function uses the value of the
current field to perform the selection.

send This Gentran:Director function enables you to manually start a
communications session to send data to your trading partner. Only selected
documents are enveloped and sent. If no documents are selected, ALL
documents are sent. Successfully sent documents are moved to the Out
Drawer.

set See Transaction Set.
simple mapping See link.

split  This function enables you to split (break) a group or repeating segment into
two loops. Typically, you use this function when you need more than one
instance of the same map component that still occurs multiple times.

standard rules These rules give you access to functions that are necessary for mapping
operations that are more complex than simple linking, but less involved than
extended rules. Each of the standard rules are mutually exclusive (you can
use only one on a particular field).

status bar The status bar of an application window defines information about a
selection, command, or process, defines Menu Bar items as the user
highlights each item, and indicates any current keyboard-initiated modes for
typing (e.g., CAP for the “Caps Lock” key or NUM for the “Num Lock” key,
etc.).

string This type of field or element contains one or more printable characters. If
you specify that a field or element is a string type, you must designate the
format by specifying a syntax token.
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trading partner

This function enables you to designate a “token” that defines ranges of
characters and/or numbers that are allowed to be used for a string-type
element or field. You can then use the syntax tokens in the Format field of
the Field Properties dialog. This enables you to define what type of
characters should be used while compliance checking each element/field
(i.e., alphanumeric within a certain range, numeric within a certain range,
etc.).

The translator uses this map to determine which trading relationship
(established in Partner Editor) corresponds to each document in the
application file, so the system knows which import map to use to process the
document. You need a system import map that is defined in EDIMGR.INI to
translate outbound data.

See system import map.

These translation objects control the creation and separation of interchanges,
functional groups, and transaction sets. They also used to generate and
reconcile functional acknowledgements. All the required system translation
objects are automatically installed with the Gentran:Director system.

See EDIA.

TDF is the Transaction Data File. This file serves as a filter between your
document files and the Gentran:Director translator. For outbound
processing, data is imported from a TDF file and translated to EDI format
using a TDF Import translation object. The data is then ready to be posted
and sent to your trading partner. For inbound processing, EDI documents
that are received by Gentran:Director can be exported to a TDF-formatted
file using a TDF Export translation object. This data file is then ready to be
processed or converted to your internal application files.

See Network.

The title bar of an application window contains the name of the application
and enables you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the
Menu Bar.

The U.K. standards for EDI that are published by the Article Numbering
Association (UK) LTD.

Another firm with which you company trades documents. Also referred to as
a partner.
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transaction set
(document)

translation object

translator

transmission

transmission chain

A business form as defined by the standards. Examples include an ANSI 850
purchase order or an UCS 880 invoice. The standards define each transaction
set in terms of the segments and elements that make up the form, the order in
which they appear, and the relationships among them. This is also known as
“message” in Europe.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify
which translation objects are used by each partner relationship.

Inbound Translation Objects:

Turn Around: This translation object is used when a document is received,
to create the natural response document that contains as many elements from
the received document as possible.

Export File: This translation object indicates that when a document is
received, it is exported to a specified file format.

Print: This translation object is used to print documents.

Outbound Translation Obijects:

Import: This translation object is used to import data from an application
file.

Print: This translation object is used to print documents.

Data Entry: This translation object is used to enter data into the Document
Editor facility.

This is the engine that processes data for Gentran:Director, the Application
Integration subsystem, and the Forms Integration subsystem.

See Communications Session.

A path an EDI communication could follow, including one company, one
trading partner, and one or more network services.

turnaround document A document into which data elements from the source document have been

turnaround map

UCs

automatically transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document
(a logical response document to the source) from an inbound (source)
document, by transferring data from the source document to elements in the
target document (translation object).

The Uniform Communications Standard is the standard used by the grocery
industry.
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version
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This standard rule enables you to update a specific field in a document
record, envelope segment, interchange, group, current partner, or document
(if the map side format type is EDI), with the contents of the element or
field.

Please note that this function updates the internal
Gentran:Director database tables. We recommend that
you use this function only if you are sure you really
want to update the internal database tables.

Typically, you only use this function if you want to
update the document name and reference in the
document table. Any other use of this function could
have disastrous consequences!

This standard rule gives you access to a set of numeric variables that you can
manipulate via numeric operations, and then transfer to and from fields. This
function enables you to add, change, or delete calculations for the element/
field, including hash totals (used to accumulate numeric field values, i.e.,
quantity, price, etc.). This function also enables you to map the accumulated
total into a control total field, and use accumulators. Accumulators are used
generally for counting the occurrences of a specific element or generating
increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a
predefined code table, specify whether or not a compliance error is generated
if the element or field does not contain one of the values in the code table,
and store a code’s description in another element or field.

These translation objects control data entry, importing, exporting, document
turnaround, and creating printed reports. These translation objects are
created using the Application Integration or Forms Integration subsystems.
The Application Integration subsystem enables you to generate import,
export, and document turnaround translation objects. The Forms Integration
subsystem enables you to generate data entry and print translation objects.

Each standards-setting body updates its standards on a regular basis. Each
formal update is referred to as a version.

The Voluntary Inter-industry Communication Standards is the standards-
setting body for the retail industry, a subset of ANSI X12.

This Gentran:Director browser contains a list of outbound “Work in
Progress” documents. It also contains recently imported or data entry
documents.

The ANSI committee that sets and publishes standards for EDI.
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